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1 Introduction 
 

1.1  Notes 
 

1. Copyrights for this software belong to the Japanese corporation MAX Co., Ltd. 
 

2. Unauthorized copying or reproduction of this software or manual, or of any portion thereof, is strictly 
prohibited. 

 
3. This software and manual can only be used under the license agreement for this product. 

 

4. Contents saved to a PC cannot be saved permanently. Our company assumes absolutely no 

responsibility for damage incurred due to data loss caused by repairs of malfunctions, etc., or for indirect 

damage such as loss of revenue. 

  
 

5. These software specifications and the contents listed in this manual are subject to change without prior 

notice. 

 
 

6. Our company assumes absolutely no responsibility for damage (including indirect damage) incurred due 

to following instructions listed in this manual, including misprinting or other errors that may be contained 

in this publication.  

  
 

7. The organizational names and personal names portrayed in the samples created in this manual are 

fictitious and have absolutely no relation to actual organizations or people. 

 
 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or 

other countries. 

Other listed company names and products names are trademarks and registered trademarks of the 

respective companies.     

 
 

1.2  Operating Conditions 
 
    ●Supported OS: Windows 11 / 10 

 

    ●The system clock and memory are designed for a computer which is equipped with CPU and RAM 

according to OS requirements of Microsoft Corporation, inscribed with the [Designed for Windows] logo, 

and has storage free space of at least 100 MB.  

 
    *Operation is not guaranteed on a PC other than the specifications listed above. 

 
 

1.3  Regarding Font 

     

    ●All "true type" fonts installed on your computer can also be used with the software. 

(However, it may not be possible to correctly display or output some fonts, due to problems with the creation 

of data.) 
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1.4  British English (metric units) version and American English (imperial units) version software 

 

In this manual, the descriptions are written based on the British English (metric units) version of BepopPC 

EX application software. As shown in the buttons and screen examples below, there are multiple differences 

between the British English (metric units) version and the American English (imperial units) version.  

 

Please check the actual screen with the description in this manual and make sure to operate following the 

actual screen.  

 
 ●British English (metric units) version, some examples only 

 

 
 

 
 ●American English (imperial units) version, some examples only 
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2 Basic Operations 
 

2.1  Start BepopPC EX 
 

(1) Start BepopPC EX by double-clicking the icon displayed on the desktop of your PC, or by selecting [Start] - 

[All Programs] - [BepopPC EX]. 

 

 

 

 

(2) The [Design window] opens automatically.  

 
 *If printer drivers of multiple printers are installed, the [Setup sheet] dialog box is displayed when starting BepopPC EX. Set 

the [Printer name], [Set up output], [Output Length], and [Output Direction]. *Refer to “2.3 Create New Sheet(Setup Sheet)” 

 

 *If only one model of printer driver is installed, the [Setup sheet] dialog box is not displayed when starting BepopPC EX. 

The [Setup sheet] dialog box is displayed when creating a new layout after startup. 

 

 *The icons which are displayed and enabled differ depending on the selected printer mode. 

  

Design window 
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2.2  Explanation of Screen 
 

2.2.1  Design Window 

 
The main screen for entering text and inserting cliparts.  

 
 

 
 

2.2.2  Quick Access Toolbar 

 

 
 

Item Contents 

 
[Bepop Ex] 

[Save], [Undo], [Redo], [Print Preview] and [Exit] 

buttons are stowed in this button. 

 
[Quick Access 

Toolbar]  

These buttons are always shown regardless of 

changing the Tab. 

Click  button to customize (enable/disable) the 

buttons shown at the Quick Access Toolbar. 

 

  

Design Window 
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2.2.3  Tab 

 

 
 

Item Tab Contents 

[File] Menu for features such as [New], [Save], and [Print]. 

[Home]  Menu for editing objects using features such as [Cut], [Copy] and [Paste]. 

[Print] Menu for printing. 

[Setting] Menu for changing the settings and configurations of the software. 

 

2.2.4  Features in each Tab 

 
File tab 

 
 

Item How to Select from Tab 

 

[New] [File] - [New File] 

 

[Open] [File] - [Open] 

 
[Save] [File] - [Save] 

 
[SaveAs] [File] - [SaveAs] 

 
[Templates] [File] - [Templates] 

 [Open templates] [File] - [Templates] - [Templates] 

 
[Open a Custom 

template] [File] - [Templates] - [Custom Template] 

 
[Save a New Custom 

Template] [File] - [Templates] - [Save a New Custom Template] 

 
[Wire & Cable Marking] [File] - [Wire & Cable Marking]  

 
[New (Tape Mode)] [File] - [New (Tape Mode)] 

 
[Product Label Mode] [File] - [Product Label Mode] 
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Home Tab① 

 
 

Item How to Select from Tab 

 
[Select] [Home] - [Select] 

 [Select] [Home] - [Select] - [Select] 

 [Select All] [Home] - [Select] - [Select All] 

 [Cut] [Home] - [Cut] 

 [Paste] [Home] - [Paste] 

 [Copy] [Home] - [Copy] 

 [Delete] [Home] - [Delete] 

 [Undo] [Home] - [Undo] 

 [Redo] [Home] - [Redo] 
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Home Tab② 

 

 

Item How to Select from Tab 

 
[Font] [Home] - [Font] 

 [Bold] [Home] - [Bold] 

 [Italic] [Home] - [Italic] 

 [Underline] [Home] - [Underline] 

 [Reverse Order] [Home] - [Reverse Order] 

 
Home Tab③ 

 

 
 

Item How to Select from Tab 

 
[Text Options] [Home] - [Text Options] 

 [Text Box] [Home] - [Text Options] - [Text Box] 

 [Curved Text] [Home] - [Text Options] - [Curved Text] 

 [Text (With Effect)] [Home] - [Text Options] - [Text (With Effect)] 

 [Text Box with Border] [Home] - [Text Options] - [Text Box with Border] 
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Home Tab④ 

 

Item How to Select from Tab 

 
[Shape] [Home] - [Shape] 

 [Rectangle] [Home] - [Shape] - [Rectangle] 

 
[Rounded Rectangle, 

Oval] [Home] - [Shape] - [Rounded Rectangle, Oval] 

 [Circle, Elipse] [Home] - [Shape] - [Circle, Elipse] 

 [Polygon] [Home] - [Shape] - [Polygon] 

 [Star] [Home] - [Shape] - [Star] 

 [Right Arrow] [Home] - [Shape] - [Right Arrow] 

 [Left Arrow] [Home] - [Shape] - [Left Arrow] 

 [Speech Balloon] [Home] - [Shape] - [Speech Balloon] 

 [Curved Rectangle] [Home] - [Shape] - [Curved Rectangle] 

 [Line] [Home] - [Shape] - [Line] 

 
Home Tab⑤ 
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Item How to Select from Tab 

 
[Clipart Tools] [Home] - [Clipart Tools] 

 [Multi Colour Cliparts] [Home] - [Cliparts] - [Multi Colour Cliparts] 

 [Cliparts] [Home] - [Cliparts] - [Cliparts] 

*Prior to showing the standard mark or certification 

mark on the labels, please make sure of the marked 

product's compliance with each standard/regulation. 

The standard marks and certification marks included 

have been prepared in accordance with the 

standards and regulations as of Apr. 1, 2022. 

 [Register Clipart] [Home] - [Cliparts] - [Register Clipart] 

 [Design Clipart] [Home] - [Cliparts] - [Design Clipart] 

 
Home Tab⑥ 

 

Item How to Select from Tab 

 
[Import] [Home] - [Import] 

 [Insert Illustration] [Home] - [Import] - [Insert Illustration] 

 [Insert Graphic] [Home] - [Import] - [Insert Graphic] 

 [Insert Document] [Home] - [Import] - [Insert Document] 

 [DXF File] [Home] - [Import] - [DXF File] 
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Home Tab⑦ 

 

Item How to Select from Tab 

 
[Chevron] [Home] - [Chevron] 

 
[Barcode] [Home] - [Barcode] 

 
[Table] [Home] - [Table] 

 [New Table] [Home] - [Table] - [New Table] 

 [Insert] [Home] - [Table] - [Insert] 

 [Row] [Home] - [Table] - [Insert] - [Row] 

 [Column] [Home] - [Table] - [Insert] - [Column] 

 [Delete] [Home] - [Table] - [Delete] 

 [Row] [Home] - [Table] - [Delete] - [Row] 

 [Column] [Home] - [Table] - [Delete] - [Column] 

 [Distrinute Evenly] [Home] - [Table] - [Distribute Evenly] 

 [Row] [Home] - [Table] - [Distribute Evenly] - [Row] 

 [Column] [Home] - [Table] - [Distribute Evenly] - [Column] 

 [Merge Cells] [Home] - [Table] - [Merge Cells] 

 [Unmerge Cells] [Home] - [Table] - [Unmerge Cells] 

 [Row Height] [Home] - [Table] - [Row Height] 

 [Column Width] [Home] - [Table] - [Column Width] 
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Home Tab⑧ 

 

Item How to Select from Tab 

 [Object-in-Cell Alignment] [Home] - [Table] - [Objectin-Cell Alignment] 

 [Upper Left] [Home] - [Table] - [Objectin-Cell Alignment] - [Upper Left] 

 [Upper Center] [Home] - [Table] - [Objectin-Cell Alignment] - [Upper Center] 

 [Upper Right] [Home] - [Table] - [Objectin-Cell Alignment] - [Upper Right] 

 [Middle Left] [Home] - [Table] - [Objectin-Cell Alignment] - [Middle Left] 

 [Center] [Home] - [Table] - [Objectin-Cell Alignment] - [Center] 

 [Middle Right] [Home] - [Table] - [Objectin-Cell Alignment] - [Middle Right] 

 [Lower Left] [Home] - [Table] - [Objectin-Cell Alignment] - [Lower Left] 

 [Lower Center] [Home] - [Table] - [Objectin-Cell Alignment] - [Lower Center] 

 [Lower Right] [Home] - [Table] - [Objectin-Cell Alignment] - [Lower Right] 

 
Home Tab⑨ 

 

Item How to Select from Tab 

 
[Date and Time Field] [Home] - [Date and Time Field] 
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[Cut Shapes] [Home] - [Cut Shapes] 

 [Rectangle Cut] [Home] - [Cut Shapes] - [Rectangle Cut] 

 [Rounded Rectangle Cut] [Home] - [Cut Shapes] - [Rounded Rectangle Cut] 

 [Circle/Elipse Cut] [Home] - [Cut Shapes] - [Circle/Elipse Cut] 

 [Rounded Triangle Cut] [Home] - [Cut Shapes] - [Rounded Triangle Cut] 

 [Right Arrow] [Home] - [Cut Shapes] - [Right Arrow] 

 [Left Arrow] [Home] - [Cut Shapes] - [Left Arrow] 

 [Cut Line] [Home] - [Cut Shapes] - [Cut Line] 

 [Bordering] [Home] - [Cut Shapes] - [Bordering] 

 
Home Tab⑩ 

 

Item How to Select from Tab 

 
[Cutting Tools] [Home] - [Cutting Tools] 

 [Cut Border] [Home] - [Cutting Tools] - [Cut Border] 

 [Straight Cut Line] [Home] - [Cutting Tools] - [Straight Cut Line] 

 
[Convert] [Home] - [Convert] 

 [Convert to Cut] [Home] - [Convert] - [Convert to Cut] 

 [Convert to Print] [Home] - [Convert] - [Convert to Print] 
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Home Tab⑪ 

 

Item How to Select from Tab 

 
[Database Access - Menu] [Home] - [Database Access - Menu] 

 [Connect] [Home] - [Database Access - Menu] - [Connect] 

 [Disconnect] [Home] - [Database Access - Menu] - [Disconnect] 

 [Change] [Home] - [Database Access - Menu] - [Change] 

 
[Automatic placement] [Home] - [Automatic placement] 

 [Sequential Numbering] [Home] - [Automatic placement] - [Sequential Numbering] 

 [Auto Copy] [Home] - [Automatic placement] - [Auto Copy] 

 [Database Auto Copy] [Home] - [Automatic placement] - [Database Auto Copy] 

 
[Print] [Home] - [Print] 

 
Print Tab① 

 

Item How to Select from Tab 

 
[Print Preview] [Print] - [Print Preview] 

 
[Single Colour Print] [Print] - [Single Colour Print] 

 
[Colour Print] [Print] - [Colour Print] 

 
[Print Gap Adjustment] [Print] - [Print Gap Adjustment] 
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Print Tab② 

 

Item How to Select from Tab 

 
[Data Position Preview] [Print] - [Data Position Preview] 

 [Sequential Numbering] [Print] - [Data Position Preview] - [Sequential Numbering] 

 [Auto Copy] [Print]- [Data Position Preview] - [Auto Copy] 

 [Database Access - Auto Copy] 
[Print] - [Data Position Preview] - [Database Access - Auto 

Copy] 

 
[Label Setup Print] [Print] - [Label Setup Print] 

 [Serialization] [Print] - [Automatic placement] - [Serialization] 

 [Auto Copy] [Print] - [Automatic placement] - [Auto Copy] 

 [Database Auto Copy] [Print] - [Automatic placement] - [Database Auto Copy] 

 
Setting Tab① 

 

Item How to Select from Tab 

 
[Page Setting] [Setting] - [Page Setting] 

 
[Properties] [Setting] - [Properties] 

 [Text Box Properties] [Setting] - [Properties] - [Text Box Properties] 

 [Object Border Settings] [Setting] - [Properties] - [Object Border Settings] 

 [Basic Configuration] [Setting] - [Properties] - [Basic Configuration] 

 [Custom Colour] [Setting] - [Properties] - [Custom Colour] 
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Setting Tab② 

 

Item How to Select from Tab 

 
[Change Grid Settings] [Setting] - [Change Grid Settings] 

 
[Screen Colour Settings] [Setting] - [Screen Colour Settings] 

 
[Refresh Screen] [Setting] - [Refresh Screen] 

 [Zoom In] [Setting] - [Zoom In] 

 [Zoom Out] [Setting] - [Zoom Out] 

 
[Zoom to Selection] [Setting] - [Zoom to Selection] 

 
[BepopPC EX Manual] [Setting] - [BepopPC EX Manual] 

 
[Version Information] [Setting] - [Version Information] 

 
[Online Sales & Support] [Setting] - [Online Sales & Support] 

 

 

2.2.5 Object bar 

  
 

Icon and Icon Name  Icon and Icon Name 

 [Align Left]   [Align Top] 

 [Align Horizontal Center]    [Align Vertical Center] 

 [Align Right]     [Align Bottom] 

 [Vertical Spacing]   [Horizontal Spacing] 
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Icon and Icon Name  Icon and Icon Name 

 [To Front]   [Group] 

 [Forward One]    [Ungroup] 

 [Back One]     [Mirror] 

 [To Back]   [Rotate] 

 
 

2.2.6  Colour Bar 

 
 
 
 

 

 

 

 

 

 

 

2.2.7  Zoom Slider 

 

 Zooms in or out by sliding (click and hold) the knob . 
  

Standard Solid Colours 

Custom 

Colours 

Button to open Process 

Colour Bar 

Transparent 

Process 

Colours 

Button to close Process Colour 

Bar 



 

22 

2.3  Create New Sheet (Page Setup) 
 

(1) Click the  icon on the tool bar or select [File] - [New] from the menu bar. 

 

(2) The [Page Setup] dialog box is displayed. 

Specify settings for [Printer name], [Set up output], [Label Setup] ON/OFF, [Output Length], [Output 

Direction], and [Multi-strip Printing]. 

 
 

2.3.1 Select the Printer Name 

   When printer drivers for multiple printers are installed, select the printer to use. 

    The following printer names can be used with the application software BepopPC EX. 

   CPM-300, CPM-200, CPM-100HG3, CPM-100G3, CPM-100HG5, CPM-100G5 and CPM-100SHG5. 
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2.3.2 Select the Setup Output 

   Set the printing method. 

   The [Set up Output] which can be selected for each printer is shown below. 
 

Printer name Setup print Printed items Print details 

CPM-300 

CPM-200 

CPM-100SHG5 

CPM-100HG5 

CPM-100G5 

Print/Label ○Print (Single-colour printing） Use one colour of ink ribbon to print on the 

sheet. 

○Print (Colour Print) Use multiple colours of ink ribbons to print on 

the sheet.  

○Print  

(Colour Print/Adjustment Mode) 

Adjusts the printing misalignment which occurs 

when printing with multiple colours of ink ribbons 

on the sheet. 

○Cut-shapes (label) Cuts the periphery around the printed object and 

creates a label. 

○Bordering (label) Creates a border around the periphery of the 

printed object and cuts the object. 

○Cut object 

(Cut-shapes conversion) 

Converts the print data to a cut-shape. 

Cutting mode ○Cut text Cuts the sheet and creates cut text. 

CPM-100HG3 

CPM-100G3 

Print/Label ○Print (Single-colour printing） Use one colour of ink ribbon to print on the 

sheet. 

○Print (Colour Print) Use multiple colours of ink ribbons to print on 

the sheet. 

○Cut-shapes (label) Cuts the periphery around the printed object and 

creates a label. 

○Bordering (label) Creates a border around the periphery of the 

printed object and cuts the object. 

○Cut object 

(Cut-shapes conversion) 

Converts the print data to a cut-shape. 

Cutting mode ○Cut text Cuts the sheet and creates cut text. 

 
●Layout design window when [Print/Label] is selected 
 

 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
  

The colour bar is displayed. 
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●Layout design window when [Cutting] is selected 

 
      

           
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.3 Label Setup 

When Label Setup is applied, in layout design window, the background of specified label dimensions and the 

specified numbers of rows and columns are shown. 

 

[Layout design window when Label Setup is applied]  

 
 
 
This helps designing labels or signs with certain fixed dimensions. 
Please bear in mind that this background does not mean that cutting shapes, as same as the dimensions of 

label, are arranged automatically.  
To cut as same dimensions as the label dimensions, add cutting shape manually, such as [Home] tab – [Cut 

Shapes] – [Rectangle Cut] etc.  
 

  

An outline of the text or shape is displayed. 

Label width(70mm) 

Label 
height 
(45mm) 

Number of columns (3 columns) 

Number 
of 

rows 
(2 rows) 

X Gap or Horizontal margin (2mm) 

Y Gap or  
Vertical margin (2mm) 

Corner radius  
(2mm) 
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[Page Setup dialog when Label Setup is selected]  

  
 

2.3.4 Label Setup Print 

When Label Setup mode is applied, and also in case printing either multiple of same labels, printing labels 

using serialized numbers or printing labels with Database-connected information, it is recommended to 

use Label Setup Print. In Label Setup Print, the design and the settings of top-left label are applied to as 

many as desired number of labels and printed accordingly. 

 

[Label Setup is applied, designing label with anticipating using serialization in Label Setup print]  

 
 

As anticipating using Label Setup Print, only the top-left label is designed. 

 

To print using Label Setup print, click [Print] tab – [Label Setup print], then 

click either [Serialization], [Auto Copy] or [Database Auto Copy]. 
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Or click [Home] tab – [Print], then select 
either [Serialization], [Auto Copy] or 
[Database Auto Copy]. 
 
 
 
 
 
 

 
After that, enter the number of labels 

desired and select the sorting style 

from the followings ; 

“Print labels sorted in the specified 

page length” or 

 

“Print labels sorted in the specified 

page length (save mode)” or 

 

“Print labels in one page”. 

 
 
 
 
 
 
 
 
 

 
[Preview of Label Setup print output using serialization]  

 
As shown, the serial numbers have been arranged. To use serialization, follow the same steps shown 
in “5. Serial Numbering/Auto-copy”. 

[Preview of Label Setup print output using Auto Copy]  
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As shown, same label has been copied multiple times. To use Auto Copy, follow the same steps shown 
in “5. Serial Numbering/Auto-copy” 
 

[Preview of Label Setup print output using Database Auto Copy]  

 
As shown, each label has different information each other. To use Database Auto Copy, follow the 
same steps shown in “4. Importing a Database and Printing a Formatted Label”. 
 

2.3.5 Set the Printing Length 

         

  Set the length of the white tape roll in the design layout. For each printer, the possible initial [Output Length] 

is recorded below. 

Printer name 
Printing Length (possible 

setting range) 

Printing Length* 

(initial value) 

CPM-300 
30 to 1,000 mm*2 

(1.18 to 39.40 in) 

400 mm 

(15.72 in) 

CPM-200 
30 to 2,000 mm 

(1.18 to 78.60 in) 

400 mm 

(15.72 in) 

CPM-100HG3, CPM-100G3  

CPM-100HG5, CPM-100G5  

CPM-100SHG5 

10 to 2,000 mm 

(0.39 to 78.60 in) 

400 mm 

(15.72 in) 

 

*The [Output Length] of the tape roll is automatically adjusted to fit the layout when printing. Therefore, it is not absolutely 

necessary to specify settings before creating the layout.  
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*2 It is possible to print upto 2,000mm long with CPM-300 when clicking “Continue Print” at the following dialog. 

 

2.3.6 Set the Printing Direction 

   

Select either [Vertical] or [Horizontal] for the design layout direction. 

Changing the printing direction of the layout to fit the text or shape can help save space when printing. The 

initial setting is [Horizontal]. 

[Design layout when Horizontal is selected for Output Direction] 

 
 
[Design layout when Vertical is selected for Output Direction]  

 

Sheet 

width 
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2.3.7 Creating a Layout Wider than the Tape Roll (Multi-strip printing) 

 

It is possible to design an image or object using 2 strips, and to cut and print objects which are larger than 

the tape width. After printing, apply the 2 strips together for use as a single sign or label. 

 

(1) In the [Page Setup] dialog box, insert a check in the box for [Multi-strip Printing] and select either “2 bands 
(Restricted)” or “2 Bands (Limited Length)”. 

 
 

(2) A red line and blue line are displayed in the center of the layout design window. The area between the red 

line and blue line is the overlap (10 mm or 0.39 in) for applying the tape together. 

 
*The top strip will be printed first, followed by the bottom strip. When applying the tape to the application surface, apply 

the top strip and the bottom strip together so that they overlap by 10mm or 0.39 in. 

(It is also possible to print only the top strip or only the bottom strip.) 
 

When “2 bands (Restricted)” is selected, it is not possible to draw cut-shapes, use the bordering tool, convert objects and 

texts to cut-shapes, and colour printing. Furthermore, when a cut-shape object exists in the layout design window, it is 

not possible to select multi-strip printing. 

When “2 bands (Limited Length)” is selected, the maximum print length is 1,000mm (39.37 in). No other restriction. 
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   The maximum printing width for each type of printer is listed below. 
 
 
 
 
 
 
 
 

2.4  Opening a Saved Layout 
 

(1) Click the  icon in File tab. 
 

(2) Select the folder and the file to be opened. 
 

(3) Click [Open] to open the file.       

*Printer information is also saved in the file. Therefore, if multiple printer drivers are installed, there are cases in which 

the [Printer name] and [Sheet width] may need to change from the specified settings before opening the file. 

 

2.5  Saving a BepopPC EX File 
 

Open a saved file, edit the file, and finally save the file (using the same file name). 

(1) Click the  icon in the File tab.  

 

(2) The updated content is saved 

 

2.6  Saving a BepopPC EX File Using a New Name 
 

Save the layout of a file being edited using a new file name. 
 

(1) Click the  icon in File tab. 

 

(2) Enter the file name and then click [Save]. 

 

2.7  Closing the Application 
 

       Click the   icon at the top-right of the screen, or click the  icon - [Exit]. 

 

       *If an edited layout has not been saved,  the 

following message is displayed. 

Click the appropriate button.  

 
       
 
 
 
 
 
  

Printer name For 2 strip printing For 3 strip printing 

CPM-300 538 mm / 21.57 in Not Available 

CPM-200 390 mm / 15.35 in Not Available 

CPM-100HG3, CPM-100G3, CPM-100HG5, CPM-100G5 190 mm / 7.48 in Not Available    

Yes (Y) No (N) Cancel 
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2.8  Using Print/Label 

 
2.8.1 Displaying the Print Preview Window (Print/Label) 

 

Click the  icon in the Print tab. 

The printing content will be displayed in the print preview window. 

 
*For labels, the cut shape will be displayed in aqua colour. 

*Depending on the printing length, screen size, and screen resolution, unprintable areas may be displayed, or some 

areas may not be displayed correctly. 
 

2.8.2 Single-colour printing using the Print/Label setting 

 

Print the content of the editing window in one colour.  

If you wish to print in multiple colours, refer to “2.8.3 Colour Printing”. 

 

(1) Connect your printer to your PC.  

*For details on the connection method, refer to the instruction manual (separate booklet). 

(2) Click the   icon in the Print tab. 

 

(3) The [Single-colour Print] dialog will be displayed. 

Under the [Content] field, be sure to select [Print + Cut Shape (Label)].  

(If there are no cut-shapes, [Only Print] will be displayed.) Specify other settings.  
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[Multi-Strip Printing Range]: When performing multi-strip printing, select [Top/Bottom], [Only Top], or [Only Bottom]. 

There is no need to specify settings for [Multi-Strip Printing Range] when not performing multi-strip printing.  

 

[Number of Copies]: Set the number of copies you wish to print. The number of copies which can be selected 

varies depending on your printer model. However, the number of copies is always “1” for multi-strip printing.  

 

[Auto-adjust printing length]: Automatically sets the printing length to a position which is approximately 2 mm 

(0.07in) from the object closest to the end of the layout. 

             

   *Clicking [Properties] will display properties for the printer driver.  

   *It is necessary to set the printer driver properties when using lamination film or lamination ribbon, or when changing the 

type of tape roll. 

      

(4) Click [Print] to start printing. 

 

(5) If the data contains cut-shapes, the shapes will be cut after printing. 
 

2.8.3 Colour Printing 

 
Print in multiple colours which are specified in the printing data.  

When printing using multiple colours, it is necessary to replace the ink ribbon cassette.  

(1) Connect the printer to the PC.  

*For details on the connection method, refer to the instruction manual (separate booklet).  

(2) Click the  icon in Print tab or  icon in Home tab.  

 

(3) The [Colour print] menu will be displayed. 

  Under the [Content] field, be sure to select [Print + Cut Shape (Label)].  

  (When there are no cut-shapes, [Only Print] will be displayed.) Specify other settings. 

 

(4) Click [Print] to start colour printing.  

       
*Insert the correct ink ribbon cassette for the colour printing. Printing will start automatically.  
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*Clicking [Properties] will display properties for the printer driver. 

*It is necessary to set the printer driver properties when using lamination film or lamination ribbon, or when 

changing the type of tape roll. 

 

(5) When the first colour is finished printing, open the printer cover. 

*Be sure to open the cover completely. If the cover is only partially opened, the rewinding of the tape roll will stop 

midway, and it will not be possible to correctly print the next colour.  

 
(6) Once the sheet has automatically returned to the start position, insert the ink ribbon cassettes for the colours 

which have not yet been printed. Close the printer cover. Printing will start automatically.  

*Always follow messages when operating the printer. It is not possible to redo colour printing from midway 

through a print.  

*For more information on setting the ink ribbon cassette and opening the printer cover, refer to the installation 

manual enclosed with the printer.  

*When multi-strip printing “2 Bands(Restricted)” is selected, it is not possible to perform colour printing.  

 

(7) If the data contains cut-shapes, the shapes are cut after all the colours are printed.  
*For information on single-colour printing, refer to “2.8.2 Single-colour printing using the Print/Label setting.”  
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2.8.4 Settings for Application after Multi-Strip Printing (Border Cut) 

 

When using multi-strip settings, it is possible to cut the upper/lower/left/right margin of the sheet to make 

aligning the strips easier while pasting. 

This function can only be used when [Print Only] is specified for the printing. 

 
(1) Connect the printer to the PC.  

*For details on the connection method, refer to the instruction manual (separate booklet).  

 

 (2) Click the  icon in the Print tab.  

 

(3) If cut shapes are in the data, [Print+Cut Shape (Label)] is displayed under the [Content] field of print settings. 

In this case, after printing, labels will cut along the cut-shapes (if [Only Print] is selected for [Content], border 

cutting will be performed). Next, set other items.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
       
 
 
 

[Multi-Strip Printing Range]: When performing multi-strip printing, select [Top/Bottom], [Only Top], or [Only 

Bottom]. Cannot specifying settings for [Multi-Strip Printing Range] when not performing multi-strip 

printing.  

 

[Number of Copies]: Set the number of copies to print. The number of copies which can be selected varies 

depending on the selected printer. 

However, the number of copies will always be “1” for multi-strip printing.  

 

(4) Click [Properties]. 

*Clicking [Properties] displays the property for the printer driver. 

(5) Click the [Output Settings] tab. 

(6) Under the [Options for Output] field, insert a check in the box for [Cut Printable Area], and then click [OK]. 

*The settings for a laminate ribbon can also applied at the same time. 

(7) Select the printer if necessary, and click [Print] to start printing. 
(8) After printing, the margin will be cut and design will be completed. 
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2.8.5 Using the Laminate Ribbon When Printing  

 

Print the content of the editing window in one colour.  

When printing using multiple colours, refer to “2.8.5 Using the Laminate Ribbon for Colour Printing.”  

*Printing using the laminate ribbon is only supported by the CPM-100SHG5, CPM-100HG5, CPM-100G5, CPM-100HG3 

and CPM-100G3 models. 

*Laminate function is not available in printers designed for the North American market. 

 
(1) Connect the printer to the PC.  

*For details on the connection method, refer to the instruction manual (separate booklet).  

(2) Click the  icon in the Print tab. 

 

(3) The [Single-colour Print] menu will be displayed. Select [Print+Cut Shape (Label)]. (If no cut-shapes are in 

the data, [Only Print] will be displayed. In this case, proceed to step (4).) 

      

(4) Click [Properties]. 
*Clicking [Properties] displays the property menu for the printer driver. 
 

(5) Click the [Output Settings] tab. 

 

(6) Insert a check in the box for [Laminating Ink Ribbon] in [Outputting Method], and then click [OK]. 

 
 

(7) Select the printer as necessary. Click [Print] to start printing. 

 

(8) After printing, once the sheet has been rewound, follow the instructions on the screen and set the laminate 

ribbon.  

 

(9) After coating using the laminate ribbon, if the printing data includes cut-shapes, they will be cut out. 

*It is not possible to set laminate print when using multi-strip settings. 

*The printer may stop temporarily during coating using the laminate ribbon. This stoppage occurs when the printer 

thermal head reaches a high temperature. Printing will resume automatically once the temperature of the thermal head 

decrease (about 3 minutes). Such stoppages are not a malfunction. If an error message (time-out message) is 

displayed on the PC screen, do not click the message button. Wait until printing resumes. 

*Laminate printing is not possible when the number of copies is set to 2 or more and the total printing length exceeds 

2,000 mm or 78.7in (an error message is displayed when [Print] is clicked). In this case, set the number of copies to 

“1” in order to print. 

Cancel 
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      (Total sheet length = sheet length × number of copies) 

2.8.6 Using the Laminate Ribbon for Colour Printing 

 

Print in multiple colours which are specified in the design layout data.  

When printing using multiple colours, it is necessary to replace the ink ribbon cassette.  

*Printing using the laminate ribbon is only supported by the CPM-100SHG5, CPM-100HG5, CPM-100G5, CPM-100HG3 

and CPM-100G3 models. 

*Laminate function is not available in printers designed for the North American market. 

 

(1) Connect the printer to the PC.  

*For details on the connection method, refer to the instruction manual (separate booklet).  

(2) Click the  icon in the Print tab or the  icon in the Home tab.  

(3) The [Colour Print] menu will be displayed. Select [Print+Cut Shape (Label)]. 

 (Not displayed when cut-shapes are not in the design layout data.) In this case, proceed to step (4). 

(4) Click [Properties]. 

*Clicking [Properties] will display properties for the printer driver. 

(5) Click the [Output Settings] tab. 

(6) Insert a check in the box for [Laminate Ribbon] in [Outputting method], and then click [OK]. 

 

 

(7)  Click [Print] to start printing. A message will be displayed explaining which colour will be used when printing. 

Insert the ink ribbon cassette for the displayed colour. Once the ribbon has been set, printing will begin 

automatically.  

(8) Follow instructions on the screen. Once printing for the first colour is finished, open the printer cover. 

*Be sure to open the cover completely. If the cover is only partially opened, rewinding of the sheet will stop midway, and 

it will not be possible to correctly print the next colour.  

*Once the sheet has automatically returned to the starting position, set the ink ribbon cassette for the next colour (colour 

displayed in the message). Close the printer cover. Printing will start automatically. 

*When 2 or more colours are specified, repeat the procedures in step (8).  

*Always follow messages when operating the printer. It is not possible to redo colour printing from midway. 
 *For information on setting the ink ribbon cassette and opening the printer cover, refer to the printer instruction manual. 
 *When multi-strip printing “2 Bands (Restricted)” settings are applied, it is not possible to perform colour printing.  

 

(9) After printing the last colour, once the sheet has been rewound, follow the instructions on the screen and set 

the laminate ribbon.  

Cancel 
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(10) After coating using the laminate ribbon, if cut-shapes exist, the shapes will be cut out. 
 

*When printing using 1 colour, refer to “2.8.7 Using the Laminate Film to Create Laminated Labels.” 

*The printer may stop temporarily during coating using the laminate ribbon. This stoppage occurs when the printer 

thermal head reaches a high temperature. Printing will resume automatically once the temperature of the thermal head 

decrease (about 3 minutes). Such stoppages are not a malfunction. If an error message (time-out message) is 

displayed on the PC screen, do not click the message button. Wait until printing resumes. 

 

2.8.7 Using the Laminate Film to Create Laminated Labels  

 

Print the content of the editing window in one colour.  

When printing using multiple colours, refer to “2.8.3 Colour Printing”.  

 

*Printing using the laminate film is only supported by the CPM-200, CPM-100SHG5, CPM-100HG5, CPM-100G5, CPM-

100HG3 and CPM-100G3 models. 

*Laminate function is not available in printers designed for the North American market. 

 
(1) Connect the printer to the PC. 

*For details on the connection method, refer to the instruction manual (Separate booklet).  

 

(2) Click the  icon in the Print tab. 

 
(3) The [Single-colour Print] menu will be displayed. Select [Print+Cut Shape (Label)]. 

*When printing a layout which is connected to a CSV database, laminate film mode can only be used if [CSV Database 

Auto Copy] is not selected and [Current Record] is selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
  (4) Click [Properties]. 

*Clicking [Properties] will display properties for the printer driver. 
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(5) Click the [Output Settings] tab. 

 
 

(6) Insert a check in the box for [Laminating Film] of [Outputting methods], and then click [OK]. 
*If a check is inserted in the boxes for [Cut Printable Area] or [Laminating Ribbon], it is not possible to select [Laminating 

Film]. 
 

(7) After checking the message shown below, click [OK], and then click [OK] again at the Properties screen. 

 
 
 
 
 
 
 
 
 
 
 
     

 

*When using laminate mode, after the previous printing, check that the sheet has been cut by the printer cutter before 

performing printing. 

 
(8) Click [Print] to start printing. A message about the need to return the vinyl to the machine after printing is 

displayed immediately after [Print] is clicked. Click [OK] to continue. 

 
  

(9) Once printing is finished, remove the tape roll from the printer. 

 

(10) After applying the laminate film, reset the sheet in the printer. 

 

(11) Close the printer cover and click [OK]. The cut-shape data will be cut, and the laminated label will be 

completed. 

 
*It is not possible to apply laminate film settings when using multi-strip settings. 

*When affixing the laminate film to the printed labels, make sure that the film is parallel to the tape roll. 

If the laminate film covers the holes on the edge of the tape roll, the printer may not operate correctly. Use a cutter or 

other tool to cut and remove laminate film if it covers the holes. 

*Auto-cut settings are turned off when using laminate film settings. After using laminate film settings, be sure to clear the 

settings and turn the auto-cut settings on again for regular use. 

 

 

Cancel 
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2.8.8 Printing After Adjusting the Printing Misalignment (Gap) During  

Colour Printing (CPM-100G5 / HG5 / SHG5, CPM-200 and CPM-300) 

 

When performing colour printing on a CPM-100G5 / HG5 / SHG5, CPM-200 and CPM-300, there may be 

noticeable printing misalignment (gap between colours) depending on the layout. 

By using [Colour Print (Adjustment Mode)] to set an [Adjustment Value] for each layout, it is possible to 

adjust the printing misalignment (gap between colours). 

 

   Basic flow of [Colour Print (Adjustment Mode)] 

  

 
 
 
 
 
 

 
 
 
 
[Operation Method] 

(1) From the menu bar, select [File] - [Colour Print (Adjustment Mode)]. 
 

(2) The [Colour Print (Adjustment Mode)] will be displayed. 
 

(3) Leave the adjustment value entry field as “0.00” for each colour and click [Print] to start printing. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
(4) Use a ruler to measure the printing misalignment amount (gap between colours) of the results of a printing. 

 
(5) Select [Colour Print (Adjustment Mode)] again and set the measured misalignment amount (adjustment 

value) in the [Adjustment Value Entry] field. 
*For details, refer to “About the Adjustment Value” on the following page. 
*It is only possible to enter an adjustment value for colours used in the layout. 
 

(6) After entering the adjustment value, click [Print] to start printing. 

1. Use [Colour Print (Adjustment Mode)] and perform printing one time with the 

adjustment value set to “0.00”. 

2. Measure the printing misalignment (gap between colours) for the results of printing. 

3. Select [Colour Print (Adjustment Mode)] again, set the measured misalignment 

amount, and print. 

4. If the adjustment is not sufficient, repeatedly change the adjustment value and print. 

5. In order to enable the adjustment amount for subsequent jobs, save the layout (save 

the adjusted value). 

 

Leave the adjustment value entry 

field as “0.00” and click [Print] 
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(7) In order to save the adjustment value and enable it for subsequent printing jobs, save the layout of the 
design window. 

   *The adjustment value differs for each layout. Therefore, settings are required for each layout. 

 
  

[About the Adjustment Value] 

○When the adjustment value is set to a positive value (+0.01 to +2.00 mm/ 

+0.001 to +0.078 in): The printing position is move backwards. 

○When the adjustment value is set to a negative value (-0.01 to -2.00 mm/ -

0.001 to -0.078 in): The printing position is move forwards. 
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                     Correct printing position (no printing misalignment) 

 
 
 

 
 
 
 
 
 
 
 
                   

 
 
 
 
 
 
 
 
 
 
 
 

                    

 

 
      
 
 
 
 
 
 
 
 

                    

 
 
 
 
 
 
 
 
 
  

Tape roll side 

Printed tape side Tape roll side 

Printed tape side  
Tape roll side 

Front 
Back 

Printed tape side Tape roll side 

Adjustment Example (2) 

Black: -1.00 mm(-0.039 in)  

Red:  0.00 mm(0.000 in) 

No forward 

adjustment  

Correct 

position 

1.00 
mm 

Printed tape side 

Front 
Back 

Adjustment Example (1) 

Black: 0.00 mm(0.000 in) 

Red: +1.00 mm(+0.039 in) 

Front Back 

Front 
Back 

1.00 
ｍｍ 

1.00 
ｍｍ 

The printing position for black 
will be moved forward by 1.00 mm 

(0.039 in) 

The printing position for red 
will be moved backward by 1.00 

mm (0.039 in) 

Gap between black and red: 
1.00 mm (0.039 in) 
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Notes on [Colour Printing (Adjustment Mode)] 
 

*If the layout is complex, there are cases in which the printing misalignment which was measured from the 

results of printing without adjustment may require further modification.    

 
 [Layout Data] (Correct printing position)            Results of printing without adjustment 

 
 
 
 
 
 
 
 
 
  

  
 

Adjustment Method 1 

When black and dark green without adjustment are used as the standard, the adjustment values are as 

follows: 

Black: 0.00 mm, Red: ＋1.00 mm, Blue: -1.00 mm, Dark Green: 0.00 mm 

Black: 0.00 in, Red: ＋0.04 in, Blue: -0.04 in, Dark Green: 0.00 in 

  (Red moves backward by 1 mm, so blue should be moved forward by 1 mm) 

 
Adjustment Method 2 

  When red is used as the standard, the adjustment values are as follows: 

Black: -1.00 mm, Red: 0.00 mm, Blue: -2.00 mm, Dark Green: -1.00 mm 

Black: -0.04 in, Red: 0.00 in, Blue: -0.08 in, Dark Green: -0.04 in 

*Colour adjustment may cause misalignment of the printing data and cutting data. 

In this case, either make the appropriate colour adjustment, or change the cut-shape data position in 

the layout. 

 (Example) The blue dotted line is the cut-shape. 
 

 
 
 
 
 
 
 
 
 

*The adjustment value differs for each layout. Therefore, settings should be entered for each layout. 

Furthermore, there is the possibility that misalignment may change depending on printer. Therefore, when using 

a different printer, it may not be possible to obtain same results. 

*When printing in adjustment mode, ink ribbon exchanges must be performed in a fixed order. 

 Follow the instructions on the status monitor. 

*When printing using [Colour Print (Adjustment Mode)], the length of the front and back margins will increases by 

about 2 mm (0.078 in). 

*When printing with process colours only (CMYK), the entered adjustment value will be disabled (adjustment is not 

possible). 

 

Black-Dark Green: No misalignment 

Red-Dark Green: Misalignment of 1.00mm (0.04 in) 

Red-Blue: Misalignment of 2.00mm (0.08 in) 

[Correct position] [Without adjustment] [Red adjustment] [Black Adjustment] 
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2.9 Using Peel-off Mode 

Using the Peel off Mode function, after printing, the printed/cut media will be positioned in a reachable 

position, without fully cutting the tape. If you continue printing, the next output will start from the end position 

of the previous output. When compared to Auto cut, it is possible to save the margin on the Tape. 

 

2.9.1 Using Peel-off Mode(for CPM-100SHG5, HG5 and G5 only) 

 
(1) Select [File] – [Print] or [Colour Print]. 

 
(2) Click [Properties]. 

 
(3) Under [Operation After Printing], select [Peel off mode] in the print Properties menu[Peel Off Mode]. 

 
 

 (4) Click [print] in the print menu. 

 
Printing will start. After printing, the printed/cut media will be positioned in a reachable position, without fully 
cutting the tape. 
If you continue printing, the next output will start from the end position of the previous output. 
 

Cancel 
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<Note regarding the “Peel-off” Mode> 
To use “Peel-off” Mode, please make sure to follow the following cautions. 
⚫ Before resuming printing, make sure to peel the printed Tape (including the remains of the labels, inner 

portion) off the release liner. 
Not doing so could cause the Tape jam in the printer, which could lead to the malfunction of the printer. 

 (Example) When making “Cut Label (Switch Label)” with Yellow Tape. 

 
 
⚫ Prior to turn the printer off at “Peel-off” Mode, make sure to Full Cut the printed portion of the Tape by 

pressing the Scissors button manually.  
 

⚫ At “Peel-off” Mode, do not cut the Tape with the cutter knife or scissors. Make sure to cut by pressing the 
Scissors button manually. 
 

 
 

2.9.2 Adjusting the Tape feed length at Peel-off Mode(for CPM-100SHG5, HG5, 

G5 only) 

 

It is possible to set the tape feed length when using peel off mode in the printer status monitor 

The Tape Feed Length which can be adjusted to add additional amounts to the initial setting. 

 

*The adjustment is valid only when the computer can communicate with the printer. 

 

(1) Connect the CPM printer and the computer. Turn the printer on. 

 

(2) Open the Status Monitor by double-clicking the CPM printer icon in the Task Bar. 

 

(3) Click [Settings] in the Status Monitor. 

 

  

*Make sure to peel the remains 
of the label off the release liner. 
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(4) The Settings dialog appears. Enter the additional tape feed length and click [Save]. Click OK.  

 

 

 

2.10 Cutting 
 

2.10.1 Print Preview Display (Cutting mode) 

 

Click the  icon in the Print tab. 
The content for printing will be displayed. 
*If cut-shapes are in the layout, they will also be displayed in the print preview  

(Preview may differ from the printed design). 

 
<Print Preview Window> 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Depending on the screen size, printing length, and screen resolution, portions which cannot be printed may be 

displayed, or the layout may not be displayed correctly. 
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2.10.2 Printing a Cutting Data Design 

 
(1) Connect the printer to the PC. 

*For details on the connection method, refer to the instruction manual (separate booklet). 
 

(2) Click the  icon in the Print tab. 

 

(3) Select the appropriate settings in the print menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 [Multi-Strip Printing Range]: Only valid when "Multi-Strip Printing" is selected in tape settings. 

  (Cannot be selected in other cases.) 

The following settings can be specified for the multi-strip printing range. 

 2 strip 3 strip 

Horizontal 

・Top/Bottom (Left/Right) ・Top/Middle/Bottom  

・Only Top (Left) ・Top Only 

・Only Bottom (Right) ・Middle Only 

  ・Bottom Only 

Vertical 

・Top/Bottom (Left/Right) ・Left/Middle/Right 

・Only Top (Left) ・Left Only 

・Only Bottom (Right) ・Middle Only 

  ・Right Only 

 
[Content]: Data content can be selected when a cut-shape object exists in the editing window. 

[Number of Copies]: Set the number of copies to print. The selectable number of copies varies depending 

on the printer model. 

   **However, the number of copies is always “1” for multi-strip printing. 

[Auto-adjust printing length]: Automatically sets the printing length to a position which is approximately  

2 mm (0.078 in) from the object shape at the end of the layout. 

(4)   Click [Print] to start printing (cutting). 
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3 Creating/Editing an Object 
 

3.1  Basic Operation for Creating/Editing an Object 
 

3.1.1  What is an Object? 

 

“Object” is a general term for a character string (text), border, straight line, table,  

Bar code, clipart, cut-shape, image file, or document file that can be created using Bepop PC EX. 

 

 

 

 

 

 

     
 
 
 
 
 
 
 
 
 
 

3.1.2  Selecting an Object 

 

Use the cursor to select an object for editing, or to specify object settings. 

 

(1) Click the [Home] tab - [Select] -   icon and click any part of the object. 

 

(2) Object points  ■  and a rotate point  ■  will be displayed around the selected object. 

    To select multiple objects: 

   ・Hold down the [Shift] key and left-click on objects,  

 ・Click and drag the mouse to drag and cover multiple objects. 

    ・Hit CTRL+A to select all objects. 

 ・It is also possible to unselect unneeded objects, by holding shift and left-clicking on the objects. 
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3.1.3  Changing the Object Size 

 

(1) Use the cursor to select the object for which you want to change the size. 
 

(2) Align the cursor with an object point ■ which is displayed around the selected object. 
 

The curser will transform into an up/down arrow, left/right arrow, or diagonal arrow. To change the object size, 

click and drag the mouse in the direction of the arrow. 

 
 
 
 
 
 
 
 
 
 
 

 
*In order to change the size of an object without changing height x width ratio, hold down the [SHIFT] key 

while dragging a corner object point. 

 

3.1.4  Rotating an Object 

 

   The following 3 methods can be used to rotate an object. 

    It is not possible to rotate document files (Excel, Word, etc.), grouped objects containing document files,  

Or multiply selected objects containing document files. 

  

● Rotating using the rotation point 
 

(1) Select the object which you wish to rotate. 

(2) Align the cursor with the rotation point ■ on the right side of the selected object. 

(3) A circular arrow will be displayed. Rotate the object by holding down the left button on the mouse  

   and dragging in the direction that you want to rotate. (Rotation is performed with the object center as the 

axis.) 

 
   *It is not possible to use the rotate point to rotate a table, bar code, image file, document file, cut-border, grouped object, 

or multiple selected objects. For these items, rotate them (90°) using the Rotate button on the toolbar, or double-click 

the object to open its properties page and manually enter the rotation degree. 

 

     
 
 
 
 
 
 
 
 
 
 

*By holding down the [Shift] key on the keyboard while moving the rotation point, the object is rotated in units 
of 15°. 

 

Rotation Point 
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  ● Rotating entering a value for the angle 
(1) Display the Properties by double-clicking the object. 
(2) Under the [Rotate] field, enter a number for the angle of rotation and then click [OK]. 
(3) The object will be rotated clockwise according to the entered angle. 

*The number must be entered in half-width integers (for customers using foreign keyboards). 

*For tables, bar codes, image files, cut-shapes, and grouped objects,  

 a rotation angle of from 0°, 90°, 180°, and 270° must be selected in the Properties of each object. 
 

● Rotating using the Rotate button 

(1) Select the object and then click the  (Rotate) button in the Object bar. 
 
(2) Each time that the button is clicked, the object will rotate 90° clockwise along its center axis. 

 

*Bar code objects are rotated using the upper-left object point as the axis. 

*Objects which have already been slightly rotated will be rotated an additional 90° from their current angle. (Example: If 

an object has already been tipped by 10°, the angle of the object will change to 100°→190°→280°→10° each time 

that the rotate button is clicked.) 

 

3.1.5  Moving an Object 

 

(1) Select the object which you wish to move. 

 

(2) The object can be moved by holding down the left button of the mouse on the selected object and 

dragging. 
 

 
 
 
 
 
 
 
 
 

*If the object is dragged while holding down the [Shift] key on the keyboard, the object is 

moved with the left/right position and the top/bottom position fixed.   (It is not possible to drag 

diagonally.) 
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(3) When “Align objects to Alignment guide line” is enabled in the “Change Grid Settings”, the Alignment guide 

line is displayed when the object is moved close to either vertical/horizontal centre, left/right end or top/bottom end 

of the other objects. Besides, the object is automatically snapped to either vertical/horizontal centre, left/right end or 

top/bottom end of the other objects. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

Alignment guide line 
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3.1.6  Copying an Object 

 

(1) Select the object which you want to copy. 

 

(2) With the object selected, first click [Copy]  and then click [Paste]  in the [Home] tab. 

   Alternative Methods: 

 ・Click [CTRL+C] to copy and [CTRL+V] to paste. 

 ・Right-click the object and left-click [Copy], then right click anywhere on the layout design window and 

click [Paste]. 

 

*The pasted object is displayed with its top-left side aligned with the position of the mouse cursor when the 

paste operation was performed. 

*The pasted object is displayed slightly below and to the right of the original object. 

 
 
 
 
 
 
 
 
 

 

After the object is selected, if the [CTRL] key on the keyboard is held down while moving the object, it is 

possible to copy and paste simultaneously. 

 

3.1.7  Changing the Layering of Objects 

 

When multiple objects are stacked on top of each other, it is possible to change the stacking order. 

 

(1) Select the object for which you want to change the stacking order. 

 

(2) Change the order by clicking one of the following icons on the object bar:  

 

●Icon Functions 

Send to Front : The selected object will be moved to the front among all other objects. 

Forward One : The selected object will be moved one place forward in the order. 

Backward One:The selected object will be moved one place backward in the order. 

Send to Back : The selected object will be moved to the back among all other objects. 
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    ●Changing the Order 
   

Example) Select Object 3 and then click [Forward One]. 

  
 
 
 
 
 
 

                       

 
 
 
 
 
 
 

Example) Select Object 1 and then click [Send to Back]. 
 
 
 

 
 
 
 
 
 

 

 

 

 

3.1.8  Aligning the Position/Spacing of Objects 

 

BepopPC EX contains special tools to help align the positions of multiple objects, or set the spacing 

between multiple objects. 

 

(1) Select the objects to be aligned or spaced. 

   To select multiple objects, hold down the [Shift] key and select objects, 

     or use the mouse to drag and cover multiple objects. 

 

(2) Align the position or spacing by clicking one of the following icons on the object bar:  

    
●Icon Functions 

Align Left: Align selected objects with the left-most position side of the object furthest to the left. 

Align Horizontal Center: Align with the horizontal center of the selected objects. 

Align Right: Align selected objects with the right-most side of the object furthest to the right. 

Vertical Spacing: Align the vertical spacing of the selected objects to the specified value. 

  

Before changing the order 

The objects are displayed in 

the order 1, 2, 3 from the 

front 

After changing the order 

The objects are displayed in 

the order 1, 3, 2 from the 

front 

Before changing the order 

The objects are displayed in 

the order 1, 2, 3 from the 

front 

After changing the order 

The objects are displayed in 

the order 2, 3, 1 from the 

front 
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Align Top: Align selected objects with the top side of the topmost object. 

Align Vertical Center: Align with the vertical center position of the selected objects. 

Align Bottom: Align selected objects with the bottom-most side of the bottommost object. 

Horizontal Spacing: Align the horizontal spacing of the selected objects to the specified value. 

 
     *Icons for aligning the position or setting the spacing are only enabled when multiple objects are selected. 

 
   Examples:  

Before setting position alignment                    After setting align right  

 
 
 
 
  
 
 
 
 
 
 

 Before setting position alignment                   After setting align bottom  
 

(After specifying [Align right]) 
 
 
 
 

 
 

     Before setting spacing alignment                After setting vertical spacing  
 
                 Set vertical spacing of 10 mm 

(0.39 in) 

 
 
 
 
 
 
 
 
 
   *Vertical spacing settings are based on the topmost object.  

   *Horizontal spacing settings are based on the leftmost object. If multiple objects exist in the same position,  

    spacing settings are based on the bottom layer. 
  

10 mm (0.39 in) 

10 mm (0.39 in) 
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3.1.9  Grouping/Ungrouping Objects 

 

Handle multiple objects as one grouped object. 

Specifically, grouped objects are treated as one object when moving, copying, deleting, zooming, or rotating. 

*When objects are grouped, it is not possible to change the text, font, size, or other attributes of text boxes which are 

included in the object. If you want to change these attributes, please ungroup the objects. 

 

(1) Select the objects which you want to group. 
*To select multiple objects, hold down the [Shift] and left click with the mouse. 
Example) Grouping the rectangular border and the number “3” (text box) 
 

 
 
 
 
 
 
 

(2) After selecting multiple objects, click [Group] . 

 

(3) The selected objects are grouped. 

 

 
 
 
 
 
 
 

Alternative methods for grouping: 

 ・Right-click and select [Group all objects]. 

*Repeatedly changing the size of grouped objects may cause the shape to become deformed. 

 

Methods for ungrouping(after selecting object)： 

・Click [Ungroup] . 

・Right-click and select [Ungroup objects]. 

 
 

3.1.10  Mirroring Objects (Sticking Designs to the Inside of Glass) 

 

This section contains procedures for mirroring objects (flipping objects horizontally as if they were being 

viewed in a mirror). This procedure is most often used to apply a sign to the inside of glass to be viewed 

from the outside. 

(1) Select the design which you would like to mirror. 
 

(2) Click the mirror icon  on the object bar. 

*Press the same icon to return the object to its previous position. 
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3.1.11  Fixing the Object Position 

 

It is possible to fix the position of a created object. Once the position has been fixed, it is not possible to 

move the object or change its size by using the mouse or keyboard. This is used when designing multiple 

labels in one design window. 

 
  (1) Double-click the object. (This will display the Properties window) 
 
  (2) Insert a check in the box for [Fix Position] and then click [OK].      

 

 

 

 

 

 

 

 

*To unfix the position, remove the check from the box from [Fix Position] and then click [OK]. 

      *After fixing the position, if the size of the box is changed, the size will change based on the upper-left object point. 

      *When selecting and moving an object for which fixed position is enabled and an object for which fixed position is 

disabled, only the disabled object is moved. 

      *Grouping a freed object and fixed object, the group will be fixed. 

 

3.1.12  Deleting an Object 

 

Methods for deleting selected objects: 

・Click [Home] tab - [Delete]. 

・Press the [DEL] or [Delete] key on the keyboard. 
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3.2  Object Colour Settings and Print Settings (for Print/Label only) 
 

3.2.1 Types of printing  

  
    The following 3 types of printing can be used in BepopPC EX. 

●[Single-colour Print] 

Printing is performed using 1 colour of ink ribbon (such as a black ribbon OR red 

ribbon, etc.) 

 

●[Spot Colour Print] ("Spot Colour" = Printing industry term for printing  

with pure colour ink ribbons for each colour.) 

Printing is performed using several spot-colour ribbons (such as a black ribbon AND 

red ribbon AND yellow ribbon, etc.) 

   *Printing is performed by changing the spot-colour ribbons one-by-one. 

 

●[CMYK Print] (CPM-100HG5, CPM-100SHG5 and CPM-200) 

Superimposes the CMYK ribbon with the 4 colours of cyan, magenta, yellow and black.  

This enables printing of photographs, colourful illustrations, catalogs, advertisements, 

and other images which cannot be expressed using a spot-colour ribbon. 

*CMYK Print settings can be chosen for all objects excluding bar codes, cut shapes, 

and cut borders. 
*To realize cheaper running costs when printing in CMYK, set all print all text and design data to print CMYK.  
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3.2.2 Object Colour Settings (Spot-colour) 

 

This section lists procedures for setting the colour of an object. After selecting the object, click the colour 

which you want to set (change) from the colours displayed on the colour bar. The colour of the object 

changes and the arrow mark moves to the selected colour on the colour bar. 
 

Colour bar when CPM-300 is selected as the printer 

 
Black   Red   Blue  White  Dark Blue       Green  Yellow                                         Transparent 

 

Colour bar when CPM-200 is selected as the printer 

 
Black    Red  Blue  White    Dark Green  Green Yellow       Orange  Custom1 Custom2 Custom3  CMYK Transparent 

 
Colour bar when CPM-100HG5 or CPM-100SHG5 is selected as the printer. 

 
Black   Red   Blue   White  Dark Blue Dark Green Green  Yellow  Gray  Orange  Custom1 Custom2 Custom3  CMYK Transparent 

 
Colour bar when CPM-100G3, CPM-100HG3 or CPM-100G5 is selected as the printer. 

 
Black   Red    Blue  White  Dark Blue Dark Green Green  Yellow  Gray  Orange                           Transparent 

                        *Gray ribbon is no longer available. 
 

3.2.3 Object Colour Settings (CMYK Colour) (CPM-100HG5, CPM-100SHG5 and CPM-200) 

 

Superimpose the Process Colour Objects with the 4 CMYK colour ribbons of cyan, magenta, yellow and black. 

This enables printing of photographs, colourful illustrations, catalogs, advertisements, 

and other images which cannot be expressed using a spot-colour ribbon!     

 
 

 

 

  

Object Name Initial Value and Print Method 

Image/document file Insert check in box for [CMYK Print] 

⇒Printing is performed using CMYK colour 

Objects other than image/document files No check in box for [CMYK Print] 

⇒Printing is performed in spot-colours 

Grouped objects, multiple selected objects Reflects the condition of the included objects 
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*[CMYK Print] can be set for all objects excluding bar codes, cut-shapes, and cut borders. 
 *To save running costs when printing in CMYK, set all print, text, and design data to print CMYK.  

 

3.2.4 Colour Settings Using the CMYK Colour Pallet (CPM-100HG5, CPM-100SHG5 and CPM-
200) 

 

When using CPM-100HG5, CPM-100SHG5 and CPM-200, in addition to the spot-colours of black, red, 

blue, dark green, green, white, yellow, and orange, it is also possible to select from a range 15 colours 

printed by mixing colours from the CMYK colour ribbons of cyan, magenta, yellow, and black. 

Click the [CMYK Colour] icon on the colour bar to display the new 15-colours pallet (in the mini-pallet). 

●When 1 of the 15 pallet colours is selected for an object, [CMYK Print] in the object Properties is 

automatically enabled. 

 

 

 

 

 

 

 

 

 

 

 

⇒ Printing is performed in "Ultra-Pink" using [CMYK Print] which utilizes ink ribbons for cyan, 

magenta, yellow, and black.  

   ●When spot-colours (black, red, blue, dark green, green, white, yellow, and orange) are re-selected for a 

[CMYK Print] object, [CMYK Print] will be disabled in the Properties menu.  

         Spot-colour bar 

 

 

 

 

 

 

 

 

 

 

    ⇒Printing is performed using a spot-colour blue ink ribbon. 
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● Adding a check to the [CMYK Print] box for a spot-colour print object, will cause the object to 

print using CMYK colour ribbons. 

 

 

 

 

 

 

 

 

 

 

 

⇒ This is the suggested method for printing photos and text objects together. 

⇒ The spot-colour blue will printed using the cyan, magenta, yellow and black ink ribbons. 

●If the CMYK Print check mark for a "CMYK 15 Colour" object has been removed, the object will 

automatically turn black 

 

 

 

 

 

 

 
 
 
 
 
 

 

*Spot-colour ribbons cannot be used as a substitute for CMYK colour. Therefore, the colour is 

forcefully changed to black in the situation described above. 

 

3.2.5 CMYK Colour Settings when selecting Multiple Objects (CPM-100HG5, CPM-100SHG5 and CPM-200) 

 

(1) Right-click on selected grouped objects or select multiple objects. 

(2) Select either [Properties] or [Match Group Settings] and then insert a check in the box for [CMYK Print]. 

    [CMYK Print] settings will apply to all selected objects.  

 

   ●There are three possible [CMYK Print] settings for a group of objects. 

Print Setup Checked/Unchecked Box & Print Method 

1) CMYK Print is set for all objects Insert check in box for [CMYK Print] 

⇒Printing is performed using CMYK colour 

2) CMYK Print is set for none of the objects  No check in box for [CMYK Print] 

⇒Printing is performed using spot-colour 

3) Mixture of the above settings Gray check is inserted in the box for [CMYK Print] 

⇒Printing is performed using CMYK colour, and spot-

colour in accordance with settings for each object. 

*Of all the above settings, "3)" likely to have the highest running cost. Usually it is possible to decrease 
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running cost by changing all items to [CMYK Print] by putting a check in the [CMYK Print] settings box. 

*[CMYK Print] settings cannot be chosen for bar codes, cut-shapes, and cut borders. 

      Default values for settings are listed below. 

 

Object Name Default Settings and Resulting Print Method 

Image/document file Checked box for [CMYK Print] 

⇒Printing will be performed using CMYK colour 

Objects other than image/document files Not checked box for [CMYK Print] 

⇒Printing is performed using spot-colours 

Grouped objects, multiple selected objects Reflects the condition of the included objects 

   Restrictions and Cautions for CMYK Print 

 

   ●Due to factors such as print method characteristics, tape roll feeding mechanisms, colour hues of original 

data, as well as the hue/condition of tape rolls on which printing is performed, CMYK printing using  

CPM-100HG5, CPM-100SHG5 and CPM-200 cannot completely reproduce the colours displayed in 

actual images or on computer monitors. 

Furthermore, the print method differs from ink-jet printers and laser printers. 

Consequently, the reproduction of colour hues and fine details differs from such printers. Therefore, CMYK 

printing using CPM-100HG5, CPM-100SHG5 and CPM-200 is not appropriate for corporate logos in 

which a high level of colour reproducibility is required, or other uses in which discrimination is performed 

based on subtle colour differences. 

*Always use white tape rolls when CMYK printing. 

 

 

●Correct reproduction of colour is not possible when using the black and yellow spot-colour ribbons as 

substitutes for the CMYK black and yellow ribbons, or when using the black and yellow CMYK ribbons as 

substitutes for black and yellow spot-colour ribbons. 

 

●To enable/disable Colour Management feature:  

・When printing process colour images directly from some general application software,  

except BepopPC EX, disabling “Colour Management” could improve the print quality. 

・To do so, click [Print] tab - [Colour Print] - to open the spot-colour print window and click [Properties]. 

・After that, click [Details] to open “Details” dialog. 

・To enable “Colour Management”, check in the checkbox of “Assign Colour Profile”.  

To disable, remove check in the checkbox.  
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●It is possible to print using CMYK colours on CPM-100HG5, CPM-100SHG5 and CPM-200 from 

Microsoft Word and other general applications.  

    Go to [Start] - [Devices and Printers] and select [CPM-100HG5], [CPM-100SHG5] or [CPM-200].  

    Next, select [Printer] - [Properties], click the [General] tab, and click [Preferences].   

    Insert a check in the box for [Process] in the [General Application Print] mode. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3  Convenient Operations for Creating/Editing Objects 

 

3.3.1  Undo the Previous Operation 

Clear the previous operation and return to the original condition. 
 

(1) Click the  icon in the [Home] tab. 
(2) The previous operation is returned to its original condition. 

    *The previous operation can also be undone by pressing [CTRL+Z] 
      *It is possible to [Undo] a maximum of five steps. 

3.3.2  Redo 

 
Redo is used to re-perform an operation for which [Undo] was selected. 
 

(1) Click the  icon in the [Home] tab. 
(2) The operation which was cleared using [Undo] is performed again. 
     *Redo can also be done by pressing [CTRL+Y] 

       *[Redo] can be used the same number of times that [Undo] was used 

 

3.3.3  Cut 

This operation "cuts" the selected object from the layout and saves it to the clipboard. 
(1)  Select the object which you wish to cut. 

(2) Click the  icon in the [Home] tab. 
(3) The selected object will be cut. 

Cancel 

Property 
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3.3.4  Copy 

This operation copies a selected object to the clipboard. 

(1) Select the object which you want to copy. 

(2) Click the  icon in the [Home] tab. 
(3) The selected object is coped to the clipboard. 

Alternative methods for step (2): 

・Type [CTRL+C] on your keyboard. 

・Right click on the object and left-click [Copy] from the drop-down menu. 

 

3.3.5  Paste 

This operation pastes a cut or copied object to the design window. 

(1) After cutting or copying an object, click the  icon in the [Home] tab. 
(2) A new object is pasted to the design window. 

Alternative methods for step (1): 

・Type [CTRL+V] on your keyboard. 

・Right click on anywhere on the layout design window and left-click [Paste] from the drop-down menu. 

 

3.3.6 Apply Settings for Multiple Objects 

 
This method can be used to apply [Fixed Position] and [CMYK Print] settings for multiple objects (CMYK 
Print is available for CPM-100HG5, CPM-100SHG5 and CPM-200 only). 

 

(1) Select multiple objects (including a combination of text and shapes) which have not been grouped and 

then right-click. 

(2)  Select [Match Group Settings]. Insert a check in the box for [Fixed Position] or [CMYK Print]. Group 

settings for [Fixed Position] and [CMYK Print] will be applied for all selected objects. 

 

3.3.7  Zoom In/Zoom Out 

Zoom is able to magnify the the printing layout at the following ratios: 

Zoom in range: 150％, 200％, 400％, and 800％ (depending on the print length, it may not be possible to 

select 200％, 400％, or 800％). 

Zoom out range: 75％, 50％, 25％, and 10％ 

The cursor can be used to select the area on which you want to zoom using the following procedure: 

(1) Click the  icon in the [Setting] tab. 
(2) The cursor changes to a magnifying glass. Move the magnifying glass to the area where you want to 

zoom. 
(3)   To zoom-in, click the left mouse button. To zoom-out, click the right mouse button. 

 
Alternative Methods: 

・Click the [Setting] tab - [Zoom in] or [Zoom out]. 

 

・Selecting a value from the drop-down menu in the [Setting] tab.  

 

 

・Zooms in or out by sliding (click and hold) the knob  of zoom slider at the bottom right of  

the layout design window 
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3.3.8  Open Multiple Windows in BepopPC EX 

 

   When running BepopPC EX, it is possible to launch a second window by double-clicking the BepopPC EX 

icon (including layout data which has already been created), or by selecting [Start] - [Programs] - [BepopPC 

EX] - [BepopPC EX]. 

*It is possible to copy and paste objects between windows in BepopPC EX.  

*Also, it is possible to use the Windows toolbar functions [Tile Horizontally] and [Tile Vertically]. 

●Other information and restrictions regarding running multiple windows of BepopPC EX 

 

*When running multiple windows, the most recent window be displayed in the forefront. 

*It is not possible open multiple windows with the same file name. 

*It is not possible to open multiple windows of the clipart editing window [BepopScanEX]. 

*When running multiple BepopPC EX windows, imported cliparts will automatically be pasted to the front most sheet. 

*If a linked text box connected to the CSV database is copied to another window, it will be pasted as disconnected linked 

text box. 

*It is not possible to copy (cut) and paste between BepopPC EX, and older Bepop software. 

 

3.4   Creating a Text Box and Entering Text 

 

3.4.1  Creating a Text Box 

     

In order to enter text, first it is necessary to create a text box. 
 

(1) Click the [Home] tab -   icon. 
 

(2) Decide on the starting point for the cross-hair cursor and click the left mouse button. Drag the cursor to 

create the desired text size and then release the left mouse button. 
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(3) The [Textbox Properties] menu will be displayed. Enter the text and specify settings for font, size, width, 

text spacing, line spacing, etc. 

 

 

To edit text in a text box which has already been formatted, double-click the text in the design window to 

display the [Textbox Properties] menu. 

 

3.4.2  Entering Text 

 

Open text in the [Textbox Properties] menu. 

(1)  Click the Input Text field and enter your text. 

(Press the [Enter] key to start a new line of text.) 

(2)  Click [OK]. 
*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

 

3.4.3 Align Multiple Lines of Text 

It is possible to set the alignment of multiple lines of text to [Align left], [Align Center], [Align right].  

Under the [Textbox Properties] menu, input multiple lines of text in the［Input Text］field, and click 

on the alignment icons. 

       

[Align left]     [Align Center]     [Align right] 

 

3.4.4  Setting the Font 

 

The font can be set by using the select bar in the [Textbox Properties] menu. 

●Setting/changing the font at the Textbox Properties menu 

(1)  Click the drop-down arrow [▼] for the [Font] field and then select a font. 

   An image of the selected font is displayed under the [Input Text] field. 

Enter text here. 
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*The names of available fonts differ depending on the fonts installed on the computer. 

(2)  Click [OK]. 
*By clicking [Apply], it is possible to apply settings without closing the [Textbox Properties] menu. 

●Changing the font using the select bar 

 

(1)  Select the text box, and click the drop-down arrow [▼] for the field by the font name in the [Home] tab, and 

choose a font.        

(2)  The font of the text box will be changed. 

*It is possible to simultaneously change the font in multiple text boxes by performing the above operation when 

multiple text boxes are selected. 

 

3.4.5  Setting the Text Size and Width 

Set/change the size and width at the [Textbox Properties] menu. 
(1) Click the [Size] field and enter the text size. 

*It is not possible to enter a full-width character number. 

(2)  Click the [Width] field and enter the text width (%) or click the down arrow [▼] and select a number. 

*It is not possible to enter a full-width character number. 

(3)   Click [OK]. 
*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 
*When entering multiple lines of text, the text box border size is used as a reference. 

*When [Align With Border] is enabled, the text width is automatically reduced to fit within the text box. 

*If you want the size of the text box to be determined by the text properties and number of characters, then 

remove the check from the box for [Align With Border]. 

*In the “Character Height”, the character height of the text (except margin) is displayed. 

 

3.4.6  Setting the Text Spacing 

It is possible to set the text spacing in the [Textbox Properties] menu. 
(1)  Click the [Text Spacing] field and enter a letter spacing value as a half-width number. 

 *It is not possible to enter a full-width number. 
 

(2)  Ensure that the box for [Align With Border] border is not checked and then click [OK]. 
 *By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 
 *If [Align With Border] is enabled, the set text spacing will be disabled. 

 

3.4.7  Setting the Line Spacing 

 

Set/change the line spacing at the [Textbox Properties] menu. This field is only valid when entering multiple 

lines of text. 
 

(1)  Click the [Line Spacing] field and enter the spacing between lines. 
 *It is not possible to enter a full-width character (for international keyboards) number. 

(2)  Click [OK]. 
 *By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

 

3.4.8  Bolding/Unbolding Text 

 

Set/change bold text at the [Textbox Properties] menu or on the [Home] tab. 

●Bolding/unbolding text at the [Textbox Properties] menu 
 

(1)  At the [Textbox Properties] menu, insert a check in the box for [Bold] and then click [OK]. 
*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

(2)  To unbold the text, remove the check from the box for [Bold] and then click [OK]. 
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●Bolding/unbolding at the [Home] tab 
 

(1)  Select the text (text box) which you want to bold and then click the  icon in the [Home] tab. 
 

(2)  To unbold the text, select the text and then click the  icon again.  

 
 *When cutting text or an object for which bold settings have been specified, lines may overlap depending on the 

font or object shape. 

 

3.4.9  Italicizing/Un-italicizing Text 

Set text to be italicized under the [Textbox Properties] menu or on the [Home] tab. 

●Italicizing/un-italicizing text at the [Textbox Properties] menu 

(1)  At the [Textbox Properties] menu, insert a check in the box for [Italicize] and then click [OK]. 

*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

*Unless a check has been inserted in the box for [Align With Border], the horizontal size of the text box will 

increase. 

 

(2)  To un-italicize the text, remove the check from the box for [Italicize] and then click [OK]. 
 

●Italicizing/un-italicizing at the [Home] tab 

(1)  Select the text (text box) which you want to italicize and then click the  icon in the [Home] tab. 

 

(2)  To un-italicize the text, select the text and then click the  icon again.  

 

3.4.10 Underlining/Removing Underline from Text 

         

Set/change underlined text at the [Textbox Properties] menu or on the [Home] tab. 

 

●Underlining/removing underline from text at the [Textbox Properties] menu 
 

(1)  At the [Textbox Properties] menu, insert a check in the box for [Underline] and then click [OK]. 
*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

(2)  To remove the underline from text, remove the check from the box for [Underline] and then click [OK]. 

●Underlining/removing underline from text at the [Home] tab 

(1)  Select the text (text box) which you want to underline and then click the  icon in the [Home] tab. 

(2)  To remove the underline from the text, select the text and then click the  icon again.  

 

3.4.11 Reversing/Un-reversing the Order of Text 

     

Set the reverse order for text or clear the reverse order in the [Textbox Properties] menu or on the [Home] 

tab. 

 

●Reversing the order/un-reversing order of text using the [Textbox Properties] menu 

 

(1)  In the [Textbox Properties] menu, insert a check in the box for [Reverse Order] and then click [OK]. 

*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

 

(2)  To un-reverse the order, remove the check from the box for [Reverse Order] and then click [OK]. 
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●Reversing the order/un-reversing the order of text at the [Home] tab 

(1) Select the text (text box) for which you want to reverse the order and then click the  icon in the [Home] 
tab. 

(2) To clear the reverse order from the text, select the text and then click the  icon again. 
 

3.4.12 Align/Un-Align Text with Border 

 

Set the text to align with border or not in the [Textbox Properties] menu. This function uniformly aligns text 

with the border of the text box. This function will fit text into a specifically sized area, such as a small field in a 

label, etc. 

 

(1) In the [Textbox Properties] menu, insert a check in the box for [Align With Border] and then click [OK]. 
 

*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

*Simply removing the check from the box for [Align With Border] will not change the display results. After 

removing the check, the display results will differ if changes are made to the text size, width, or text spacing. 

 

(2) To un-align the text, remove the check from the box for [Align With Border] and then click [OK]. 

 

 

3.4.13 Relationship between Text Box Size and Text Size 

 

● When entering 1 line of text 

The ratio between the height of the text and the text box will vary depending on the type of font. 
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⚫ Multiple lines of text: When a check is in the checkbox for [Align With Border] 

 

When preference is given aligning the text with the text box border, the text will automatically change size 

and shape to fit in the text box. Insert a check mark in [Align With Border] to apply these settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When "Align With Border" is checked, entering numbers in the line spacing field will not change the size of 

the text. Entries in this field will be ignored. 

 

● Multiple line entries: When a check is removed from the checkbox for [Align With Border] 
 

The size of the text box changes depending on values set for [Width], [Text Spacing], and [Line Spacing]. 

 

 

 

 

 

 

 

 

 

 

 

⚫ When creating layouts which use multiple lines of text. 

(1) If giving priority to text height [Size], we recommend removing the check from the box for [Align With Border], 

and entering one multiple-line text box, or using multiple one-line text boxes. 

(2) If giving priority to the text box size when creating layouts, we recommend entering multiple lines of text within 

a single text box. 
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3.4.14 Fix/Unfix the Position of a Text Box (Text) 

 

It is possible to fix the position of a created text box. 

Once the position has been fixed, it is not possible to move the object or change its size by using the mouse 

or keyboard. 
 
 
(1) In the [Textbox Properties] menu, insert a check in the box for [Fix Position] and then click [OK]. 

 

(2) To unfix the text box, remove the check from the box for [Fix Position] and then click [OK]. 
 
 

3.4.15 Setting Border Spacing Width 

 
      Automatically create cut-shapes based on the size of the text box. 
 

(1) At the [Textbox Properties] menu, insert a check in the box for [Square Cut] and then click [OK]. 

 

(2) To undo this setting, remove the check from the box for [Square Cut] and then click [OK]. 

       
       
 
 
 

*If necessary, adjust the Border Spacing values. When Border Spacing values have been set, cut-shapes are 

created by adding the Border Spacing values to the text box size. Initial values are 2.0 mm (0.08 in) for [Width] 

and 2.0 mm (0.08 in) for [Height]. 

 

*The only type of cut-shapes for this setting is [Rectangle]. If you want to create other cut-shapes, use a cut-

shape object without enabling [Border Spacing Width]. 

 

*Depending on the font design, text may protrude from the cut-shape. In such cases, change the Border Spacing 

values, or use a cut-shape object instead of enabling [Border Spacing Width] 

 

 

 

         

       

 

 

  

The bottom portion is protruding 

Cut-shape object 
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3.4.16 Rotating a Text Box (Text) 

  
(1) At the [Rotation] Field in the [Textbox Properties] menu, enter a number for degrees of rotation and then click 

[OK]. 
(2) The text box is rotated clockwise according to the entered angle (number of degrees). The number must be 

entered in half-width integers. 
 *By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 

 

●When textbox has been selected, it is also possible to rotate the text by dragging the rotation point.  
*If the rotation point is dragged while holding down the [Shift] key on the keyboard, the object is rotated in units 

of 15°. 
 

●When textbox has been selected, it is possible to rotate the text in units of 90° by clicking the rotate button 
on the Object toolbar. 

*Refer to “3.1.4 Rotating an Object.” 
 
 

3.4.17 Batch Settings for Multiple Text Boxes 

 
(1)  Select the text boxes for the batch. 

   *To select multiple text boxes, hold down the [Shift] key and click on the text boxes. 
 

(2) Right-click and select [Properties]. 
 
 

(3) The [Textbox Properties] menu is displayed. Batch settings are possible for items for where entry is enabled.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(4) Change the desired items and click [OK]. 

*By clicking [Apply], it is possible to apply settings without closing the Textbox Properties menu. 
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3.4.18 About Text Display 

 

The types of displayable text may vary depending on the font being used. When unincluded characters 

are entered via the OS, those characters may be displayed as blank spaces and need to be changed to 

different fonts. Not all fonts support all languages. 

 
Example) When displaying the Chinese character “髙” 

  
 
 
 
 
    
 
 
 
 
 
 

*This character is displayed as a blank space when using Arial font, and is displayed correctly when using Ming Liu. 
This is because Ming Liu is designed to show Chinese characters. 

 

3.4.19 Locating and Entering Non-Standard Characters 

 
Use IME Pad to locate non-standard characters and enter those characters into a text box (for international 
keyboard settings). 

(1) Open the [Textbox Properties] menu. 

(2) Open [IME Pad]. 
*Regarding how to install and use {IME pad}, follow the Windows operation manual. 
 

(3) From the list of displayed types in the IME Pad, select [Non-Standard Characters] to display a list of non-
standard characters. 

(4) Click the non-standard character which you wish to enter. Click the [×] in the upper-right corner of the 
window to close the IME Pad. 

 
 
 

 
 

 

 

 

 

 

 

 

(5) Return to the [Textbox Properties] menu, click the [Enter] key to execute the operation, and then click [OK]. 

*Only a dot (・) is displayed in the [Input Text] field, but click [OK]. 

*The entry method or screen display may differ depending on your OS, IME version, or other related programs. Please 

refer to the instruction manual for your OS or related program for setup instructions. 
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3.4.20 Changing the default font of the Text Box 
   Changing the language of BepopPC EX 
   Enable/disable Wizard menu at the startup 

 

  (1) Select [Setting] tab – [Properties] – [Basic Configuration]. 
 

  (2) Select the desired font in the [Default Font] and click OK. 

 
 

  (3) To change the language of BepopPC EX, select the desired language in the [Language] and click OK. 
 
  (4) To enable or disable the Wizard menu at the startup, select it in the [Display Wizard menu during startup]. 
 

3.5 Draw by Transforming Shape of Line of Text 

3.5.1  Draw by Positioning the Line of text in an Arch 

 

①  Click the  icon in the [Home] tab – [Text Options]. 

② The cursor changes into cross-hair. Decide on a starting point on the screen and click the left mouse button. 

Drag the cross-hair to create the desired drawing size and then release the left mouse button. 
The [Arch Text Properties] menu  
is displayed. Enter text. 

 
 
 
 
 
 
 
 
 
 
 

 

*Offset is used when arch text overlaps with an arch object. Offset makes it possible to open a space between the 

arch text and the arch shape even if they are the same size. The value set for offset must be less than one-half 

of the font size. 



 

73 

●Example of combining arch text and arch shape 

    When offset is “0.0 mm (0.00 in)”         When offset is “2.0 mm (0.08 in)” 

       
 
 
 
 
 
 
 
 

*The example shown above assumes that both the arch text and arch shape are perfect circles. In the case of 

ellipses, the arch text and arch shape may overlap depending on their sizes. In such cases, adjust the size of 

either the arch text or the arch shape. 

HINT: It is easy to align the arch text and arch shape by setting the offset, and leaving all other default properties the same. 

*Properties for the above example are listed below. 

Setting Arch text Arch shape 

Text box size (horizontal) 100 100 

Text box size (vertical) 100 100 

Text size 15 ― 

Arch height ― 15 

Text width 100 ― 

Line width ― 2.0 

Start angle 195 195 

End angle 345 345 

Rotate 0 0 

 

3.5.2  Draw by Positioning the Line of text in a special text box 

 

① Click the  icon in the [Home] tab – [Text Options]. 
 

② The cursor changes into cross-hair. Decide on the starting point on the screen and click the left mouse 

button. Drag the cross-hair to create the desired size and then release the left mouse button. 
 

③ The [Line Text Box Properties] menu is displayed. Input text.  
*The text size which is set when the top and bottom guidelines (dotted lines) forming the patterns are widened 

to their top and bottom limits.  
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       [Square Text] settings                          Default letter settings 
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3.6 Creating a Text Box with border 

3.6.1  What is “Text Box with Border”? 

     

Using "Text Box with border", not only the “Text box with border”, but also “Inversed text box” can be 

created with ease, without overlapping a “Text box” over a rectangle and align them. 

 

(1) To create a text box with border, click the  icon in the [Home] tab - [Text Options]. 
 

(2) Decide on the starting point for the cross-hair cursor and click the left mouse button. Drag the cursor to 
create the desired text size and then release the left mouse button. 

 
(3) The [Text Box with border Properties] menu will be displayed. Enter the text and specify settings. 

 
(4) Click [OK]. 

*By clicking [Apply], it is possible to apply settings without closing the Text Box with border Properties menu. 

 

Compared to “Text Box”, in “Text Box with border”, Border size, Vertical margin, Horizontal margin and 

Style can be changed additionally. 

To edit text in a text box with border which has already been entered, double-click the text box with border 

in the design window to display the [Text box with border Properties] menu. 

Enter text here. 
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3.6.2 Border setting of Text Box with border 

To change the size of the Text Box with border, as well as to change the settings of space between the text 

and the border, change the value in this section. 

 
By applying “Fixed” in the Border size, the size of the Text Box with border is fixed regardless of the size of 

the font size, the length of the texts and the number of rows of the texts, etc.  

Border size : Fixed 

 

On the other hand, by applying “Automatic resize”, the size of the Text Box with border is automatically 

resized in accordance with the font size, the length of the texts and the number of rows of the texts, etc.  

Border size : Automatic resize 

 

 

 

 

 

 

 

 

 

 

 

To change the space between text and the border, change Vertical margin and Horizontal margin. 

4.4mm 
= 
0.2+ 
0.5+ 
3.0+ 
0.5+ 
0.2mm 

10mm 

30mm 
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3.6.3 Style setting of Text Box with border 

To change the style of the Text Box with border, such as switching between “Text Box with border” and 

“Inversed Text Box”, change the settings in this section.  

 
 
No effect : Same appearance as “Text Box”. 
 
 

Border : “Text Box with border” 

Font colour and border colour are set independently. 

 

 

Inverse : “Inversed Text Box” 

Font colour and inverse colour are set independently. 
 

 

 

 

Colour : Either the border colour or the inverse colour is set 

 
 
 
 

 

 Line width: When “Text Box with border” is selected, the line width is changed in here. 
 

 
Letter Direction :  

When double byte characters are entered and relevant font is applied, to 
apply “Vertical” in Letter Direction, the texts are arranged in vertical 
direction, as shown as the example in the left. 
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3.6.4 Alignment of texts entered in Text Box with border 

To change the alignment of texts enterd in Text Box with border, click either one of the buttons below ; 

 
 [Align left] 

 
 

 [Align horizontal center] 
 
 

 [Align right] 
 
 

 [Horizontal justification] 
 
 

 [Align top] 
 
 

 [Align vertical center] 
 
 

 [Align bottom] 
 
 
       [Vertical justification] 
 
 

3.6.5 Character Size and Character Height 

 
In Text Box with border, “Character Height” is 
shown along with the Character Size setting. 
 

 
 

Character Size : Size of the character, including 
vertical margin of the selected font. 
 
Character Height : Approximate height of the 
character, not including vertical margin of the 
selected font. 
(The actual height depends whether the character 
is upper or lower case, etc.) 
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3.7 Drawing a Design Shape 
 

This software is equipped with a design shape function which draws an outline or solid shape in the design 

grid. 

The types of design shapes available are [Rectangle], [Rounded rectangle, Oval], [Circle, Ellipse], 

[Polygon], [Star], [Right Arrow], [Left Arrow], [Talk Balloon (Bold, Medium, Thin)], and [Arch shape]. 

For [Talk Balloon], select [Objects] - [Select Shape]-[Talk Balloon] from the menu and then specify 

[Bold], [Medium], [Thin]. It is not possible to change the number of wavy lines or the shape width for 

a talk balloon. 

 

 
 
 

The following is an explanation of creating a design shape and basic editing methods for design 

shapes, based on the example of a [Rectangle]. 

 
 

3.7.1 Drawing a Design Shape (Rectangle) 

 

Click the [Rectangle] icon in the [Home] tab – [Shape]. At the editing window hold down the left mouse 

button and drag the cursor to draw a new shape. 

 
 
 
 
 
 
 
 
 
 

3.7.2 Filling in the Interior of a Design shape (Print/Label only) 

 

It is possible to fill in the interior of all the following objects: [Rectangle], [Rounded rectangle, Oval], [Circle, 

Ellipse], [Polygon], [Star], [Right Arrow], [Left Arrow], [Talk Balloon (Bold, Medium, Thin)], and [Arch shape]. 

(1) Double-click the object to open the [Properties] menu. 

     
 
 
 
 
 
 
 
 
(2) Insert a check in the [Fill In] box, and then click [OK]. 

*In order to remove the fill effect, and display only the outside line, remove the check from the box for [Fill In]. 

*Depending on the size and line width of an object, some objects may be filled in even if [Fill In] is not selected. (Usually, 

small objects with thick lines) 

  

Design shape icons in the [Home] tab – [Shape] 

bar 
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3.7.3 Inverse Printing (Printing a shape but not the characters) 

Use the following procedures to leave the characters unprinted on this object. 

 
       
 
 
 
 
 
 
 
 
 
 
 
 
 

 

(3) Click the  icon in the [Home] tab – [Shape] and draw a rectangle design shape in the layout. 

Set the colour of the rectangle design shape to Dark green. 

 

 

(4) Open the rectangle properties menu by double-clicking the rectangle design shape, or by right-clicking the 

rectangle and selecting [Properties]. 

Insert a check in the box for [Fill In]. 

    

 
 
 
 
 
 
 
 

(5) Click the  icon in the [Home] tab – [Text Options], draw a text box on top of the rectangle which you just 
filled in, and enter your text.  

 
(6) Select the text box and click [Tape] on the colour bar. 

 
 

*Be sure set the text box to [Tape]. Do not set to white, setting the colour to white will tell the machine to print 
using a white ribbon. 

*If the text box is hidden behind another object and cannot be selected, move the object on top of the text box to 

the Back One  or Send to the Back  . 
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3.7.4 Advanced Settings for Rounded Rectangle, Oval 

 

Open the [Rounded Rectangle, Oval Properties] menu by double-clicking the rounded rectangle or by right-

clicking the rounded rectangle and selecting [Properties]. 

 

 

 

 

 

 

 

 

 

 

 

 [Circle Radius] Set the radius measurement for the corner in the rounded rectangle. Any number from 0 to half of 
the design shape height can be entered. 
(It is possible to input a number which is greater than half of the design shape, but the design shape will 
be drawn as an oval.)  

 

3.7.5 Advanced Settings for Circle, Ellipse 

Open the [Circle, Ellipse Properties] menu by double-clicking on the drawn circle in the design window, or by 

right-clicking the object and selecting [Properties]. 

 

       
 
 
 
 
 
 

 
 
  
 

[Perfect Circle] When a check is inserted in the box for [Perfect Circle], the circle or ellipse object will become a 

perfect circle. In this case, the perfect circle diameter will be the smaller number of either the width or the 

height. 

 

3.7.6 Changing the Line Width of a Design Shape (Rectangle) 

 

  (1)   Open the design shape [Rectangle Properties] menu by double-clicking the design shape rectangle, or by 

selecting the design shape, right-clicking, and selecting [Properties]. 
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(2)  Type in the value for [Line Width] and click [OK]. The up and down arrow buttons (▲▼) can also be used 
to change the value. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3)   The line width will be changed to the entered value. 

 

 

      
 
 
 

Possible line width values: 

・Rectangle / Rounded Rectangle, Oval / Circle, Ellipse / Right Arrow / Left Arrow 

0.2 mm to 3,200 mm (0.08 in to 125.76 in) 

・Polygon / Star:  

1.0 mm to 3,200 mm (0.04 in to 125.76 in) 

・Arch shape:  

1.0 mm to 3,200 mm (0.04 in to 125.76 in)  

*Number and decimal points must be input in half-width characters (for international keyboards). 

 

3.7.7 Advanced Settings for the Polygon Design Shape 

 

Open the [Polygon Properties] menu by double-clicking a drawn polygon shape, or by right-clicking the 

polygon and selecting [Properties]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Number of points]  Set the number of points for the polygon. Directly enter a value in the [Number of points] 

field, or click the up and down arrow keys (▲▼) to set a number for the polygon. A number from 3 to 15 

can be set. (An [Image (External line only)] will be displayed when the number of points is increased or 

decreased.)  
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3.7.6 Advanced Settings for the Star Design Shape 

 

Open the [Star Properties] menu by double-clicking on a drawn star object, or by right-clicking the star and 

selecting [Properties]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Number of Points] It is possible to increase or decrease the number of points protruding from the star shape. A 

number between 3 and 30 can be set. Type in the value in the [Number of Points] field, or click the up and 

down arrow keys (▲▼) to change the value. 

  

[Shape Adjust] It is possible to adjust the shape of the [Star] design shape by increasing or decreasing the depth 

of concavity. Move the mouse to the knob on the right of the [Shape Adjust] field. Click and hold the left 

mouse button to move the knob to either the left or right. Move the knob all the way to the left for a small 

difference between concavities, or move it all the way to the right for a large difference (pointy star). 
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3.7.7 Advanced Settings for the Arrow Design Shape 

Open the [Arrow Properties] menu by double-clicking a drawn arrow design shape, or by right-clicking the 

[Arrow] and selecting [Properties].  

 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

[Body Width]  The body width of the arrow can be changed. Align the mouse with the knob immediately under 

[Body Width] field. Click and hold the left mouse button and then move the knob to either the left or right 

in order to change the body width. A width between 0 (to the right) to the height of the arrow (to the left) 

can be set. 

[Point Size]  The point size of the arrow can be changed. Align the mouse cursor with the knob immediately under 

[Point Size]. Click and hold the left mouse button and then move the knob to either the left or right in order 

to change the point size. A value between 0 (right) to the width of the arrow (left) can be set. 
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3.7.8 Advanced Settings for Arch shape 

 

Open the [Arch Properties] menu by double-clicking a drawn arch shape, or by right-clicking an arch shape 

and selecting [Properties]. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

*The arch height includes the line width. 

*The arch height will be less than one-half the selection border for the object. 

If a number which is one-half of the object border size or greater is set, the center of the arch will exceed the 

object border size, and the arch will be filled in. 

 

3.8   Drawing a Straight Line 
 

(1)   Click the  icon in the [Home] tab – [Shape]. 

   

(2)   The cursor changes into cross-hair. Decide on the starting point on the screen and left-click. Drag the 

cross-hair to create the desired length and then release the left mouse button. 

 

*A horizontal or vertical straight line can be drawn by holding down the [Shift] key and dragging the mouse. 
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(3)   Open the [Straight Line Properties] menu by double-clicking the [Straight Line] which was drawn, or by 

right-clicking the [Straight Line] and selecting [Properties]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[Circle Radius] It is possible to set a number for the radius of both corners. A number from 0 to half of the line 

width can be specified.  

 

 
 
 
 
 
 
 
 
 
 
 
 

3.9  Drawing a Table 
 

3.9.1 Drawing a Table 

 

(1)  Click the  icon in the [Home] tab – [Table]. 
 
(2)  The cursor changes into cross-hair. Decide on the starting point on the screen and click the left mouse button. 

Drag the cross-hair to create the desired size and then release the left mouse button. 
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(3)  The [Table Properties] menu will be displayed. Specify settings for rows, columns, line width, width, and 
height. 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(4)  A table will be generated based on the set values. 

 
 
 
 
 
 
 
 
 
 
 
 

3.9.2 Moving Lines of Tables 

 

It is possible to move the vertical or horizontal lines by selecting the entire table, aligning the cursor with a 

line, and dragging the mouse to the desired position. 
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3.9.3 Selecting a Single Cell Within a Table 

 

It is possible to select a single cell by first selecting the entire table and then clicking a cell inside of the 

table. After selecting a cell, the table bar will activate, and it will be possible to adjust cell settings. 

Table tools 
 
 
 
 
 
 
 
 

*It is also possible to edit a cell by right-clicking, and selecting changes from the drop-down menu. 

 

3.9.4 Setting/Changing the Cell Height/Width 

 

Right-click on the selected cell, select the setting for [Row Height] and input the desired value for the cell 

height. The cell height (width) will be set/changed. 

*The value must be input as a half-width number if using a foreign keyboard. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.9.5 Inserting Rows/Columns 

 
Insert a new row (column) by right-clicking on the selected cell and select [Insert] - [Rows] or [Columns], or by clicking 

the           icons in the [Home] tab – [Table] – [Insert]. 

       
 

*New rows will always be inserted above the selected cell. New Columns will always be inserted to the left of the selected 

cell. 
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3.9.6 Deleting Rows/Columns 

 

Delete the row (column) containing the selected cell by right-clicking on the selected cell and select [Delete] 

- [Rows] ([Columns]), or by clicking the  icons in the [Home] tab – [Table] – [Delete]. 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.9.7 Evenly Distributing Rows (Height) or Columns (Width) 

 

It is possible to evenly distribute the row height or column width within the selected range by selecting 

multiple cells, right-clicking on the cells, and selecting [Distribute Evenly], or by clicking the      

icons in the [Home] tab – [Table] – [Distribute Evenly]. 

 
 

*To select multiple cells, first select a single cell and then drag the cursor. 

 
    
 
 
       
 
 
 
 
 
 
 
  



 

90 

3.9.8 Merging Cells 

 
It is possible to merge cells in the selected range by selecting multiple cells, right-clicking on the cells, and 

selecting [Merge cells], or by clicking the  icon in the [Home] tab – [Table]. 

 

 
       
 
 
 
 
 
 
 
 
 
 
 
 

3.9.9 Unmerging cells 

 
It is possible to unmerge cells in the selected range by right-clicking on merged cells and selecting 

[Unmerge Cells], or by clicking the  icon in the [Home] tab – [Table]. 

 

3.9.10 Setting/Changing the Cell Background Colour 

 

After selecting a cell, click a colour from the colour bar. 

The cell colour will change, and the colour selection arrow mark will move to the newly selected colour in 

the colour bar. 

 
   
 
     
       
 
 
 
 
 
 
       
 

 

Colour bar when CPM-300 is selected as the printer 

 
Black   Red   Blue  White  Dark Blue       Green  Yellow                                         Transparent 

 

Colour bar when CPM-200 is selected as the printer 

 
Black    Red  Blue  White    Dark Green  Green Yellow       Orange  Custom1 Custom2 Custom3  CMYK Transparent 
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Colour bar when CPM-100HG5 or CPM-100SHG5 is selected as the printer. 

 
Black   Red   Blue   White  Dark Blue Dark Green Green  Yellow  Gray  Orange  Custom1 Custom2 Custom3  CMYK Transparent 

 
Colour bar when CPM-100G3, CPM-100HG3 or CPM-100G5 is selected as the printer. 

 
Black   Red    Blue  White  Dark Blue Dark Green Green  Yellow  Gray  Orange                           Transparent 

                                                     
*Gray ribbon is no longer available. 

*When multiple cells have been selected, it is possible to change the colour for all selected cells by choosing a 

colour from the colour bar. 

*When multiple cells with the same background colour are merged, the background colour of the merged cells 

also become the same colour. When multiple cells with different background colours are merged, the 

background colour of the merged cells will be transparent. 

 

The following functions are disabled when cells are selected: 

・Cut-shape conversion 

・Bordering 

・Select all  

・Cut 

・Copy  

・Register clipart 

 

3.9.11 Auto-Positioning an Object in a Table Cell 

 
Upper/lower/left/right auto-positioning of an object is possible for a single cell in a table. 

(1)  First, select a single cell in the table. Next, select the object (Triangle Caution) for which you want to perform 
auto-positioning. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

First, select a 

cell. Next, select the object for 

which you want to perform 

auto-positioning. 
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(2)  The grid positioning menu will be displayed. Click the position which you want to use for positioning (in this 

case, center alignment). 

 
                   
 
 
 
 
 
 
 
 
 
 
 
 

 

(3)  The object (Triangle Caution) will be auto-positioned in the center of the cell. 

 
    

 
 
 
 
 
 
 
 
 
 
(4)  Perform the same procedure for the remaining cells and objects. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Assuming that the black design shape represents the cell, 

images of auto-positioning are as shown below. 

Upper Left 

Middle Left 

Upper Right 

Center 

Upper Center 

Lower Left 

Middle Right 

Lower Right Lower Center 
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(5)  Close the Auto-Positioning menu by clicking the [Close] button, or     . 

 
 ●Adjust spacing settings when aligning objects with cell borders 

When aligning objects to a cell border, it is possible to set the spacing values. Select [File] - [Properties] - 

[Object Border Settings] and then enter the desired numbers in the fields for Top, Bottom, Left, and Right. 

 

*Initial spacing values are as follows: Top: 0.0 mm, Bottom: 0.0 mm, Left: 1.8 mm, Right: 1.8 mm. 

(Top: 0.00 in, Bottom: 0.0 in, Left: 0.07 in, Right: 0.07 in) 

*Auto-positioning for cells is based on the inside of the table grid line. Auto-positioning for objects is based on 

the rectangle border. 

 
 
 
 
 
 
 
 
 
 
 
 
 

3.9.12 Entering Texts directly into Table Cell 

 
(1) To enter texts directly into table cell, after selecting a cell, double-click the same cell. The Texts in cell dialog 

opens and texts are entered.  

 
 
 
 
 
 
 
 
 
 
 
 

 
  

Double 

click 

Enter 

texts 
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(2) In the Texts in cell dialog, in addition to the same items as Text Box, Horizontal / Vertical margins in cell and 
Horizontal / Vertical alignments in cell are set. 

 

 
[Align left] [Align horizontal center]      [Align right]   [Horizontal justification] 

 
[Align top] [Align vertical center]     [Align bottom]  [Vertical justification] 

 
 

*When Simplified Chinese, Traditional Chinese or Korean version of BepopPC EX application software 
is installed, “Letter Direction” can be arranged as “Vertical”. 
 

Letter Direction :  
When double byte characters are entered and relevant 
font is applied, to apply “Vertical” in Letter Direction, the 
texts are arranged in vertical direction, as shown as the 
example in the left. 
 

 
 

3.10 Generating a Date & Time Field 

The following types of Date and Time field can be created. 

・Date, Month and Year ・Date and Month  ・Month and Year 

・Time, Date, Month and Year ・Date, Month and Year 

・Hour and Minute  ・Hour only  ・Minute only 

・Lot Number programmed with “Date, Month and Year” or “Hour and Minute” 

 

(1)  First, click [Home] tab – [Date and Time Field]. 

 

(2)  The cursor changes into cross-hair. Decide on the starting point on the screen and click the left mouse 

button. Drag the cross-hair to create the desired size and then release the left mouse button. 
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(3)  The Date and Time Field properties are shown. Enter the information and change settings as required. 

 
 

3.10.1   Details of the Date and Time Field properties 

 
[Format]   
Select format of Date/Month/Year and Hour/Minute respectively. 

*Either Date/Month/Year or Hour/Minute can be disabled. 
*Either one of Date/Month/Year or Hour/Minute must be enabled. 
 

[Date Selection Options]   

・Current date of printing : The printed date and time is as same as the clock of the Windows system. 

・Selected time and date : The printed date and time is fixed as entered here. 

・Calculate a future date : The printed date and time is calculated based on the clock of Windows 

system 

 
[CMYK Print]   

To print the label with only CMYK process colour ink ribbons, check in this box. Be sure to prepare 
all 4 kinds of the process colour ink ribbons. 
 

[Text Settings]   

Set Font, Text Size(Character height), Width(in percentage), Text spacing, Bold, Italicize, Underline 
and Fix Position. 
 

[Object Border Settings]   

Set dimensions and rotation of Date and Time field text box. 
 

[Alignment]   

・Border  

”Fixed” for automatically fixing the length of the text regardless of the number of characters entered. 
“Auto Length” for automatically adjusting the length of the text, fixing the character size. 

* When “Fixed” is selected, text alignment : “Align Left”, “Align Centre”, “Align Right” or “Align 
Width” can be set. 

  

Example : Generated Date Field 



 

96 

3.10.2     Lot Number settings 

 
(1) To generate the Lot Number based on the Windows system clock, select “Lot Number” either in the 

dropdown box of “Date” or “Time”. (At the bottom in each box) 
 

(2) Click “Settings”. 
 

(3) Enter and change the Lot Number settings as required. 
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3.11 Creating a Barcode (Print/Label only) 
 

3.11.1 About Barcodes 

       

      In Bepop PC EX, it is possible to create barcode labels which can be used in product management, logistics 

management, administrative management, etc. The following types of barcodes can be created. 

     Barcodes [List of specifications] 

Type Usable Characters Input Values Check Digit 

QR Code 
Letters, numbers, letters in 
most foreign languages 

1817 Digits 
(7089 if only numbers) 

  

EAN-13 (JAN-13) Numbers only 
12 Digits 
(With add-ons 14 or 17) 

Modulo 10/ Weight 3 

EAN-8 (JAN-8) Numbers only 
7 Digits 
(With add-ons 9 or 12) 

Modulo 10/ Weight 3 

UPC-A Numbers only 
11 Digits 
(With add-ons 13 or 16) 

Modulo 10/ Weight 3 

UPC-E Numbers only 
6 Digits 
(With add-ons 8 or 11) 

Modulo 10/ Weight 3 

CODABAR (NW-7) 0-9 A-D $  :  / +  -  . 
3-120 Digits 
(Including start and stop) 

Modulo 16 

ITF (Interleaved 2 of 5) Numbers only 
1-120 Digits 
(Including check digit) 

Modulo 10/ Weight 3 

CODE 39 
0-9 A-D $  :  / +  -  .  
space 

1-120 Digits 
(Including check digit) 

Modulo 43 

CODE 128 AACII 128 letters 
1-250 Digits 
(Including check digit) 

Modulo 103 

EAN 123 AACII 128 letters 
1-250 Digits 
(Including check digit) 

Modulo 103 

MSI Numbers only 1-120 Digits Modulo 10 

MaxiCode 
Letters, numbers, letters in 
most foreign languages 

1-138 Digits  

MicroQR 
Letters, numbers, letters in 
most foreign languages 

1-35 Digits  

PDF417 
Letters, numbers, letters in 
most foreign languages 

2,710 Digits  

MicroPDF 
Letters, numbers, letters in 
most foreign languages 

417 Digits  

Data Matrix 
Alphanumeric characters 
only 

3,116 Digits  

*QR Code® and MicroQR® are registered trademarks of Denso Wave Inc. 
 

 Restrictions & precautions for creating barcodes: 

・The background colour for barcodes is fixed as the tape colour. The bar colour is fixed as black. It is not 

possible to change colour by using the colour bar. 

・Barcodes cannot be registered as cliparts. 

・Mirror settings cannot be used for barcodes. 

(When included in a group, only the relative position within the group changes.) 

・Barcodes cannot be converted to cut-shapes. 

・If the printer is changed in tape settings, the barcode size in the layout may also change in some cases. 

Furthermore, if the Adjust Length function is used for the sheet, the correct length may not be set in 

some cases due to the barcode position, size, or rotation. 
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3.11.2 Creating a Barcode 

 
Barcodes are created by selecting the barcode type, and entering the barcode data. 

 

(1)  Click the  icon in the [Home] tab – [Barcode]. 

 

(2)  The [Barcode properties] menu is displayed. Click the [Type] and [Settings] tabs and specify settings for the 

barcode type, size and other subjects. 

 

 

② Click the [Input] tab and enter the data. 

 

 

③ When data entry is complete, click [OK]. A barcode object is displayed in the upper-left corner of the layout. 

 

 

 

 

 

 

*Depending on the type of barcode, [OK] may be disabled if the correct number of digits has not been entered 

for the data. In this case either add more digits, or change the barcode type. QR codes can register letters and 

numbers starting with a minimum of one character. 
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3.11.3 Barcode Settings 

This section explains barcode settings. 

 
      

*Example of settings when EAN-13 (JAN-13) is selected 

[Width]  5 types of [Size] can be set. (SS, S, M, L, LL)  

*SS size is a non-standard specification for EAN-13(JAN-13), EAN-8(JAN-8), UPC-A and UPC-E. 

*A bar ratio of 2:1 is not the recommended specification for CODABAR, ITF, and CODE39 (for SS, S and M sizes). 

*When these settings are specified, there is the possibility that the barcode cannot be scanned using a barcode 

reader. 

[Bar Height]  The height of the bar portion (excluding text) can be set from 4 mm to 1,000 mm (0.16 in to 39.30 

in), in units of 1 mm (approx. 0.04 in). 

*[Bar Height] settings are not available for two-dimensional codes (QR codes). 

 

[Rotation (Deg)]  A rotation angle of 0°, 90°, 180° or 270° can be selected. 

*The rotation angle for a barcode object can only be set at the [Barcode properties] menu. 

 

[Bar Ratio]  Set the ratio for thick bars and thin bars. [Bar ratio] can only be set when selecting CODABAR, ITF, 

and CODE39. 

 

[Add Margin]Use these settings to add a margin to the left and right sides of a barcode (for a QR code, the top, 

bottom, left, and right sides). When a check is inserted in the box for [Add Margin], a margin of 

approximately 6.35 mm (0.25 in) is added to the left and right sides of the barcode. 

(For a QR code, a margin of 4 cells is added to the top, bottom, left, and right sides.) 

 

[Check digit] The check digit function is added to prevent misreads by barcode readers. The function can be 

turned on and off only for CODABAR, ITF, and CODE39. For information on the calculation method used 

for specifications, refer to “3.8.1 About Barcodes". 

 

[Display Characters] Used to display data text beneath the barcode. Click the down arrow (▼) for [Display 

Characters] and select [On]. Text is displayed in a character size which is 0.25 times the [Bar Height]. 

The following settings cannot be specified for two-dimensional codes (QR codes): 

[Add On]  A 2-digit or 5-digit add-on code can be set only for EAN-13(JAN-13), EAN-8(JAN-8), UPC-A, and UPC-

E.  Insert a check in the box for [Add On] and to enable input of a 2-digit or 5-digit add-on code. 
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[Bearer Bar]  Settings can be specified for ITF only. When a check has been inserted in the box for [Bearer Bar], 

the [Add On] settings if fixed to “On.” 

 
An example of bearer bar display is shown below. 

 
 
 
 
 
 

⚫ CODE128, EAN-128: Explanation of Settings 

 

 

 

 

 

For CODE128 and EAN-128, readable characters are displayed in the center. 

Select an arbitrary start code from A, B or C. 

   

⚫ EAN-128: Explanation of Settings 

If a check has been inserted in the box for [Exclude Brackets] at the [Settings] tab of the [Barcode properties] 

window, input brackets are displayed in the readable characters, but the data is not displayed in the barcode 

symbol.  
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⚫ QR Code: Explanation of Settings 

         
[Size]  Two different types of specifying QR code dimensions are available.  

Specifying Module Size or specifying QR code dimensions. 

[Specifying Module Size]: QR code dimensions may automatically change depending on the  

   number of characters entered. 

QR code dimensions are changed by changing the Module Size, either by dragging the QR code 

itself, by selecting SS ~ LL or selecting “Larger than LL” and sliding the slide bar. 

When selecting the SS size, reading by the barcode reader can be made easier by specifying a high setting (8 or 

higher) for the print density in the print driver properties. 

[Specifying QR code dimensions]: QR code dimensions are changed directly depending on the  

entered QR code size (width). 

QR code dimensions shall not change regardless of the number of characters entered. 

 

[Model]  Select either [Model 1] or [Model 2]. [Model 1] supports QR versions 1 to 14. [Model 2] supports QR 

versions 1 to 40. 

 

[Improvement level]  Four levels of improvement can be selected: 7%, 15%, 25%, and 30%. (Numbers are an 

approximate estimate.) This improvement percentage makes it possible to read the total code word even 

when it is defective due to dots, dirt, or damage. However, depending on the position of dirt and damage, 

there are cases in which data repair cannot be performed even within the maximum possible repair 

percentage. 

 

[Start Mode] Select either [Auto] or [Binary]. [Binary] supports Simplified and Traditional Chinese charatcers.   

 

[Delete Characters]  This setting is used to delete commas, spaces, periods, hyphens, and line breaks which are 

entered in the code. 
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[Data Split Options]  The entered data is split according to the specified number and then connected as a single 

object. 

 

 

 

 

The text is connected in a vertical direction when a check has been inserted in the box for [Merge to 

Vertical].  

 

 

 

 

 

 

 

 

 

 

*Depending on the data entry, the size of each split portion may not be the same. 

 

 

 

 

Splitting increases the total number of characters for data entry. However, the maximum number of total 

characters is 32,767. 

 

 

[Details]  

 

The symbol version, which specifies the dimensions of the QR code as well as the maximum enterable 

number of characters, could be manually selected in the Details. If the dimensions of the QR code must be 

fixed regardless of the number of entered characters, manually select the desired version.  

Make sure that the selected version covers the maximum entered number of characters. 

 

In the Details, whether or not to add “Quiet Zone” (margin) could be manually selected as well. 
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3.11.4 Inputting a Control Code 

 
It is possible to input a Control Code only for CODE128, EAN-128, and QR codes. 

(1)  After entering barcode data, move the cursor to the position where you want to input the control code. Click 
[Control Code] to display the [Control Code] keyboard. 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
(2)   Select the necessary control code, and then click [Close]. 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(3)   Click [OK]. 

 

 

3.11.5 Barcode Serial Number Settings 

 

When printing a large number of barcode labels, it is possible to set serial numbers for a selected barcode 

object, or for a grouped object which includes a barcode object. 

Please view the section "5. Serial Numbering and Auto-copy" for more information on serial numbering. 

*It is not possible to set serial numbers for the CSV link barcode. To serialize a barcode linked to a CSV file, edit 

the database. 
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3.11.6 Linking from a Database 

 

It is possible to link the barcode to the Bepop PC EX layout from a CSV file, a text file or an Excel(xlsx/xls) 

file. For details, refer to “4. Importing a Database (CSV, TXT, XLSX/XLS File) and Printing a Formatted 

Label." 

 

*For CODE39 and CODABAR, if lower-case letters are contained in the database for the barcode which you want to 

link, the lower-case letters are automatically converted to upper-case letters for display.   

 

3.11.7 Cautions for Barcode Printing 

 

      Please observe the following cautions for barcode printing: 
 

・This printer is not a dedicated printer for barcode labels. Before using the barcode labels created using this 

printer, confirm that the labels can be read by the barcode reader which you use. 
 

・Our Company assumes absolutely no responsibility in the event that damages are incurred due to 

misreading of barcodes. 
 

・Always use a white tape and black ink ribbon when printing barcodes. (For CPM-100 series, we recommend 

the combination of the dedicated sheet SL-S153N Label PET White and the ink ribbon cassette SL-R101T 

Black-C.) When printing using other combinations, it may not be possible to correctly read barcodes in some 

cases. 
 

・Set the barcode width as wide as possible. When a small barcode width is set, reading using a barcode 

reader may not be possible. 
 

・The barcode shown in the design window is an image. It cannot be read as displayed in the window. 

・When printing barcodes, apply the appropriate tape setting in the printer driver properties as the tape 

actually printed. If the tape setting in the driver properties differs from actual tape roll, the printing may blur, 

thus making correct reading with a barcode reader impossible. 

 

3.12  Inserting a Clipart (Pictogram) 
 

Cliparts which were pre-installed in BepopPC EX or cliparts which you registered by yourself can be inserted 

into the editing window. There are two types of cliparts: [Cliparts] which can be used for cutting and spot-

colour printing, and [Colour Cliparts] which can be output during colour printing. *For details on the clipart 

registration method, refer to “8.  Registering/Editing Cliparts.” 
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3.12.1 Inserting Cliparts 

 

(1)   Click the  icon in the [Home] tab – [Cliparts]. 

     

 
 

(2)  Select the file name which you wish to insert from the list of cliparts and then click [Insert Clipart]. 

*Cliparts can also be inserted simply by double-clicking the image of the clipart. 

 

3.12.2 Inserting Colour Cliparts (Print/Label only) 

 

 (1)  Click the  icon in the [Home] tab – [Cliparts]. 

 
 

(2)  Select the file name which you wish to insert from the list of colour cliparts and then click [Insert]. 

*It is not possible to change the colours used in colour cliparts. However, it is possible to change colour cliparts 

to a spot-colour image.  
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3.13 Chevron (Print/Label only) 

“Chevron (Warning Stripe)” is a Wizard to generate the Chevron (Warning Stripe) which is used 

for Safety Signage and Warning Signage with ease. When the generated Chevron (Warning 

Stripe) size is changed, the specified stripe line width is kept unchanged. 

 

3.13.1 Draw the Chevron 

 

(1)   Click the  in the [Home] tab. 
 

(2)   The cursor changes into crosshair. Decide on the starting point on the screen and click the left mouse 
button. Drag the crosshair to the desired pattern size and then release the left mouse button. 
The Chevron is drawn. 

 
 

3.13.2 Chevron Pattern property settings 

Double click on the [Chevron Pattern] you drew, or after selecting the pattern right click on the mouse and select 
properties.  

 
⚫ Pattern and Colour Settings 

Pattern : the following three patterns are available. 
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⚫ 1st. Colour and 2nd. Colour 
The Warning Colours could be changed. 

 
 
*The Colour Bar colours are not applied to the Warning Stripe. 
 
 
 
 
 

⚫ Line Width 
Set the [Chevron Pattern] stripe width.  The default is 30mm (1.18 in). 

 
 

⚫ Auto-Border Cut 
Based on the size of the [Chevron Pattern], a cut-shape will automatically be drawn. 
 
Check in the [Auto-border Cut] in the property of [Chevron] and click [OK]. 
To remove, uncheck it and click OK. 
 
*The Border cut offset could be increased to the default offset.  
*By checking in the [Auto-border Cut], the Border cut rectangle with square corners is generated.  
 By checking in the [Rounded Corners], the Border cut rectangle with rounded corners is generated. 

  
  

The stripe width of 45deg. Diagonal The stripe width of Vertical 
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3.14 Wire &Cable Marking Wizard (Print/Label only) 

“Wire & Cable Marking Wizard” is a Wizard that quickly and easily generates Wire Marking 

Labels which are used for Electrical and Network Cable and Wire Mariking applications. Wrap-

around labels and Flag labels can be generated, for marking various kinds and sizes of 

cables. 

 

Supported Printers 

⚫ CPM-100G3 

⚫ CPM-100HG3 

⚫ CPM-100G5 

⚫ CPM-100HG5 

⚫ CPM-100SHG5 

⚫ CPM-200 

 

Applicable tape rolls :  

SL-S112GN White, SL-S115GN Yellow and SL-S110GN Clear for CPM-100G3/HG3/G5/HG5/SHG5. 

SL-S202GN White, SL-S205GN Yellow and SL-S210GN Clear for CPM-200. 

Recommended cut dial depth : 2.5 to 3.0. 

 

* Even though it is possible to use this Wizard functionality for CPM-300, however, there’s no 

CPM-300 adequate tape rolls available for Wire & Cable Marking. As such, CPM-300 is not 

recommendable for Wire & Cable Marking. 

 

3.14.1 Starting the Wire & Cable marking wizard 

 

(1) Click the button  in the [File] tab. 

 
 
*To not show this menu during the next startup, uncheck the bottom-right checkbox. 
 

(2) Click to select the label type in the menu. 

The wizard dedicated to the selected label type appears. 
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3.14.2 Wire & Cable marking wizard property settings 

The property settings for each label type can be entered or changed. To open the property 

settings menu, double-click (or right-click and select “property” for) the wire marker object in the 

main screen. 

For each label type, the wizard provides two tabs, “Label dimensions” and “Text” . 

 

Label dimensions tab (example of Non-Laminate Wrap Around Label) 

 
 

⚫ Cross section 
Select the cross secion shape of the wire or cable. 
After that, enter the appropriate dimensions of the 
labels in the boxes above. 
 

⚫ Background colour 
Select the background print colour of the label. 
*The colour settings for wire marking objects are 
only editable in the wizard. 
 

⚫ CMYK Print 
To print the wire marking label with only CMYK process colour ink 
ribbons, check in this box. Be sure to prepare all 4 kinds of the 
process colour ink ribbons. 
 

⚫ Marker Rotation (Deg.) 
To rotate the wire & cable marking 
label, select the rotation degree from 

0°/ 90°/180°/270°. 
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⚫ Select List 
The cross section and the dimensions of the wire & cable can be registerd. 
The registered files can be loaded and edited. 
 
Registeration of the cross section and the dimensions of the wire & cable 
(1) Click Save/Del. 
 
 
 
 
The “Register / Edit / Delete the cross section profile” menu appears. 

 
(2) Enter the file name and the appropriate wire or cable info., then click Register New. 

 
Loading the registered file 

Select the file from the Select List. 
 

Editing and overwriting the registered file 
(1) Select the file from the Select List. 
(2) Click Save/Del. 
(3) Edit the the cross section and the dimensions of the wire & cable. 
(4) Click Overwrite. 

 
Deleting the registered file 
(1) Select the file from the Select List. 

 
(2) Click Save/Del. 

 
(3) Click Delete. 
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⚫ Check the marking 
preview of the marking 
label. 
Three different preview types are available. 
 
Marking preview       Label preview   Placement preview 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
 
 

Text tab (example of Non-Laminate Wrap Around Label) 

 
 

⚫ Alignment 
Align the texts into Left / Center / Right. 
 
 
 
 

Shown as marker 
applied to wire or cable 

Shown as single label. 

Shown as multiple label 
copies arranged on a 
tape roll. 
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⚫ Format 
Set the number of repeated text lines placed in the label. 
Single side  : One line only, no repetions. 
Both sides  : One line each, on top and bottom. 
Repeat   : Specified number of repeated lines. 
Auto(Fixed text size)    : Repeating as many lines as possible 
 with the specified text size.  

 
 

⚫ Font 
Select Font. 
 
 

⚫ Size 
Change Font size. The 
actual character height 
is displayed at right. 
 

⚫ Width 
Change the character width. 
 
 

⚫ Text colour 
Change the text colour. 
 
 
 
 

⚫ Bold / Italicize / Underline 
Check the box to set these. 
 
 

Property Settings specific to Non-laminate Wrap-Around label 

⚫ Diameter  : Enter the diameter of the cable or wire. 
⚫ Circumference : Automatically set in based on the Diameter. 
⚫ Length   : Enter the label size that shows your text properly. 

Length can be selected from the list of preset lengths as well. 
* List of preset lengths : ”Xrow” means how many rows of labels are placeable on the 

width of the print media, specific to the printer selected. 
 “(XX.Xmm)” means the preset label length. 

 
⚫ Corner radius : Set to Auto or enter a specific value. 
⚫ Overlap  : Select from 1/4 turn / 1/2 turn / 1 turn. 
 
 

(Diameter) 

(Length) (Corner radius) 

(List of preset 
lengths) 
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 Property Settings specific to Self-laminate Wrap-Around label 

⚫ Laminate  : Select the number of laminating turns  
 from 1 turn / 1 and 1/4 turn / 1 and 1/2 turn / 2 turns. 

 
 

Property Settings specific to Flag label (I-Type) 

⚫ Flag length  : Enter the adequate flag length so that the text is shown properly.  

 

(Flag length) 
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Property Settings specific to Flag label (P-Type)(T-Type) 
⚫ Wrap length  : Enter the wrap length that ensures the label will be applied properly. 

 
⚫ Distance  : Enter the distance that ensures the label will be seen properly. 

 
 
Property Settings specific to Rotatable label (Non-laminated and Self-laminated) 
⚫ Temporary tack  : Enter the length that allows the label to temporarily attach, but also can 

be removed easily after wrapping, when reverse rotating or moving. 

 
 

  

(Wrap 
length) 
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Supplementary information on wire & cable marking 

 
⚫ What is a “Rotatable label”? 

It is a method of marking the wire & cable in a 
manner that the label does not adhere to the 
surface of the wire & cable. 
After marking, the completed wrapped label can 
be moved and rotated. 
 

⚫ How to apply the rotatable label 

  

Step 1 Step 2

Print labels designed with the Wire & Cable

Marking Wizard.

Fold along with the dotted cut line and stick

together.

Select either "Rotatable label(Non-laminated)" or

"Rotatable label(Self-laminated)".

Front Back

Dotted cut line

Step 3 Step 4

Attach the temporary tack portion to the

wire or cable

With Temp. Tack portion being used as an

axis, wrap the label in reverse one turn so

the printed text is as shown as below.

The wrapping direction is reverse to the

Temporary Tack application direction. The end of

the label should be applied over the beginning

portion of the same label.

Temp. Tack
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*In Step 4, the label must not be wrapped around wire or cable too tightly. If it wraps too tightly, it 
does not removed when rotated in Step 5. 
As well, in Step 3, the Temp. Tack portion must attach to wire or cable with not too large an 
area. 
Depending on the surface material of the wire or cable, as well as wire/cable diameter and the 
label length, set the adequate Temp. Tack length. 
*For Self-laminated labels, make sure to use Clear Tape Roll. 
 
⚫ To use Serial Numbering and CSV database connection functionality along with the Wire & 

Cable Marking Wizard, refer to the following sections ; 
Serial Numbering : 5 “Serial Numbering/Auto-copy” 
 
CSV database connection : 4. “Importing a Database (CSV File) and Printing a Formatted 
Label” 
 

⚫ The default font used in Wire & Cable Marking Wizard is “Consolas” in which “0(zero)” is 
clearly discriminated from “O(ou)” by its internal diagonal line. 
 

⚫ Colour coded markers 
In the colour swatch of Wire & Cable Marking Wizard, colour coded colours (CMYK) are 
also available for the colour-coding the background colours and text colours. When using 
colour-coded colours, make sure to prepare Process Colour Ink Ribbons and White or 
Clear Tape Roll. 

 
  

Step 5 Step 6

Rotate the label. The label is rotatable and movable.

Rotate the label to detatch the Temp.Tack portion

from the cabel, and attach it to the inside of the

label.

The Temp. Tack portion is no longer attached to

the cable or wire.



 

117 

3.15 Product Label Mode 
In “Product Label Mode”, labels applied for various industrial products are designed with ease, using 
dedicated feature such as Product Label Setup. Besides, as only necessary features are gathered in 
the Product Label Mode, no need to switch between the tabs. 
 

3.15.1 What are Product Labels? 

 
As shown, the Product Labels are generally 
applied to various industrial products, showing 
the important information on the product. 
Like in this example, in many cases, the label 
uses inversed background and/or inverse text 
box. 
 

In the Product label Mode, such effects are applied with ease. 
 

3.15.2 Starting the Product Label Mode. 

 

(1)  Click the button  in the [File] tab. 

 
(2)  Product Label Setup dialog opens. 

Dimensions : 
 Enter the dimensions of the label, as well as the label 
corner radius. 
 
 
Options : 
 To add cut frame as exactly the same dimensions and 
corner radius as the dimensions set in here, check in the 
Add Cut Frame. (Checked by default.) 
 
 To apply inversed background effect, check Inverse. 
 
 
Open a Template file : 
 To open a preset template file or a previously saved 
product label file, click this button. 
 Select a file in the dedicated “Product Label” folder to use 
it as a template for desiging a new label. 
 
 
 
 
 
 
 
 
  

CODE NO. 

C:\MAX\BepopPC EX\Template\Product Labels 
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(3)  Click OK to design a label in Product Label Mode. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 The design view is automatically zoomed in / out so that the designated label is fully shown. 
 

3.15.3 Buttons of Features in the Product Label Mode. 

 

 
 

Item Quick Reference 

 
[New Label] Create a new Label. 

 
[Open] 

Open a product label template or a previously saved 

product label file. 

 
[Select] Select an object 

 
[Select] Select an object 

 [Select All] Select all objects 

 [Cut] Cut a selected object 

 [Paste] Paste a copied or cut object. 
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 [Copy] Copy a selected object. 

 [Delete] Delete a selected object. 

 [Undo] Undo the last operation. 

 [Redo] Redo the last operation. 

 
 

 

Item Quick Reference 

 

[Font] Change the Font of the texts. 

 [Bold] Bold the texts. 

 [Italic] Italicize the texts. 

 [Underline] Underline the texts. 

 [Reverse Order] Reverse the order of the texts. 

 
 
 
 
 
 
 

Item Quick Reference 

 

[Text Box with border] Insert a Text Box with border. 
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Item Quick Reference 

 

[Shape] 
Draw various Shapes. 

 
[Rectangle] Draw a Rectangle. 

 
[Rounded Rectangle, Oval] Draw a Rounded Rectangle or Oval. 

 
[Circle, Ellipse] Draw a Circle or Ellipse. 

 [Polygon] Draw a Polygon (including a triangle). 

 
[Star] Draw a Star shape. 

 
[Right Arrow] Draw a Right Arrow. 

 
[Left Arrow] Draw a Left Arrow. 

 
[Speech Balloon] Draw a Speech Balloon. 

 
 [Bold Line] Draw a Speech Balloon drawn with Bold Line. 

 
[Medium Line] Draw a Speech Balloon drawn with Medium Line. 

 
[Narrow Line] Draw a Speech Balloon drawn with Narrow Line. 

 
[Curved Rectangle] Draw a Curved Rectangle. 

 
[Line] Draw a Line. 
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Item Quick Reference 

 
[Clipart Tools] Insert a Clipart. 

 [Multi Colour Cliparts] Insert a Multi Colour clipart. 

 [Cliparts] Insert a Single Colour clipart. 

*Prior to showing the standard mark or certification mark 

on the labels, please make sure of the marked product's 

compliance with each standard/regulation. 

The standard marks and certification marks included have 

been prepared in accordance with the standards and 

regulations as of Apr. 1, 2022. 

 
[Import] Import an object. 

 [Insert Illustration] Insert a preset Illustration file. 

 [Insert Graphic] Insert a Graphics file. 
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Item Quick Reference 

 
[Table] Insert and design a Table. 

 
[New Table] Insert a Table. 

 [Insert] Insert a Row or Column. 

 [Row] Insert a Row. 

 [Column] Insert a Column. 

 [Delete] Delete a Row or column. 

 [Row]  Delete a Row. 

 [Column]  Delete a Column. 
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Item Quick Reference 

 [Distribute Evenly] Distribute Rows or Columns evenly. 

 [Row] Distribute Rows evenly. 

 [Column] Distribute Columns evenly. 

 [Merge Cells] Merge Cells. 

 [Unmerge Cells] Unmerge Cells. 

 [Column Width] Change Column Width. 

 [Row Height] Change Row Height. 

 [Object-in-Cell Alignment] Align objects in Cells. 

 [Upper Left] Align objects to Upper left. 

 [Upper Center] Align objects to Upper centre. 

 [Upper Right] Align objects to Upper right. 

 [Middle Left] Align objects to Middle left. 

 [Center] Align objects to Centre. 

 [Middle Right] Align objects to Middle right. 

 [Lower Left] Align objects to Lower left. 
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 [Lower Center] Align objects to Lower centre. 

 [Lower Right] Align objects to Lower right. 

 
 
 

Item Quick Reference 

 
[Zoom to fit] Zoom to fit to the label size. 

 
[Zoom to Selection] Zoom to the selected object(s). 

 [Zoom percentage] Zoom to specified scale. 

 [Zoom In] Zoom in. 

 [Zoom Out] Zoom out. 

 [Change Grid Settings] Open the dialog of changing Grid Settings 

 [Screen Colour Settings] Open the dialog of Screen Colour Settings. 

 [Refresh Screen] Refresh Screen. 
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Item Quick Reference 

 
[Product Label Setup] Open the dialog of Product Label Setup. 

 
[Properties] General settings. 

  [Text Box Properties] Open the dialog of Text Box Printing options. 

  [Object Border Settings] Open the dialog of Table Cell Alignment. 

  [Basic Configuration] Open the dialog of Basic Configuration of the software. 

 [Custom Colour] Open the dialog of Custom Colour settings. 

 [Insert] Insert the designed label to the main design window. 
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3.15.4 Change the Label size etc. of the Product Label in progress. 

 

To change the Label size, corner radius, add/remove the Cut Frame or apply/disapply Inversed 

Background of the label in progress, the template label or previously saved label, click the 

button  to open the dialog of Product Label Setup. 
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3.15.5 Insert the designed label to the main design window. 

To insert the designed label to the main design window, click the button  . 

 
 
After that, in the following dialog, click “Yes” to insert the label and close the Product Label Mode. 

 
The designed label has been inserted to the main design window. 

 

Yes (Y) No (N) Cancel 



 

128 

3.15.6 How to save the label file in progress. 

In the Product Label Mode, it is not possible to save the label file in progress. 
To save the label file in progress, save it just after inserting to the main design window (even when it is 
still in progress and incomplete) as a new file, without adding any object and any change to the 
inserted label. 
For further details of “Save As” a new file, please check “2.6 Saving a BepopPC EX File Using a New 
Name”.  
Please make sure to save label file in the following folder, so that it is possible to resume designing 
the file later ; 
 
C:/MAX/BepopPC EX/Template/Product Labels/MyFolder 
 

 
 
After saving the file in progress in this folder, the file can be reloaded as a Template File in the Product 

Label Setup dialog. 
 
*The objects added to the label other than in the 
Product Label Mode, such as (normal) Text box, 
barcode, database link, Date and Time field, are 
removed automatically. 
 
*An object, which is applied any change other than in 
the Product Label Mode, is either removed or the label 
file itself may not be unable to be loaded as a 
Template File. 
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3.16 Cut-shapes 
 

3.16.1 What are Cut-shapes? (For Print/Label Designs) 

 

The “cut-shapes” are objects specialized for our printing and cutting machine. They are placed to surround 

text, cliparts, and layouts. The data will be cut out along the blue line which designates the cut-shape border. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.16.2 What are Cut-Borders? (Background for Cutting-Data) 

 

The “Cut-Borders” are the objects that are cut into another colour tape roll and used as the base objects for 

the texts and cliparts that have been made by cutting only. The cut-shapes are shown in aqua (light blue), 

the cut data is shown in black outlines. 

 
 
 
 
 
 
 
      

(1)  Set the cut-border and select [Print]. 

 

(2)  The message, [After finished with cutting, replace the original vinyl with vinyl for bordering.], will be 

displayed. After the cutting process for the first colour is finished, replace the first colour tape roll with the 

second colour tape roll, and then click [OK]. The cutting process for the second colour will start. 

 

    First tape roll cutting (Text)   Second tape roll cutting (Base) 

 
 
 
 
 
 
 

(3)  Print the cut data, weed the unneeded materials away from the design, and then stick the design to the 
base. 
  

Cut-Borders (For Cutting) 

The cut-borders are output to a different tape 

roll from the tape roll used as a background for 

the texts or cliparts which have been made by 

cutting. 

Cut-shapes (For Print/Label) 

The texts, cliparts, or layouts surrounded by the 

cut-shapes, and are cut out along the blue lines. 
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3.16.3 Cut-shape Types 

 

•Rectangle cut    •Circle/ellipse cut  •Border object 

•Rounded rectangle cut   •Rounded triangle cut 

•Right arrow cut    •Left arrow cut    •Cut Line (Straight Line) 

 

It is also possible to convert printing data to cutting data (text boxes, and clipart) by pressing the        

   icon in the [Home] tab or  icon in the [Home] tab – [Convert]. 

 

*You cannot draw a cut-shape in multi-strip printing mode “2 Bands (Restricted)”. 

*Image files, document files, and barcodes cannot be converted to cut-shapes. 

 

3.16.4 Cutting Properties 

 

The drawn cut-shapes are recognized as the cut-shape objects. You can edit (e.g. change the size, rotate, 

move, copy, and delete) the cut-shape objects in the same manner as editing other objects. Also, a cut-

shape object can be registered as a clipart. 

 

When you double-click on a cut-shape object, the cutting properties are displayed. You can set the properties 

of the cut-shape object here, including the width, height, circle radius (for rounded rectangle cut only), and 

perfect circle (for circle/ellipse cut only). 

 
 
 
 
 
 
 
 
 
 
 

3.16.5 Drawing a Cut-shapes 

 
You can draw following six types of cut-shapes with a mouse, in the same manner as drawing other 
objects. 

 

(1) Click an icon in the [Home] tab – [Cut Shapes]. 

 

•Rectangle cut...Click  in [Cut Shapes]. 

•Rounded rectangle cut...Click . 

•Circle/ellipse cut...Click . 

•Rounded triangle cut...Click . 

•Right arrow cut...Click . 

•Left arrow cut...Click . 

•Cut Line (Straight Line)...Click . 
 

 
(2) Left click and drag the mouse in the design layout. The selected cut-shape will be drawn. 
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3.16.6 Cut-shapes (Advanced) 

 

You can use cut-shape clipart to edit two designs in two different colours on the same design layout. 

Create one design with a normal black object, and create the other design with a cut-shape clipart. 

The following procedure shows how to make the sample shown below using cut-shapes, and how to setup 

the BepopPC EX to cut the design into a black tape roll and a red tape roll. 

 
  

 
 
 
 
 
 
 
 
 
 

In the following procedure, you will make a design to cut into red vinyl using a cut-shape object. The other 
design, which is to be printed in black, will also be drawn on the same window. 
 

(1) Set the design window to cutting mode by going to [Setting] - [Page Setting] - [Set up Output]- 
[Cutting Mode]. Draw a set of objects in cutting mode. 

  

 

 
 
 
 
 
 
 
 
 
 
 

(2) Select the object which will be cut in another colour (the red prohibition mark in this case), and then [Convert 

to Cut] (i.e. click the [Home] tab – [Convert] -    icon). 
 

 

 

 

 

 

 

 

 

 

        

(3) Set a black tape roll and execute [Print] (i.e. click  in the [Home] tab). 

Select [Cut+Cut-shape] under the [Content] field, and then click [Print]. 

(4) Only the black outline data on the editing window will be cut on the black tape roll. After the cutting process is 

finished, replace the black tape roll with a red tape roll, and then click [OK] in the tape exchange message on 

the screen. 
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(5) Next, the cut-shape object shown in aqua colour will be cut on the red tape roll. 

 

*If you use the cut borders (drawing a rectangular frame) function in this process, weeding will be easier. Also, the 

rectangular frame is useful for sticking two tape rolls together. The same rectangular frame (same in size and 

position) is printed on both the black tape roll and red tape roll. 

*The rectangular frame can be used to reference application position for two tape rolls, you can stick the tape rolls 

together at the same position as shown on the editing window (at the positions indicated with the arrows in the 

illustration). 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.16.7 Registering a Cut-shape Object as a Clipart 

 

(1) Select a cut-shape object, and then select [Home] tab – [Cliparts] - [Register Clipart].  

(2) Save the clipart under a new file name. 

(3) Click  in the [Home] tab – [Cliparts], and then select [Insert Clipart]. 

(4) Select the clipart you saved in step (2), and then click [Insert Clipart]. 

(5) The cut-shape object will be shown as a clipart. 

If you don't need the original cut-shape object, delete it. 
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3.17 Setting the Rectangular Border (For Cutting Only) 
 

3.17.1 What is the rectangular border? 

 

When a design is printed in cutting mode, the Bepop tape roll is cut in the shape of the letters, as shown in 

the following figure. 

The tape roll is then cut to remove the unwanted area to cut out only the letter parts (weeding). 

If you add a rectangular border around the text or design, the weeding process becomes easier. 

 

  
 

3.17.2 Drawing a Rectangular Frame for Cut Borders 

 

(1) While in the cutting only setting, Click  in the [Home] tab – [Cutting Tools], and then 

drag the mouse to specify the drawing range. 

 
(2) A pink rectangular border cut is drawn. 

  
 
 
 
 
 
 
 
 
 
 

*If you want to change the contents of a text box (or other types of objects) after creating the text box (or other types of 

objects) and drawing a rectangular frame to enclose that object as shown above, you need to change the layering of 

the objects. To do so, select the rectangular frame and select [Back One] or [Send to Back] from the object bar to 

send the rectangular frame behind the object. 

  For details, refer to “3.1.7 Changing the Layering of Objects”. 

  



 

134 

3.18 Adding an Extra Line Segment for Weeding (For Cutting Only) 

 
   To facilitate the weeding process when working with a cutting design, it may be helpful to add a cutting line 
(line segment). 
 

3.18.1 Adding an Extra Line (for Cutting) 

 

(1)  Click  in the [Home] tab – [Cutting Tools]. 
(2)  Left click and drag the mouse on the editing window. A line segment is drawn. 

     
 
 
 
 
 
 
 
 
 
 
 
 
 

           *Segmenting the unwanted area can make the weeding process easier. 

(3)   When you double-click on a line segment object, the line segment properties are displayed. 
 

 
 
 
 
 
 
 
 
 

3.18.2 Adding a Straight Line (for Printing and Cutting) 

(1) Click in the [Home] tab - [Cut Shapes]. 
(2) Left click and drag the mouse on the layout design window. A line segment is drawn. 

 

 
  

Line segment 

Line segment 

“Rectangular frame” is 
shown in pink. 
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(3)   When you double-click on a line segment object, the line segment properties are displayed. 

 
 
 

3.19 Using the Bordering Tool (Draw a Unique Cut-line Around Designs) 
 

3.19.1 Objects That Can Be Bordered 

 

Create a unique cutting border around printed text and cliparts automatically. 

The following objects can be bordered: 

• All Design shapes: rectangles/rounded rectangles/ovals/circles/ellipses/polygons/stars/arrows 

(right/left)/talk balloons (bold/medium/thin)/arch rectangles.   

•Tables  

•Text boxes   

•Special text boxes (Arch/Line) 

•Cliparts (except for the DXF file objects) 

 

*One or more objects can be selected to be bordered, as long as the objects are of the above types. 

*Grouped objects can be bordered as long as they contain the types of objects above. 

*Bordering is disabled in multi-strip printing mode “2 Bands (Restricted)”. 

 

3.19.2 Bordering 

 
(1) Select the object(s) to be bordered, by clicking on them.  

 

(2) Click  in the [Home] tab – [Cut Shapes]. 

 

(3) The [Bordering] menu will be displayed. Enter the Border Width value. 

 
     
 
 
 
 
 
 
 
 
  

[Border Width]  Specifies the width between the design and the cut line. You can specify a value within the 
range of 0.0 to 50.0mm (0.00 in to 1.97 in), in increments of 0.1mm (approx. 0.04in). 

*Be sure to use half-space numbers to enter a value for the border width. 
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(4) Click [OK]. The bordering process may take some time. In this case, the progress will be displayed during 

the process. 

     
 
 
 
 
 
  
  

*You can cancel the process while it is in progress. 
*You cannot cancel the process if the progress is 80% completed or more. Also, note that the process may 

continue for a while after clicking [Cancel]. 
 

(5)  The newly created border cut-shape object will be displayed together with the print data. 

 
*If the selected object to be bordered not within the size range shown below, the message, [Object size is larger 

than Bordering range.], will be displayed and the bordering process will not start. 

 

Horizontal design layout:                     Vertical design layout: 

       Width: 1.0 to 3000.0 mm (0.039 to 118.11 in)    Width: 1.0 to 275.0 mm (0.039 to 10.83 in) 

       Height: 1.0 to 275.0 mm (0.039 to 10.83 in)    Height: 1.0 to 3000.0 mm (0.039 to 118.11in) 
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3.19.3 Advanced Settings for Bordering 

 

You can customize the settings about border outline data. 

Customize the following settings if the outline data is not created as desired. 

 

(1)  Click [Details] in the [Bordering] window shown in 3.16.2. The following menu is displayed. 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
[Cut-line Quality]  Select from the three choices [Fine], [Normal], or [Rough]. 

[Fine]  The quality is the highest; however, the process takes a long time. 
 [Normal]  The quality is normal. 
[Rough]  The process time is short; however, the quality is rough. 

*The default option of [Cut-line Quality] varies depending on the size of the object to be bordered. 

*If the size of the object to be bordered is larger than 1400 mm (55.02 in), you cannot select [Fine]. 

 
[Bordering Accuracy]  Adjust the bordering accuracy by left clicking and moving the mouse on the slider.  

* The outline becomes more rounded as you move the slider close to [Fine]. However, note that if it is too close 
to [Fine], the outline may be jagged. 

* The outline becomes jagged as you move the slider close to [Rough]; however, the outline tends to be less 

round. 

* Normally, it is best to use the default setting. 
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3.19.4 Restrictions of the Border Function 

 

Additional information about the cut-shape made using the bordering tool: 

・When the bordering process is completed, the border becomes a blue cut-shape line. You can move, 

rotate, or change the size of the border; however, the border may become skewed if you do so. It is 

recommended to execute bordering as the final step before printing. 
 

・You cannot change the border width once the bordering has been completed. If you want to change the 

border width, delete the displayed border first, and then remake the border with a different width. 
 

・If the offset is less than 2.0 mm (0.08 in), the border may overlap the outline of the printing data. 

If you want to avoid this overlap, please set the border width to 2.0 mm (0.08 in) or larger. 
 

・You can use the bordering function in combination with the convert to print data function to bold letters. 

 

3.19.5 About the Outline Data After Bordering 

 

・The outline data may be angularly shaped compared to the object. Also, the border width may slightly 

be different from the set value in some places. 

 

・The more and the larger the bordered objects are, the more angular the outline data will be. The outline 

data will be more well-shaped when the objects are bordered one by one. As for the text boxes, the 

outline data will be more well-shaped with the datum that contains fewer letters. 

 

・If empty spaces exist inside the object, a border can be created inside those spaces. If such closed 

images are unwanted, delete them by referring to “3.13.6 Editing the Border Outline Data (Cutting 

Mode)”. 

 

・After bordering, if the outlines are overlapped or the outline data is not created as desired, delete the 

created border object and then execute [Bordering] again. This time, click [Details] in the first displayed 

menu and adjust the Cut-line Quality and Bordering Accuracy settings. For details about these settings, 

refer to “3.16.3 Advanced Settings for Bordering”. 
 

・It is possible to edit border outline data. Refer to “3.16.6 Editing the Border Outline Data (Cutting Mode)”. 
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3.19.6 Editing the Border Outline Data (Cutting Mode) 

 

(1)  Select both the border, and the bordered object, and edit them by going to [Home] tab - [Cliparts] – 

[Register Clipart]. 

 

 

 

 

 

 

 

 

*Although only the cut-shape object (border) can be registered as a clipart, selecting both the bordered object 

and the cut-shape object (border) will facilitate editing. 

(2)  Save the clipart under a new file name. 

(3) Click  in the [Home] tab – [Cliparts] – [Design Clipart]. 

(4) When the clipart editing window (BepopScanEX) is displayed, select [File] - [Read Clipart] from the 

menu bar to load the clipart you saved in step (2). 

 

 

 

  

 

 

 

(5)  Edit the loaded clipart. 

*For how to edit the clipart, refer to “8.13 Editing the Clipart Data Outline”. 

HINT: To delete the bordered object data selected in step (1), select it and click delete. If the bordered 

object is comprised of more than one closed image, continue as many times as needed. The 

closed images that are not needed for printing the border should also be deleted here. 
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(6) Save the edited clipart.  

Select [File] - [Save Clipart] From the menu bar on the clipart editing window to save the clipart under a new 
file name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(7) Select [File] - [Exit] from the menu bar on the clipart editing window to finish editing the clipart. 

Select [Cancel] for the message, "Do you want to paste clipart data?" 

(8) Go back to the design window of BepopPC EX, click  in the [Home] tab – [Cliparts]. 

(9) Select the clipart you saved in step (6), and then click [Insert as Cut-shape]. 

*If you execute [Insert Clipart] here, the clipart will be output to the same tape roll as the bordered object when 

printing. 

(10) Move the inserted object over the bordered object. Move new border to back layer, and Delete the border 
used in step (1). 

*The original border in step 1 and the edited object in step 9 have the outline data of the same size as edited. 

However, they are different in object size. 

 

3.20 Cutting the Borders and the Cut-shapes On Different Tape rolls 
 

If there are cut-shape objects on the editing window, you can output the cut-shape objects in different colour 

from other outline objects. To do so, print the black outlined objects first, exchange the tape roll in the printer, 

and then print border cut-shape object.  

(Data outline shown in aqua colour). 

 
Cut and bordering objects displayed on the same design window: 

   
Cutting objects only (Black lines) will be cut first: 
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Bordering cut-objects (Blue lines) will be cut second: 
*Before clicking [OK] in the tape exchange message, make sure to change the tape. 

   
 
Procedure: 

(1) Connect the printer to the PC. 

      *For details on the connection method, refer to the instruction manual (booklet). 

 

(2) Click  icon in the [Home] tab, or click  icon in the [Print] tab. 
 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(3)    Set the following items in the print menu. 
 

[Content] The three following settings are available [Cut+Cut-shape], [Only Cut], or [Only Cut-shape]. 

[Cut+Cut-shape] The black outline object and the rectangular frame are cut, and then the tape exchange 

message is displayed. Then the cut-shape object and rectangular frame are cut. 

[Only Cut]   Only the black outline object and the rectangular frame are cut. 
[Only Cut-shape]   Only the cut-shape object and the rectangular frame are cut. 

[Number of Copies] Set the number of copies to cut. The number of copies which can be selected varies 
depending on the selected printer type. 

*Clicking [Properties] displays the properties for the printer driver. 

 

(4)  Click [Print] to start printing. 

 

(5) If you selected [Only Cut] or [Only Cut-shape], this is the end of the output process. If you selected 

[Cut+Cut-shape], the tape exchange message will be displayed. After the first cutting process is finished, 

replace the tape roll and click [OK]. 

(If you click [Cancel] here, the printing process ends without printing the cut-shape object.) 
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3.21 Converting an Object to a Cut-shape Data 
 

(1) Select an object to be converted to a cut-shape data. 
 

(2) Click the [Home] tab – [Convert] -  icon. 
(3) The object is converted to a cut-shape. 

 
(Before)                         (After) 

 
 
 
 
 
 
 
 
 
 
 

 Additional Information: 

・The width, height, and rotation angle of the original object are retained even after it is converted to a cut-shape data. 

・The rectangular frames to cut borders, cut-shapes, object data without an outline data (e.g. a text box that contains 

only spaces), image files, document files, and barcodes cannot be converted to cut-shapes. 

・If you select more than one object at the same time and execute [Convert to Cut-shape], each selected object is 

converted to a cut-shape data. If a non-convertible object listed above is included in your selection, that object 

remains unconverted even if you execute [Convert to Cut-shape]. 

・If you select a grouped object that contains both convertible and non-convertible object and execute [Convert to Cut-

shape], only the convertible objects are converted to cut-shapes. The non-convertible objects remain unconverted. 

・If you select only rectangular frames or cut-shapes, [Convert to Cut-shape] is disabled. 

 

3.22 Converting an Object to Print Data 

 

(1) Select an object to be converted to a print (fill-in) shape. 

(2) Right-click and click [Change to Print Data] or click  in the [Home] tab - [Convert]. 

(3) The cut-shape data is converted to a print data. 

 

 

(Before)                          (After) 

 
 
 
 
 
 
 
 
 

 
*The width, height, and rotation angle of the original object are retained even after it is converted to a print data. 

*If you select more than one object at the same time and execute [Change to Print Data], each selected object 

is converted to a print data. The non-convertible objects remain unconverted. 
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4 Importing a Database (CSV, TXT, XLSX/XLS File) and Printing a 

Formatted Label 
 

Import a database (CSV, TXT, XLSX/XLS file) and print the included cells by inserting the data into a format. 

 

4.1 Importing a Database File 
 

(1) Click [Home] tab - [Database Access - Menu] - [Connect]. 
[Connect]   Selects a CSV, TXT, XLS or XLSX file, and make link between the database file and the layout. 
[Disconnect]  Closes the database window and disconnects the link between the imported file and the layout. 
[Change]    Disconnects the link between the current file and the layout, then makes a link with another file. 

       

 
 

(2)   Select a CSV, TXT, XLS or XLSX file and click [Open] to open the database window. 
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4.2 Database Window and Editing Steps 
 

Make a link between BepopPC EX and a database. You can edit in the design window and in the database 

window at the same time.  

 
 
 
 

 
 
 
 
 
 
 
 

 

*To input or modify the text in a cell, double-click the cell or press the ENTER key. 

*You cannot edit the rows that are marked with “#” in the print selection column. To edit information in the cells, 

turn OFF the “#” mark. 

*While displaying the field names, you cannot edit the BepopPC EX design window. 

*You can change the position and the size of the database window. 

*The maximum number of fields which can be linked in a CSV file is 350,000 cells (number of columns 

multiplied by number of rows), including the titles in the top row. 

 
      : Cuts the text data included in the selected cell and copies it to the Clipboard. 
 
      : Copies the text data included in the selected cell to the Clipboard. 
 
      : Pastes the text data in the Clipboard to the selected cell. 

 
      : Changes the number of row to the specified number. 
 

     : Inserts a new row above the selected cell. 
       

: Deletes the selected rows. 

  

: Pastes the selected field column to the design window. 

        You can select a display format from [Text], [Barcode], [Clipart] or [Image]. 
 

 : Displays the field name of the field column pasted to the design window. 

 

Field names 

Selected row/number of rows 

Print selection column 

You can switch the printing for a row ON/OFF by clicking 

this column. The rows marked with “#” will be printed. To 

turn ON all the rows, click [Print] at the top of the column. 

To turn OFF all the rows, double-clicking [Print] or SHIFT-

clicking on the print column. 

You cannot close the window by clicking this 

[Close] button. To close the window, click 

[Home] tab - [Database Access - Menu] - 

[Disconnect]. 

[Add to Layout] 

You can select the way to paste data in the 

design window. Select [Text], [Barcode],  

[Clipart] or [Image]. 
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4.3 Pasting to the Design Window 
  

In the database window, select a field for pasting into the design window and click [Add to Layout]. You can 

also paste the field to the design window by dragging and dropping the field name to the design window. The 

display format can be selected from [Text], [Barcode], [Clipart] or [Image]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

      

4.3.1 Paste the Linked Data as Text 

Text which has been pasted into the design window will remain linked to the database window, and show the 

contents of the row currently selected. 

If you double-click the linked text or right-click and select [Properties], the [Linked Text Properties] menu will 

be displayed. You can change various settings here. 

 

 

  
      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
[Field Name]   Shows the name of the field linked with the text. 

Select a field name with a 

cursor and drag & drop it. 
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[Shape Size]   Displays settings that can be used to determine shape size: [Auto Length] and [Fixed]. 

[Auto Length]  The size of the text box is adjusted automatically in accordance with the letters and the 

size/width/text spacing settings of the text. 

[Fixed] The size of the text box is fixed. 

[Arrangement] When the size of the text box is fixed, you can select the arrangement of the text in the text box 

from [Align Left], [Align Center], [Align Right], and [Align With Border]. 

 
[Align Left]:  
 
 
[Align Center]:  
 
 
[Align Right]:  
 
 
[Align With Border]:  
 

Additional information about linked text: 
 

・When the [Shape Size] is set to [Automatic Length], The size of the text box is adjusted 

automatically to fit the text length. If the text is too long, contents may be displayed outside of the text 

box. 

 

 

 
 
 
 

 
 

・When the [Shape Size] is set to [Fixed] and [Arrangement] is set to [Align Center] The width and 

spacing of the text are adjusted to fit the specified shape size, and the text is center-aligned. 

 
 
 
 
 
 
 
 
 

  ** This is the recommended setting for nameplate label applications. 
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・When the [Shape Size] is set to [Fixed Size] and [Arrangement] is set to [Align With Border], the 

width and spacing of the text are adjusted to fit the specified shape size, and the text is spread evenly. 

When the text is short, the text spacing is enlarged while the text width remains the same as it is set in 

the properties setting. 

 

 

 

 

 

 

 

 

4.3.2 Paste the Linked Data as a Barcode 

 

When a barcode pasted from the database into the design window it will become a linked barcode. Linked 

barcodes show the contents of the row currently selected in the database window. 

If you double-click the barcode or right-click the barcode and select [Properties], the [Barcode properties] 

window will be displayed. You can edit the type and settings of the barcode here. However, you cannot 

change the content of the barcode.  

(To change the content, you must edit the cell in the database window). 

 

    *Depending on the content of the linked barcode, [Invalid] may be displayed. 

If [Invalid] is displayed, edit the content of the data so that the contained text and the number of digits comply with the 

selected barcode, or select a different type of barcode. 

     
 
 
 
 
 
 
 
 
 

Cancel Apply 
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*When EAN-13(JAN-13), EAN-8(JAN-8), UPC-A, or UPC-E is selected, the barcode is displayed properly even if a check 

digit is included in the data content. However, note that if a wrong check digit is included, [Invalid] is displayed and the 

barcode becomes invalid. 

     
 
 
 
 
 
 
 
 

4.3.3 Pasting a Clipart from the Database 

 

By entering the path to the BepopPC EX clipart file location, the clipart in the specified path can be linked 

with the sheet and displayed with other data. The cliparts for BepopPC EX are stored in the following path 

when using default installation options (If non-default install is used, the following paths will be invalid). 

     

Cliparts: C:\MAX\BepopPC EX\Symbol\Folder name\Filename 

Colour cliparts: C:\MAX\BepopPC EX\ColourSymbol\Folder name\Filename 

 

(1) Click [Home] tab - [Database Access - Menu] - [Connect]. 

 

 

 

 

 

 

 

 

       

(2)  Select the column containing clipart path, and then click [Add to Layout] - [Clipart].  

You can also add the cliparts to the layout by dragging and dropping the field name to the design window. 
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(3) The clipart will be placed in the design window. 

       
 
 
 
 
 
 
 
 
 
 

*If you double-click the clipart or right-click the clipart and select [Properties], the linked clipart properties will be displayed. 

*The [Folder Name] field shows the field name of the linked clipart. 
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4.3.4  Linking the image files from the Database (Process Colour) 

By entering the path to the desired image file location, the image files in the specified path can be linked with 

the spreadsheet and displayed with other data.  

 

(1) Prepare the database in which the path to the desired linked images are entered. 
 
(2) Connect the database : [Home] tab – [Database Access - Menu] – [Connect]. 
 
(3) Select the row where the path to the desired image file is entered and click [Add to Layout] – [Image] or  

drag the field name and drop it on to the design window. 

 
 
The linked image is placed on to the design window. 

 
 
*Double-click the linked image to show the image property. 
*The Field Name shows the title of the linked column. 

 



 

151 

⚫ Aligning the image position. 
Specifies the aligning position of the linked image in the specified image frame. 

*Places the image in the specified image frame at Image Alignment. Keeping the ratio of the image, the linked 
image is stretched or shrunk so that its height or its width fits the image frame. 

 
 
 (Example) Image alignment “Left or Top” and vertically long linked image. 

 
 
<Drag the handle of the image frame downward so that the image is enlarged.> 
➔ Both of the image frame and the linked image frame are enlarged. 
 

 
 
<Drag the handle of the image frame upward so that the image is shrunk.> 
➔ Both of the image frame and the linked image frame are shrunk. 

  

Left or Top Center Right or Bottom 

Image frame 

Linked Image Frame (Blue) 
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4.4 Automatically Link Database Rows to your Design  
     

(1) Prior to print, connect the desired database and complete the settings as required. 
Do not disconnect it until the print is completed. 
 

(2) Click  in the [Print] tab.  
  

(3) Select an option from [Database Auto-Print Settings] and click [Print]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
[Database Auto-Print Settings] Choose between one of the two following options:  

[Current Row] The currently displayed row will be printed, regardless of selection marks “#” in the Print 
column. 

[Selected Rows] The rows marked with “#” are printed, regardless of the currently-displayed Rows. 

*You can switch the printing ON/OFF by clicking the print selection column in the database.  

(The rows marked with “#” will be printed.) 

 

[Auto-adjust printing length] If checked, the length of the tape roll is adjusted automatically to fit the 

object positions on the layout. 

*If you have edited data in the database window, the following message will be displayed when you attempt to 

close the BepopPC EX file. Select [Cancel] if you don't need to save the changes. 

 
 
 
 
 
    
 
 
 
 

*To arrange layout of all the data before printing, refer to “4.5 Automatically Positioning the Data Linked With a 

Database”.  

  

Yes (Y) No (N) Cancel 
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4.5 Auto-Copy Data which is Linked with a Database 
 

Database linked with a CSV, TXT or XLSX/XLS file can be positioned on the layout automatically for batch 

printing. By positioning all the layout before printing, it is possible to arrange the layout to minimize waste of 

the tape roll. 

(1) Paste all the field columns to be printed on the design window, and then use the tables and/or cut-shapes 

to make the label layout. 

(2) Select all the objects in the layout, including the linked texts, linked barcodes, tables, and cut-shapes. 

*Be sure to group all the objects in the layout. The auto-copy function is disabled until all the objects are grouped. Refer 

to “3.1.9 Grouping/Ungrouping Objects”. 

 

 
 

(3) With the grouped object selected, click [Home] - [Automatic Placement] - [Database Auto Copy].  

 
 

(4) The [Database Auto Copy] properties are displayed. In this menu, set the following fields: [Row Selection 

Options], [Vertical Spacing], [Horizontal Spacing], and [Number of Copies], and then click [OK]. 
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(5) The selected rows will be positioned on the design window automatically. 
*The linked text and objects in the design window will no longer be linked with the database after the auto-copy. 

 

       
 
 
 
 
 
 
 
 
 
 
 
 
 

*If size of the copied objects is larger than the data edit limits (3200 mm/125.76 in), the following message is 

displayed and the area outside of the data edit limits is not displayed. 

 
 
 
 
 
 
 
 
 

*You can reconnect the linked texts with the database by changing the field name in the properties window. 

However, note that you cannot edit linked text positioned on the design window even if they are not linked with 

the database (To edit this text, please reconnect to the database and edit it in the database window). 

*You can use [CTRL+Z] to undo the database auto-copy, which will reconnect you to the database and allow you 

to edit and adjust content. 

*The linked barcodes cannot be reconnected with the database again after the link is cut. 

However, the barcode data can be edited in the design window, when not linked with the database. 
Printing after using Database Auto-Copy 

 

Since the database link is cut after the auto-copy process is completed, the database auto-print functions will 

be disabled. Follow the normal printing procedure.  

 

Saving your layout after using Database auto-copy 

Since the link with the database is cut after the auto-copy process is completed, if you save the layout file 

after executing auto-copy, you need to link the file with the database again the next time you open this file. 

Do not save the changes when closing the file. 

 

*If you want to print keeping the link with the database, refer to “4.6 Printing the Rows Linked With a Database 

Without Using the Auto-copy Function”. 
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4.6 Printing Linked Data Without Using the Auto-copy Function 
 

You can view the layout in print preview, to print the data while remaining linked with the CSV, TXT or 

XLSX/XLS file. Since you don't need to position the rows or break the link with the database, it will be easier 

to print in some situations. For example, printing all the rows several times a day. 

 

(1) Paste all the necessary data fields into the design window, and then use objects and/or cut-shapes to 

make the label layout. 

 

(2) Select all the objects in the layout, including linked text, linked barcodes, objects, and cut-shapes. 

 
Be sure to include all the objects in the group. The auto-copy function is disabled until the objects are 
grouped. 

 

 

 
 
 
 
 
 
 
 
 
 
 

 

(3) With the grouped objects selected, click [Print] tab - [Data Position Preview] - [Database Access - Auto 

Copy]. 
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(4) The [Database Auto Copy] properties are displayed. In this window, set [Row Selection Options], [Vertical 

Spacing], [Horizontal Spacing], and [Number of Copies], and then click [OK]. 

 
(5) The print preview will be displayed. Check the preview, and then click [Single Colour Print] in the upper 

left. 

 
(6) The print menu will be displayed. Click the [Print] button to start printing. 

  

5 Serial Numbering/Auto-copy 
 

5.1 Setting a Serial Number and Auto-copying it to your Layout 
 

You can assign serial numbers to text boxes, barcodes, or grouped objects that contain text boxes or 

barcodes. The software will then position them automatically on the layout. Only alphanumeric characters 

can be used for a serial number. 

(1) Select an object (a text box or a grouped object that contains a text box) to assign a serial number. 
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(2) Click [Home] tab - [Automatic Placement] - [Sequential Numbering]. 

     
(3) The [Serial Numbering] menu will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) Select a text box to set a serial number from the [Selectable Data] list, and then click [>>(R)] to add it to the 

[Data for Serialization] list. 

 
 
 
 
 
 
 
 
 
 
 

(5) Select the text box in the [Data for Serialization] list, and then click [Details]. 
 

(6) Drag to specify the range (digits) to be set as a serial number, set the increments, and then click [OK]. 

 
 
 
 
 
 
 
 
 
 
 

*If you set the increments to be “1”, the specified data will increase by 1 number (or letter). 

*If you set the increments to be “2”, the specified data will increase by 2 numbers (or letters). 

 

(7)  After setting a serial number, click [Arrange] to open the [Serial Numbering Settings] menu. 

  

Added to the [Data for 

Serialization] list. 
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(8)  Set [Total Sequence Length] (total number of digits to be serialized), [Number of Copies], [Vertical 

Spacing], and [Horizontal Spacing], and then click [OK]. 

 
 

(9)  The objects containing the serial numbers will automatically be positioned on the layout design window, 
depending on the setting of the “Starting Position of Serial Numbering” either beginning from the upper left 
or beginning from the current position. 

    
    
 
 
 
 
 
 
 
 
 

* If the tape roll printing direction is set to [Horizontal], the object with the next serial number will be located below 

the current object. 

If there is not enough space below an object, the next object will be located in the upper right space. 
 

* If the tape roll printing direction is set to [Vertical], the object with the next serial number will be placed on the 

right side of the current object. 

* If there is not enough space on the right, the next object will be placed in the lower left space. 

  

Horizontal spacing 
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5.2 Print a Serial Number Layout (Print Preview) 
 

It is possible to print a serial number layout by displaying it in the print preview window, without positioning 

it in the design window. 

 

(1) Select an object (a text box or a grouped object that contains a text box) to assign a serial number. 

 

 

 

 

 

 

 

 

 

(2) Click [Print] tab - [Data Position Preview] - [Sequential Numbering]. 

Use the following steps to set a serial number. Up to step (8), the steps are the same as those 
mentioned in “5.1 Setting a Serial Number and Auto-copying it to Your Layout”.  

 
(3) The [Serial Numbering] menu is displayed. 

 

(4) Select a text box to set a serial number from the [Selectable Data] list, and then click [>>(R)] to add it to the 

[Data for Serialization] list. 

 
(5) Select the text box in the [Data for Serialization] list, and then click [Details]. 

 

(6)  Drag to specify the range (digits) to be set as a serial number, set the increments, and then click [OK]. 

(7)  After setting a serial number, click [Arrange] to open the [Serial Numbering Settings] menu. 

 

(8) Set [Total Sequence Length] (how many to be serialized), [Number of Copies], [Vertical Spacing], and 

[Horizontal Spacing], and then click [OK]. 

 

(9) The print preview window will be displayed. Check the preview, and then click [Print] in the upper left. 

 

 

 

 

 

 

 

 

 

 

(10) The print menu will be displayed. Click [Print] to start printing. 
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5.3 Auto-copying Objects on the Layout Using the Auto-copy Function 
 

You can auto-copy the selected object or grouped objects and position them in rows on the layout. 

(1) Select an object (a text box or a grouped object that contains a text box) to auto-copy. 

 
   
 
 
 
 
 
 
 
 
 

 

 

(2) Click [Home] tab - [Automatic Placement] - [Auto Copy]. 

     

(3) The [Auto Copy Settings] menu will be displayed. 

 
       

(4) Set [Copies], [Vertical Spacing], and [Horizontal Spacing], and then click [OK]. 
(5) The copies of the selected object will be positioned in a row on the tape roll, beginning from upper left. 
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5.4 Print Auto-copied Objects Using Print Preview 
 

You can print auto-copied objects by displaying it on the print preview, without positioning it on the design 

window. 

 

(1) Select an object (a text box or a grouped object that contains a text box) to auto-copy. 

 
   
 
 
 
 
 
 
 
 
 
 

 

 

(2) Click [Print] tab - [Data Position Preview] - [Auto Copy]. 

The following steps up to step (4) are the same as the steps in “5.3 Auto-copying Objects on the Layout 

Using the Auto-copy Function”. Use the following steps to auto-copy the object. 

 

(3)  The [Auto Copy Settings] window will be displayed. 

       

(4) Set [Copies], [Vertical Spacing], and [Horizontal Spacing] fields, and then click [OK]. 

 

(5) The print preview window will be displayed. Check the preview, and then click [Single Colour Print] or 

[Colour Print] in the upper left. 

 
 

(6) The print menu will be displayed. Click [Print] to start printing. 
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6 Importing CAD Data Using a DXF File to Create a Layout 
   

You can create a layout by importing CAD drawing data using the DXF format. 

 

6.1 Importing a DXF File 
 
  (1) Click [Home] tab - [Import ] - [DXF File]. 
  (2) Select a DXF file to import and click [Open]. 
  (3) Complete the DXF file import settings, and then click [OK]. 

     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
Addtional information about inporting files: 
     • A dot is represented by a shape of 3 mm X 3 mm (0.12 in X 0.12 in). 

      • To display a hatching as a filled shape, set “SOLID” with the CAD application. 

      • The linear shape or two-dimensional shape data other than the above are displayed according to the actual settings of 

the lines. 

      • OLE objects, image data, and three-dimensional data cannot be imported. 

      • The format (such as A4) must be specified in the DXF files beforehand. 

      • To display a shape converted to an outline by Illustrator as a filled shape, check the [Fill in entire block] box and set the 

polyline setting to [Show as a line]. 

 

  (4) The DXF object will be displayed on the design window. 
 
Additional information about editing the design window: 
     • The drawing data will be converted to one object. 

      • The letter data will be converted to a text box. 

      • Drawing data from versions “R12” and “R13” can be imported. However, the conversion accuracy is not guaranteed to 

be 100%. 

   • The objects (including the grouped objects) imported from DXF files cannot be registered as cliparts. 

   • If tape roll settings are set to [Cutting Mode], this function will be disabled. 

   • If a layout contains a DXF object and is set to [Cutting Mode], the DXF object will be deleted. Since the deleted DXF 

object cannot be restored, please be careful when using this setting. 
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7 Import an Image File or Document File (For Print/Label Only) 
 

With BepopPC EX, you can import an image file or a document file to the editing window and print it. 

   The following types of files can be imported. 

 

   
 
 
 
 
 
 

*You cannot use the colour bar to change the colours of image files and document files. To set the printing 

colour, right-click on the selected object, select [Properties], and then set the printing colour. 

*The default setting is [CMYK Print]. (The CMYK print is available with CPM-100HG5, CPM-100SHG5 and 

CPM-200 only. With other models, only single-colour printing is available.) 

*Image files and document files cannot be registered as cliparts, be converted to cut shapes, or use the mirror 

function. 

 

 

7.1 Inserting an Image File 
 

(1) Click [Home] tab - [Import] – [Insert Graphic]. 

       

(2) The [Select Image File] menu will be displayed. Select an image file and click [Open]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) The image file will be inserted on the editing window. 

 
 

 
 
 
 
 
 
 

 
 
 
 
 

Image 

File 

JPEG (.jpg,.jpeg) 

Document 

file 

Excel   (.xls,.xlsx) 

BMP  (.bmp) Word (.doc,.docx) 

WMF (.wmf) PowerPoint (.ppt,.pptx, pptm) 

PNG  (.png)    

GIF   (.gif)    

TIFF  (.tif)    
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7.2  Insert a Document File 
 

(1) Click [Home] tab - [Import] – [Insert Document]. 

       

(2) The [Select Document File] menu will be displayed. Select a document file to be inserted and click 

[Open]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) The document file will be inserted in the editing window. 

 
 

7.3  Insert an Illustration 
 

(1)   Click [Home] tab – [Import] - [Insert Illustration]. 

 

(2) The [Illustration] menu will be displayed. Select an Illustration to be inserted and click [Open]. 

*The default folder of MAX preset Illustrations is C:/MAX/BepopPC EX/Illust/. 

 
 

(3) The Illustration will be inserted in the editing screen. 
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8 Registering/Editing a Clipart 
 

8.1  Registering an Object as a Clipart 
 

Objects such as text boxes, select shapes, or combination of them displayed on the design window and 

registered as a “clipart”. 

 

(1) Select an object to register. You can select more than one object. 

 
 
 
 
 
 
 
 
 
 
 
(2) Click [Home] tab – [Cliparts] - [Register Clipart]. 

Click the ▼ button located to the right of the group name field to select a group on which to register the 
clipart. 

*To create a new group, click [Add groups] and enter a new group name. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4)  Enter a file name and click [OK] to register the object as a clipart. 

If another clipart in the group for registration has the same name, a confirmation message to overwrite the 

existing clipart will be displayed. 

*Up to 64 single-byte characters (or 32 double-byte characters) can be used as a group name or clipart name. 

*Note that the following characters cannot be used for a group name or clipart name. (If used, an error 

message, “Incorrect file name.” is displayed.) 

       ￥ / : , .  (for group name only) ; ” < > | ? * 
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8.2  Editing the Outline of a Clipart and Restrictions 
 

It is possible to edit clipart in BepopPC EX. The clipart registered in “8.1 Registering an Object as a Clipart”, a 

pre-registered clipart, or a clipart converted from bitmap data (such as scanned logo, etc...). 

 

The following is the general workflow for editing cliparts: 

１．Open the BepopScanEX（clipart editing window） 

２．Read a scanned image or another image file (.bmp, .jpg or .tif file type) 

３．Adjust the angle and density of the image. 

４．Outline of the data (using auto-trace function). 

５．Adjust the outline. 

６．Save as a clipart. 

 
Limitations/Precautions for clipart editing: 

・Only .bmp, .jpg or .tif image data can be read. 

・Make sure to use large, high-quality image files. Poor quality image files will lead to a poor-quality outline. 

・Mono colour bitmap files cannot use the colour threshold bar. 

・Closed loops cannot zoom-in or zoom-out. 

・Zooming in on a bitmap image can cause the background may shift out of alignment. 

・When adjusting a slanted image file, the image size may expand. 

・Adjusting the slant of an object more than two times, can cause the image to be crowded out of the frame. 

 
 

8.3  Operating BepopScanEX（clipart design window） 
 
 

(1) Click the [Home] tab – [Cliparts] – [Design Clipart]. 

 

(2) BepopScanEX（clipart design window）will open. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

BepopScan EX 

Clipart design 

window 
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8.4 Reading an Image File (.bmp, .jpg or .tif) 
  

8.4.1 Make a scan of the original 

 
(1) Prepare a document in the scanner while running the BepopScanEX software. 

 
(2)   In the BepopScanEX menu bar select [File]-[Select Scanner]. 

 
 
 
 
 
 
 
 
 
 

(3)  Choose the appropriate scanner and click select. 
*Only TWAIN type scanners are supported by this software. 

 

(4)  Click the    icon in the BepopScanEX tool bar or go to the menu bar and select [File]－ 

[Read Scanner]. 

*For instructions on Scanner use, refer to the instruction manual provided with your scanner. 

 
(5)  Turn on the scanner, when it has finished reading original copy, the data will be displayed. 

  
 
 
 
 
 
 
 
 
 
 

*When the scan is finished、it is possible that the computer will display a tab other than Bepop PC EX clipart 

editing window（BepopScanEX）. In this event, click the mouse on the clipart editing window（BepopScanEX）, 

and make sure that the clipart design window is chosen. 

 

*In the event that a scanner is not connected, or a scanner other than the “selected scanner” is connected, ”cannot 

find scanner” error message will be displayed. 
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8.4.2 Load a prepared image file 

 
This part will explain how to load an image file. 

*Only .bmp, .jpg or .tif image files can be used. 

 

(1) Choose [File]-[Read Image] from the BepopScanEX menu bar. 

 

(2) Chose the file, and click [Open]. 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

(3) Monocolour data will be displayed. When using a colourful bitmat image, the colour threshold can be adjusted 

with the threshold bar to display different colours. 

         
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Please use a large/high resolution image file. Using a low-resolution image will make the vector image outline 

difficult to draw. 
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8.5 Adjust the tilt of the data to be outlined 
 
    Learn to adjust the tilt of scanned files and image files. 
  
 

(1)  Click the      icon in the BepopScanEX tool bar, or go to the menu bar and select [Edit] - [Adjust tilt]. 
 

(2)  Draw a line along the base of the image you wish to adjust. Click and hold the curser over the place you wish 

to adjust, move the cursor to draw a line that is the same angle as the tilt, and then release the curser. 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) The data will adjust the data to be parallel with the line you drew.  
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8.6 Adjust the image density in order to draw an outline 
 

Adjust the image density of an image file or scanned file. 

(1) The threshold bar  adjusts the image density by moving from left to right. 

 

(2)  Moving the bar to the left will make the image less dense. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Make adjustments until the necessary image is displayed 
 

(3)  Moving the bar to the right will make the image denser. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Be careful avoid showing unnecessary dots and pixels. 

*Image density may not be able to be adjusted after scanning an image that uses choosing two values or a drawn 

image. 

*Colourful bitmap images can be read. However, unclear files may not be read effectively. 
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8.7 Draw an outline 
 

Change scanned data or image data into an outline. 
 

(1)   Click the      icon in the BepopScanEX tool bar, or go to the menu bar and select [Edit] - [Make 

Outline]. 

 

(2)   After outlining the data, marks that represent control points will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

*In some cases fine letters and images cannot be outlined correctly.  

If you encounter difficulty outlining the data, please readjust the image density. 

 

8.8 Paste designed clipart data to the layout 
 

Finish the clipart design processing by pasting designed data into the BepopPC EX design window. 

To save the designed clipart data, go to the BepopScanEX menu bar and select [File] － [Save Clipart]. 

 

(1)   Click the         icon in the upper right corner of the BepopScanEX window, or go to the menu bar 

and select [File] - [Exit] 

 

(2)   The following message will be displayed: "Image data has been changed. Save changes?" 

Select [Yes] to save image data, select [No] to continue on to step number (3). 

 

(3)  The following message will be displayed: "Clipart data has been changed. Save changes?"  

Select [Yes] to save clipart data, select [No] to continue on to step number (4). 

 

(4)  The following message will be displayed: "Do you want to paste the clipart data?" 

Please select [Yes]. 

 

(5)  The clipart data will be pasted on to the BepopPC EX design window. 

*The pasted clipart data will become an object in the software. 
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8.9 Save the image data of an outlined shape 
 

(1)  Choose [File]-[Save Image] in the BepopScanEX menu bar. 

        
(2)  Insert your filename and click [save]. 

*The data will be saved as a bitmap (.bmp) file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.10 Save clipart data 
 

(1) Click the      icon in the BepopScanEX tool bar, or go to the menu bar and select [File] - [Save clipart]. 

  

(2) The "Save clipart" menu will be displayed. Choose a group name from the drop-down menu, enter a filename, 

and click save. 
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8.11 Open previously saved clipart data 
 

(1) Click the       icon in the BepopScanEX tool bar, or go to the menu bar and select [File] - [Read 

Clipart]. 

       
(2) The "Select Clipart" window will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) Choose the clipart you wish to open, and click on the [Insert Clipart] button.  

 
 

8.12 Delete a clipart that has been saved 
 

Delete a clipart that has been registered. 

There are two ways to delete data, deleting the individual clipart file or deleting the group folder. 

 

(1) Click the [Home] tab – [Cliparts] – [Cliparts]. 

 

(2) Choose the group name and then file name of the clipart you wish to delete, click [Delete Clipart]. 

 

(3)  To delete a group, select the group you wish to delete and click [Delete Group]. 

 

*The deleted clipart files and groups will appear in the recycling bin. 

To delete the files from your system entirely, or return files from the recycling bin, refer to the instruction manual 

for your operating system. 

 

*Completely deleted pre-installed clipart groups cannot be retrieved unless BepopPC EX is completely reinstalled. 
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8.13 Edit the clipart data outline 
 

8.13.1 Definitions of the outline markers 

The □ symbol is a "corner point" for straight and curved lines, when selected the point will fill in and look like ■. 

The ○ symbol is the "control point" for curved lines. The shape of curved lines can be changed by moving the 

control point. When selected, the control point looks like●. 

 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.13.2 Displaying the previous background image. 

 

By clicking the     icon in the BepopScanEX tool bar, or by going to the menu bar and selecting 

[View]-[Display Background], it is possible to show or hide the background image. 

 

【Displayed Background】                        【Hidden Background】 

  
 
 
 
 
  
 
 
 
 
 
 
 

 
*The background is the image file from before the outline was traced. 

*The background bitmap data and the newly outlined data cannot be combined and saved.  

If the program is closed while tracing, then the background bitmap data will not be displayed when the program 

is re-opened. Please be careful. 

*Repetitively zooming in and out can cause the background bitmap data to shift out of alignment. 
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8.13.3 Moving "corner points" and "control points" 

 
It is possible to move the corner points and control points that you want by clicking and dragging with your 
mouse. 

(1) After clicking the point you want to move, the selected point will fill in, and the respective line will turn red. 

(2) Moving the point with your mouse will cause the line shape to change. 

 

            【Control Point】                               【Corner Point】 

   
 
 
 
 
 
 
 
 
 
 
 

It is also possible to move the points with your curser keys. 

 

* Pushing the curser key will cause the point to move by 1mm (0.04 in). 

However, by selecting [Set Grid] - [Adjust Grid] - [Yes], it is possible to move points to fit on the line of the grid. 

* By holding down the [SHIFT] key and pressing an arrow key, the point will move 10mm (0.39 in). 

* By holding down the [CTRL] key and pressing an arrow key, the point will move 0.1mm (0.004 in) at a time. 

 

8.13.4 Deleting unnecessary points 

 
(1)  Click on the point you wish do delete. 
 
(2)  Press the delete key, or Click on the     icon in the tool bar. 

* It is also possible to go to menu bar and select [Edit] - [Delete Points]. 
 

(3)  The corner point will be deleted. 
    

  
 
 
 
 
 
 
 
 

* The blue control points cannot be deleted. 

* It is possible to delete neighboring points without selecting them by repeating step (2). 
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8.13.5 Add a new control point 

 
 

(1) Click the      icon in the BepopScanEX tool bar, or go to the menu bar and select [Edit]－ [Add points]. 

 

(2) The curser will change to a crosshair(+). Match the curser to the place where you wish to add a point, and 

click. 

 
 
 
 
 
 
 
 
 
 
  
 

(3) The corner point will be added to the selected line segment. 

       
  

 
 
 
 
 
 
 
 
 
 
 
 

8.13.6 Change a straight line into a curved line 

 
(1) Select the straight line that you wish to change into a curved line. (Select the corner point, and the line segment 

changes to red.) 

     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2)  Click the       icon in the tool bar, or go to the menu bar and  

select [Edit]－[Switch Between Straight/Curved]. 

 

A new corner point has been added 
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(3)  Two blue control points will be added to the line segment. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

(4)  Adjust and move the curved line control points. 
 
 
 
 
 

  
 
 
 
 

 
 
 
 
 

8.13.7 Change a curved line into a straight line 

 
(1)  Select the curved line that you wish to change into a straight line (selecting the corner point causes the line 

to turn red). 
  
 
 
 
 
 
 
 

icon in the tool bar, or go to the menu bar and select [Edit]－ (2)  Click the     

 [Switch Between Straight/Curved]. 
 
(3) The 2 control points for curved lines will be deleted, and a straight line remains. 

  
   
 
 
 
 
 
 
  

Newly added control points 
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8.13.8 Draw a circle 

 

(1)  Click on the  icon in the tool bar, or go to the menu bar and select [Edit] - [Draw Circle]. 
 

(2)  Move your curser to the place where you wish to add a circle. By clicking and dragging the mouse it is possible 

to adjust the size of the circle. 

 
 
 
 
 
 
 
 
 
 

(3)  Once the circle is adjusted to the correct size, release the mouse button, and the circle will be added as 

outline data. 

  
    
 
 
 
 
 

* It is only possible to make perfect circles using this method. Ellipses cannot be made by this method. 
 
 

8.13.9 Drawing a polygon 

 

icon in the tool bar, or go to the menu bar and select [Edit] － [Draw Polygon]. (1)  Click the       

(2)  Move the cursor to the point where you wish to draw the polygon, left-click the mouse to lay down a start 

point. 

Next, move the mouse to a where you wish to place a corner point, and left-click the mouse to lay down the 

point.  

 
 
 
 
 
 
 

(3)  Double click when placing a new corner point to register that point as the last corner point. A line back to the 

start point will automatically be drawn, completing the polygon. 
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8.13.10 Delete a connected set of lines 

 
(1) Select the set of lines you wish to delete by clicking and dragging your mouse over a point on the line. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2) After selecting a set of lines, all the points will turn green. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(3) Press the delete key, click the       icon in the tool bar, or go to the menu bar and select  

[Edit]－[Delete]. 

 
(4) The chosen group will be deleted. 
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8.13.11 Move a connected set of lines 

 

(1) Click-and-drag your mouse over any point on the line to select the entire set of connected lines. 

 

(2)  When a set of lines has been chosen, every point in the set will turn green. 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     

 

(3) Click-and-drag one of the green points with your mouse to move the entire set of lines. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(4) Release the mouse when the set of lines has been moved to the target location. The new position will become 
its fixed position. 
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8.13.12 Copy and paste a connected set of lines 

 
 

(1) Click-and-drag your mouse over any point on the line to select the entire set of connected lines. 

 

(2) When a set of lines has been chosen, every point in the set will turn green. 

 

(3) Complete copy and paste by doing any one of the following: Type [CTRL+C] then [CTRL+P],  

 

select the copy icon      then select the paste icon right click the mouse and select 

[Copy] from the drop-down menu then right click again and select [Paste], or go to the menu bar and select 

[Edit] - [Copy] and then [Edit] - [Paste]. 
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8.13.13 Automatically compile two shapes using Merge 

 
It is possible to take two overlapping shapes and compile them into one by using Merge. 
 

(1) Select the two overlapping images by clicking and dragging the mouse over points on each of the on each 

of the shapes. The points will turn green when selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2)  Click the "Merge" button. 
     

 
 
 

 
(3)  The image will be merged automatically, and the points of overlap will join together. 

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* In the case the merger cannot be completed, the following message will be displayed. 

 
 
 
 
 
 

       
 
 
 
 

Overlapping part 
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8.14 Exiting from the clipart design 

 

(1)  Choose the         icon located in the upper right corner of BepopScanEX, or go to the menu bar and 
select [File] - [Exit]. 

(2)  If the outline data has been changed, the following message will be displayed, "Clipart data has been changed. 

Save changes?" To continue without saving select [No]. 

(3)  If image data was imported during the editing process, the following message will be displayed, " Image data 

has been changed. Save changes?" To ignore changes in the image data select [No]. 
* If [Yes] is selected, the image data will be saved as a mono-colour image. 

* The menu bar cannot be accessed while drawing a shape (polygon). Finish drawing the shape before exiting by 

using the menu bar. 

 

8.15 Zooming in and out in the clipart design window 
 

(2) Click and select .  

The zoom feature is usable in the following percentages: 10, 20, 30, 40, 50, 60, 70, 80, 90, 

   100, 150, 200, 400, 800％ 

（Depending on the size of the Bitmap data, some percentages cannot be used) 

(3) It is possible to zoom in and out on a designated point. 

 

Click the magnifying lens icon  to change the curser into a zoom tool. 

（Left click to zoom-in and right click to zoom-out.)  
 

To return the curser to selection mode, go to the [Home] tab and click the  icon. 

 

8.16 Set the design grid in the clipart design window 

 

(1)   In the BepopScanEX menu bar, click on [View]－[Set Grid]. 

(2) The grid setup menu will be displayed. 

 

 

 

 

 

 

 

        
[Setup Grid]    Choose [Yes] or [No]. 

[Set Spacing]  Enter the desired grid spacing (1～50mm/ 0.04 in～1.97 in). 

 （When writing in foreign keyboards, use half-width characters only numbers） 

     [Adjust Grid]  Set the control points to automatically align with the grid. 
   Please select [Yes] or [No]. 

 

(3) Select [OK] to display the grid settings. 

* Depending on the grid spacing and the zoom settings, the grid may not be displayed. 
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8.17 Register a colour clipart 

 

Register a multicoloured object as a colour clipart. Registered colour cliparts can be inserted into the layout 

by going to the [Home] tab – [Cliparts] and clicking the    icon.  

 

(1) Make a colour clipart. Be sure to group the objects together to make one colour clipart. 

* Be sure to limit the groupings strictly to 1 group only. Grouping objects together multiple times will make it 

impossible to save the colour clipart correctly. 

 For an example, when there are grouped objects A and another grouped object B, then all of these are grouped 

again and saved, it will become unusable object as colour clipart. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(2) Click the [Setting] tab – [Change Grid Settings]. 
 

(3) When the Design Grid Settings menu opens, go to the "Align objects with grid" column and select [Yes]. 

 

 

    

 

 

 

 

 

  

Grouped already 

Grouped again 

No good as a colour clipart 

Not Grouped yet 

Grouped once only 

Good as a colour clipart 



 

185 

(4) Using the arrow keys on the keyboard, adjust the colour clipart position so that the black dot「■」in the 

upper left corner is even with the upper left corner on the design window. 

 

※Make sure to adjust the position of the clipart so that it perfectly fits in the corner. 

  If the clipart is not saved in the position, it will not be registered as a colour clipart. 

 

 

 

 

 

 

 

 

 

 

(5) After positioning of the shape is complete, click [File] tab - [Save As]. Save the image in the following 

location: C Drive → MAX → BepopPC EX → ColourSymbol → choose a folder that already exists, or make 

a new folder and save the object. 

※Make sure to save it in an existing folder located in [ColourSymbol], or make a new folder in [ColourSymbol]  

The clipart must be saved in a folder located one layer under [ColourSymbol]  

 

(6)  The file will be register as a colour clipart. 
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9 Use a pre-installed template 
 

A complete layout can be made easily by making use of a pre-installed template. 

 

9.1 Choose a template 
 

(1)  Click [File] tab - [Templates] - [Templates]. 

 

(2)  The template menu will be displayed 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(3)  Select a file, and click [OK]. 
*Click the black triangle ▼ to open the dropdown menu and view other template types. 

*Depending on the selected printer type, the displayed templates may change. 

 

9.2 Edit the templates 

 

(1) Open a template. 

(2)  In an area where there is a text, double click it and a text box property menu will be displayed. Edit 

the content of the text box. 
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10  Use the user template 
By registering your designed file in the selected folder, it is possible to preview the content without opening the 

file so that you can find the file you need. 

 

10.1 Selecting the User Template File Save Location 

 

(1) Click [Setting] - [Properties] - [Basic Configuration]. 

 

(2) Click [Open] for user template file save location. 

 

(3) Choose the desired folder, and click the [OK] button. 

 

*The user template files that are directly saved in the [user template file save location] cannot be opened. Be 

certain to make a [Group] (folder), and save the file inside the created [Group] (folder). 

*To delete/change folders and file names in the [user template file save location], please open them in your 

Windows File Explorer window. 

 

10.2 Register a User Template 

 

(1) With the BepopPC EX file you wish to register opened in the design window, click the  icon in the 
[File] tab – [Templates]. 
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*If there is no group created in the [user template file save location], the below error message will be 
displayed. 
If you continue by pressing OK, the [Create folder] window will be displayed, and a new group can be 
created. 

 
 

(2) In the user template registration menu, enter the file name for registration and click [OK]. 
*It is not necessary to enter the file extension (.lpb) while registering a file name in [User template file 
save location]. 

 

▼ 

The file layout will be saved as a user template. 

※It is possible to make a new group in the user template [User Template Registration] window. It is 

possible to create new group by clicking on [Create folder]. 
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<Overwriting (updating) a user template file> 
 

(1) Choose the file displayed in the [User Template Registration] window and click [OK]. 
 

(2) Click [Yes] in the overwrite confirmation screen. 

 

▼ 

The file registered as a user template will be overwritten (updated). 
 
*User template registration is different from saving a file (2.5 Saving a BepopPC EX file). 
After completing the user template registration, a diaog asking if you want to save the currently edited file 
shall appear. Please save the file if necessary. 
 

<Register a user template file which has database link> 

 
For the file linked to a database, the database [Character Encoding] and [File Type] will automatically be 
displayed in the [User Template Registration] window.  
Make any necessary changes. After clicking the [OK] button, your user template file and linked database will 
be registered in the user template file save location. 
 

Yes (Y) No (N) 

Cancel 
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10.3 Opening a user template 
 

(1) Click the [File] tab – [Templates] – [Custom Template]. 
 
*If any group does not exist in the designated [user template file save location], the below error message 
will be displayed.  

Please refer [10.1 Selecting the User Template File Save Location], and please set the [User template file 
save location]. 

 
 

(2) In the [User Template] window, select the file you wish to open and click [OK]. 

 
 

< Referencing a database linked file in the user templates > 
 

(1) When referencing, the below window will appear. Click [OK]. 
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(2) Save the shared database, which is linked to the referenced file, in the local drive for editing. 

 
*It is not possible to overwrite the database which is linked to the referenced file. 
Please be sure to Save As the database. 

 
 

11  Input and print using tape mode 
 

Tape mode is a mode that is designed to make nametags, rack labels, and file labels with the CPM unit a fun 

and easy process. 

 

Enter label content (5 at a time), set the tape width, and the BepopPC EX software will automatically position 

the data over the layout in the most efficient position. Labels with cut-lines can be finished quickly. 

 

11.1 Enter the text in the tape mode window 
 

(1) Click the [File] tab - [New (Tape Mode)]. 

 

(2) [New Draft (tape mode)] window will open. Fill in the tape in order starting with Tape 1. 

Text can be entered in windows Tape 1 ~ Tape 5, with a maximum of five windows. 
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11.2 Set the tape size 
 

(1) Go to the [Width field and click on the ▼ icon to open the drop-down menu. Set the tape width. 

The following widths can be set: 

4 ㎜、6 ㎜、9 ㎜、12 ㎜、18 ㎜、24 ㎜、32 ㎜、36 ㎜、42 ㎜、48 ㎜、50 ㎜、 

60 ㎜、70 ㎜、80 ㎜、90 ㎜、100 ㎜  

0.16in, 0.24in, 0.35in, 0.47in, 0.71in, 0.94in, 1.26in, 1.41in, 1.65in, 1.89in, 1.97in, 2.36in, 2.75in, 3.14in, 

3.54in, 3.93in  

(2)  Click on the［Length］field and fill in the size.  

Set numbers between 5～1000mm (0.20 in~39.30in), and in 1 ㎜ (approx. 0.04 in) units. 

Put a check in the [Automatic] box to make the tape size adjust automatically based on the entered text.  

(If entering data using a foreign keyboard, enter half-width characters) 

(3)  Click on the［Margins］field, and enter the margin size. Set numbers between 0~50mm (0.00 in~ 1.97 in) 

and in 1 mm (approx. 0.04 in) units 

 

 

11.3 Settings for font/text width/text spacing/text direction 
 

(1)  Go to the［Font] field and select a font by clicking on the ▼ icon and opening the drop-down menu. 

(2)  Click on the ▼ icon in the［Width］field to open up the dropdown menu to set the width. 

Or manually enter the numbers with your keyboard (Foreign keyboards must enter the number in half 

width characters). Values between 50～200％ can be set in 1% increments. 

(3) Click on the［Spacing］ field and input spacing values. (Foreign keyboards must enter the number in 

half width characters). 

(4) In the［Letter direction］field, enter either "Portrait" or "Landscape" to set the direction of the lettering. 
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11.4 Settings for producing rounded corner cut-shapes 
 

Change the cut-shape from the default (square corners) to a rounded corners setting. 
      

(1) Check in the checkbox for [rounded corners]. 
 

(2) Change the radius of the rounded corners by adjusting the set values. 
    Click on the▲▼arrows to adjust the values, or enter a value directly. 

 (If using a foreign keyboard, fill in with half-width characters). 
 *Only values between 0 and half of the size of the shape can be set. 

 

11.5 Set the number of copies                          
      

Copy the prepared content by setting the number of copies.  

In the copy field, use the▲ and ▼ icons to change the value, or enter a number between 1 and 9 directly. 

(must use half-width character numbers). 
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11.6 Check the print preview, and print 
 

11.6.1 After checking the print preview, print 

 
(1)  After entering contents and settings [New Draft (tape mode)] menu, click on [Print Preview]. 

(2) The screen will change to the print preview window, and the contents will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

※Image is of a 24mm (0.94 in) width labels. 

(3)  Select [print]. 

(4) Your contents will automatically be added to the design window, and the print menu will be displayed. 

(5)   After checking each item, select [Print] and the printer will start automatically. 

    *About data auto-positioning  

    When the label length is less than 100mm (3.93 in), the tape will automatically print vertically. 

    When the label length is greater than 100mm (3.93 in) the tape will automatically print horizontally. 

 

11.6.2 Magnify the print preview display 

 

(1) Select [Expand View] in the print preview window.  

(2) The contents will be magnified.  

 

11.6.3 Return to the [New Draft (tape mode)] window 

 

(1) Click on the [Cancel] button in the print preview window. 

(2) Screen will return to the [New Draft(tape mode)] window. 

*If changes and corrections are necessary after viewing the print preview window, click the [Cancel] button and 

return to [New Draft (tape mode)] to make corrections. 

 

11.7 Print without checking the print preview window 
 

(1)  After entering contents and settings [New Draft (tape mode)] menu, click on [Print]. 

(2)  Your contents will automatically be added to the design window, and the print menu will be displayed. 

(3)   After checking each item, select [Print] and the printer will start automatically. 
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11.8 Edit the layout 
 

Edit the contents that have been automatically placed in the design window. 

 

(1) After setting preparing the contents in the [New Draft (tape mode)] window, click the [Edit Layout] button. 

(2) The following message will be displayed, "You will be unable to input text in tape mode. Do you wish to 
proceed?" Click [OK] to continue. 

(3) Your contents will be auto-placed in the design window. Please edit the layout as needed. 

(4) After finished editing, click [Print] tab - [Single Colour Print] or [Colour Print] 

* Warning: You cannot return to the [New Draft (tape mode)] window after pressing［Edit Layout button]. 

 

11.9 Exit tape mode 
 

Exit tape mode and return the design window. 

(1) Click [Cancel] in the [New Draft (tape mode)] window. 

(2) The tape mode is closed, and return to the layout design window. 

 
       

12  Other settings 
 

12.1 Design grid settings 
 

(1) Click the [Setting] tab – [Change Grid Settings]. 

(2) The [Design Grid Settings] dialog will be displayed. 
 

       
 
 
 
 
 
 
 
 
 
 
 
[Display Design Grid] Check [Yes] or [No]. 
 
[Set Grid Spacing]  Enter a value for the grid spacing (1 to 50 mm/.04 to 1.95 in) 

(half-space characters for foreign keyboards) 
 

[Align Objects with Grid] Aligns the position of an object with the lines on the design grid.  
      Check [Yes] or [No] 
 

(3)  Click [OK] and the design grid settings will be applied. 
*Depending on the design window zoom settings, and the grid spacing value, the design Grid may not 
be displayed. 
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12.2 Window colour settings 
 

It is possible to change the background colour, tape roll colour, and gird line colour in the design window to 

a colour that you like. 

Click [Setting] tab - [Screen Colour Settings]. 

 

[Background]   Changes the background colour. 
 

[Sheet]    Changes the tape roll colour. 
 

[Grid Line]   Changes the grid line colour. 
 
[Label]    Changes the label background colour in Label Setup Mode. 

 

The changed [Background], [Sheet], [Grid Line] and [Label] colours are saved and applied for the files 
opened after the changes. 

 

12.3 Text Box Printing Options 
 

Apply settings if small letters are not printing correctly. 
 

(1)   Click [Setting]－[Properties]－[Text Box Properties]. 

(2)   Put a check in the「Convert to fine data」field. 

   
 
 
 
 
 
 
 
 
     

(3)  Enter the maximum letter size to which this setting is applied, and click [OK]. 
 
       
     
 
 
 
 
 
 
 

*The default setting is 7.0mm (0.28 in). 

*Results vary based on the printing, so adjust the numbers by checking the actual print quality. 

*The mirror function and the italic function cannot be used with this function.  
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13  Connect BepopPC to bespoke software 
 

Using your company's bespoke software, it is possible to set BepopPC EX to run in the background (not 

displayed) and print layouts from BepopPC EX. 

 

13.1 Useable layout requirements 
 
     Useable layouts are those that can be linked to a CSV, TXT or XLSX/XLS database. 

 
 
 
 
 
 
 
 
 
 
 
 
    

13.2 How to print a CSV/TXT/XLSX/XLS file while running BepopPC EX in the 

background 
 

Enter the following parameters in the .exe file of the application you will use to print. 

 
Order Parameter Remarks 

1 "/p" Fix letter position. 

2 Layout filename Write the exact path 

※Enclose the filename in ["] double quotations. 

3 "/prep" Fix letter position. 

4 "/linkdata1" The identifier for the first field of letters. Fixes letter position. 

5 Link name = Column name in the 
DXF File 

The first column name that will be imported from the DXF file. 
 Example: The Link name would be "Product Name" and the data in the column would 
be "SL-R201T BLACK". In the case of field "Product Name" starting with  "SL-R201T 
BLACK" you must write, "Product Name= SL-R201T BLACK ". 

※As there are cases where the column name may have spaces, be sure to put ["] (double 

quotations). 

6 "/linkdata2" The identifier for the second field of letters. Fixes letter position. 

7 Link name = Column name in the 
DXF File 

The second column name that will be imported from the DXF file. 
(Same format as 1st field) 

8 "/linkdata3" The identifier for the third field of letters. Fixes letter position. 

9 Link name = Column name in the 
DXF File 

The third column name that will be imported from the DXF file. 
(Same format as 1st field) 

10 "/linkdata4" The identifier for the fourth field of letters. Fixes letter position. 

11 Link name = Column name in the 
DXF File 

The fourth column name that will be imported from the DXF file. 
(Same format as 1st field) 

12 "/linkdata5" The identifier for the fifth field of letters. Fixes letter position. 

13 Link name = Column name in the 
DXF File 

The fifth column name that will be imported from the DXF file. 
(Same format as 1st field) 

* The most fields that can be inserted is 5 (including barcodes). If there are less than five than it is okay to omit 
the unnecessary parameters. 

 

Example) In the layout on 13.1, There is Product Name "SL-R201T BLACK", Product Code "IL92101", EAN 

Code "490287081068". The paramaters would be the following:  

/p "C:/_Data/bepoppc/Layout/Management.lcb" /prep /linkdata1 "Product Name= SL-R201T 

BLACK " /linkdata2 "Product Code =IL92101" /linkdata3 "EAN_Code=490287081068" 

  

Product Name 

Product Code 

EAN Code 
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13.3 Use a database file as go-between to print 
 

Before starting BepopPC EX, make a CSV/TXT/XLSX/XLS file with the data which you wish to import, and 

save it over the file connected to the layout which you wish to print. 

       Set the following parameters in the application you wish to print from and start BepopEX.exe. 

     
Line Parameter Remark 

1 "/p" Fixes letter position。 

2 Layout filename Be sure to record the path. 

※Sometimes there spaces in the filename, so please enclose with " (Quotation mark) . 

3 "/prec" Fixes letter position. 

4 "/copydata" This identifier states how many times to print１a piece of data. 

5 Number of prints Set the number of prints of data, by writing a number. 

 

Example）Entering the CSV file data into the example from the first previous page would have parameters 

that look like this: 

/p "C:¥_Data¥bepoppc¥Layout¥part labels.lcb" /prec  /copydata 1 

 
      In the case that there were 4 CSV Files, the printed image would look like: 

       
 
 
 
 
 
 
 
 
 
 
 
 
 
 

*Print density, auto-cut ON/OFF settings all depend on the printer driver settings. 

*For this function, it is not possible to fully support all the customer applications. Also, we cannot offer advice and 

support for programing. 

*We offer absolutely no guarantee this function will work with your bespoke software. 

 

 

14  Printing when two of the same type drivers are installed 
 

(1)  Connect the printer to the PC.  

* For further instructions on connection, please reference the instruction manual (separate manual). 

  

(2)  Click the  icon in the [Home] tab, or click [Print] tab - [Single Colour Print]. 

       

* When doing a colour print, click the [Print] tab – [Colour Print].  
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(3) Check the name of the printer at the "Printer:" field. To choose a different printer, click on the select [Select 
Printer].  

 

 
(4)  Under the [Printer Name:] open the drop-down menu by pressing the ▼ icon, and select the printer.   

   
 
 
 
 
 
 
 
 
(5)  After checking the name in the [Printer:] field, click on the [Print] button to start the print. 

 

15  Error message list 
 

15.1 Common 
 
 

"The driver for MAX Bepop has not been installed. Install the latest version of the driver from the 
included CD-ROM, or download and install it into your PC. For the installation method, see the 
Instruction Manual." 
 

Support:  Bepop PC EX software cannot start if the dedicated printer driver is not installed. 

Please install the dedicated printer driver. 

* For an explanation on how to install the printer driver, please refer to the Install Manual of MAX 

printers. 

 

15.2 Zoom in/zoom out 
 

"The Objects cannot be displayed in the current Zoom ratio.  So, Zoom ratio is changed 
automatically." 

Support： The current tape size setting is too large. Zoom ratio will automatically be changed to display content. 
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15.3 Opening and saving files 
 

"Printer Driver, that was used when editing this file, cannot be found. The data may not be 
displayed correctly." 

 

Support： Please install a printer driver that matches your printer. If you purchased multiple types of printers, 

please install the printer drivers for all of the printer types. After installing the drivers, please try to 

reopen BepopPC EX. 

* After clicking [OK], without saving, install the printer drivers after shutting down BepopPC EX. For 

information regarding the printer driver install, please refer to the Install Manual (separate publication). 

 

"Could not locate file" 

Support：The chosen file has been deleted, moved, or you do not have permission to access the file. 

 

"The access to file was refused." 

Support：You do not have access rights to the file. Contact system administrator. 

 

"Selected file is now editing." 

Support：You have attempted to open a file that you are currently editing. To open the file without the edited 

changes, close BepopPC EX without saving, and reselect the file. 

 

（Other error messages regarding opening and saving files） 

Support：Check whether the chosen file has been deleted, corrupted, or access rights have been denied. 

If saving, the disc space may be full, or the file may be a read-type only file. 

Check with system administrator about files, folders, and access rights. 

 

 

15.4 Editing cliparts（BepopScanEX） 
 

15.4.1 Initial Operation 

"Cannot open the window." 

Support：It is possible that BepopPC EX is not installed correctly. 

  Please reinstall BepopPC EX. 

 

15.4.2 Reading and saving clipart files from the hard disk 

 

"Incorrect filename."       "Not enough directory space." 
"File access denied."     "File not found." 
"Folder not found." 

 

Support：These messages are displayed when there is no folder for the selected clipart file, the folder does not 

exist, the file has been corrupted, you do not have access rights, there are too many files in one 

folder.  

Check with system administrator about files, folders, and access rights. 

 

"Filename is too long. Please make it shorter." 

Support：The clipart filename/folder name cannot exceed 64 characters. (32 Half-width characters) Please do 

not save using file names of more than 64 characters. 
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"An error occurred while reading clipart file." 

Support：You attempted to read a file that is not a clipart file, or the data has been corrupted. 

 

"An error occurred while saving clipart file." 

Support：Clipart files do not have access rights to the folder you are attempting to save in. When trying to save 

a lot of files in the same folder the save may fail, try saving in another folder. 

 Check with system administrator about files, folders, and access rights. 

 

"Failed to make new folder." 

Support：The folder name may already exist, there are too many folders, or you do not have access rights. 

 

"Invalid folder name." 

Support：File and folder names cannot use the following charcters: 

￥ ／ ： ； ， ． ＊ ？ ” ＜ ＞ ｜ 

 
 

15.4.3 Reading and saving images 

 

"Cannot read file format." 

Support：The file types that can be read into BepopScanEX are as below ; 

 Bitmap(.bmp) files  : BMP/DIB, BMP/DIB(RLE4) and BMP/DIB(RLE8) 
 JPEG(.jpg, .jpeg) files : JPEG(basic DCT), JPEG(progressive DCT) 
 TIFF(.tif, .tiff) files  : TIFF(uncompressed), TIFF(CCITTRLE), TIFF(GROUP3-1D), 

 TIFF(GROUP3-2D), TIFF(GROUP4), TIFF(PACKBITS) 
  

*The colour depth must be 24bit or less, regardless of the file types. 
 
Example of incompatible file types ; 
 GIF(.gif) files  : GIF(87a), GIF(89a) 
 TIFF(.tif, .tiff) files  : TIFF(LZW), TIFF(JPEG) 
 PNG(.png) files  : PNG 
 FPX(.fpx) files  : FPX(uncompressed), FPX(Single Colour), FPX(JPEG) 
 PCX(.pcx) files  : PCX 
 WMF(.wmf) files  : WMF 
 EMF(.emf) files  : EMF 
 DXF(.dxf) files  : DXF 
 JPEG(.jpg, .jpeg) files : JPEG(exif) 
 SVG(.svg) files  : SVG 
 JPEG2000(.jp2, .j2k) files : JPEG2000, JPEG2000(Code Stream)  
 SXF(.sxf) files  : SXF(p21), SXF(sfc)  
 
As shown, JPEG(.jpg, .jpeg) files which include exif data (jpg(exif)) are not available for being read into 

BepopScanEX. As of April 2022, the JPEG image files, that are photos taken by Smartphones in general, include 

exif data as default.  

To avoid the error, please make sure to convert the image file to the other file type, which do not include exif and 

compatible with BepopScanEX, such as Bitmap. 

 
When the image file is not compatible with BepopScanEX, convert the file to either one of the aforementioned 

compatible file types. 

 

"Can only save in bitmap form." 

Support：Regardless of the original file types, after being read into BepopScanEX, the image can be saved only 

as a Bitmap (.bmp) file. 
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15.4.4 Reading an image from a scanner 

 

"Cannot find scanner." 

Support：Check that the scanner is connected to the PC. Check that the scanner driver has been installed 

correctly (Refer to the install manual of your scanner). 
 

"Failed to read scanner." 

Support：Due to a scanning error, the file could not be read. Check the connection, driver, and any other 

problems that may be occurring with the scanner. 

 

15.4.5 Data outlining (for cliparts) 

 

"Cannot create clipart." 

Support：There is a problem with the image data or not enough RAM on the computer so the outline failed. Be 

sure that the image data is Bitmap, and that the scan data is less than 24bits. Also, in the case of a 

colourful image, be sure to use the threshold bar to adjust the mono-colour image. If these 

adjustments are not effective, please try to free up RAM on you PC by closing all other applications. 

 

15.4.6 When finishing clipart design 

 

"Failed to transfer data." 

Support： If the data is more than 64kb, it cannot be pasted from BepopScanEX to BepopPC EX. In this case 

go to the menu bar and select [File]-[Save Clipart], after saving the clipart to the hard disk you will be 

done designing. (When asked, "Do you want to paste clipart data?" please select [No]") 

 

"Cannot find application." 

Support： Closing BepopPC EX while operating BepopScanEX will cause this message to appear. Please open 

BepopPC Ex again. 

 

15.5 Print/colour print/print preview（For print labels and cutting） 
 
"Failed to display printer properties" 

Support： It is likely that the printer driver has failed to install correctly. Exit from BepopPC EX and re-install the 

correct printer driver for your printer model. 

 
"Cannot find the printer driver" 

Support：Exit from BepopPC EX and re-install the correct printer driver for your printer model. 

Please do not delete the printer driver while BepopPC EX is still running. 

 

15.6 Object 
 

"Cannot display this at present size. Adjust Size (width,length,rotation)" 

Support：The layout has exceeded the largest display boundary. Please display an appropriate size/settings 

value. 

 

15.7 Tape settings（For print labels and cutting） 
 

"There is no printer that was selected in [Sheet Setting]. Close the Application software. Execute 
after installing Printer Driver." 

Support： Close Bepop PC EX. Please re-install the appropriate printer driver. 

* Do not delete a printer driver while BepopPC EX is in operation. 
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15.8 Insert clipart/register clipart 
 

"There are no groups. Insertion of Clipart is not executed." 

Support：Displayed when the clipart groups have been deleted. 

Please "Register Clipart" and add another group. 

 

"This group cannot be selected. The other group is selected automatically." 

Support：Displayed when access rights for the group have been enabled, and you cannot access the group. 

 Check with system administrator about files, folders, and access rights. 

 

"File error was occurred."  "Error128: An error occurred while reading file(open error)." 
"Error127: An error occurred while writing file(open error)."  

"Error101: An error occurred in clipart dialog or selecting filename." 
 

Support：Displayed when the chosen clipart file cannot be saved, is a "read-only" file type, or has been 

corrupted. It is possible to check whether the file is "read-only" by viewing it in your file explorer. If 

the clipart files have been corrupted, reinstall the software, or download the cliparts of the MAX 

Bepop dedicated website. 

 
"Incorrect filename. Please re-enter file name." 

Support: File and folder names cannot use the following symbols: 

￥ ／ ： ； ， ． ＊ ？ ” ＜ ＞ ｜ 

 
 

"Failed to move directory."  "Due to failure to move directory, cannot register." 
"Failed to make new group." 

Support：Folders cannot be made when, there is no group and a group of cliparts has not been made, there 

are too many folders, or you do not have access rights. 

 
 
"There is no clipart data" 

Support：This is displayed when a clipart without outline data is accessed. As these cliparts will not function 

properly, please delete them. (Go to the [Insert Clipart]-[Delete Clipart]) 

 

"There is no disc capacity to save data. Delete some files to increase the capacity." 

Support：The hard disk is full. After deleting unnecessary files to open up space, please try again. 

 

"Some errors were occurred in the drive to open or save file." 

Support：There was an error in the hard disk driver. 

 

"There are no capacity in the folder. Delete some files or make other folder." 

Support：Delete unnecessary cliparts from the group (Go to the [Home] tab - [Clliparts] - [Cliparts] – [Delete 

Clipart]), or save the file in a different group. 

 

"The editing directory cannot be deleted." 

Support：The selected file is being used in another application, please retry after closing the application. 

 

"The access to file was refused." 

Support：This is displayed when access rights have been set, and you do not have rights to access the fi le. 

Please discuss access rights with your system administrator. 
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"Filename is too long. Shorten filename." 

Support: The clipart filename/folder name cannot exceed 64 characters. (32 Full-width characters) Please do 

not save using file names of more than 64 characters. 

 

"The group name you entered already exist. Enter new group name." 

Support：Displayed when a folder using this name already exists. Please enter another name. 

 

"There are no groups. Make new groups. Click [OK] to continue." 

Support：If there are no groups when you register a clipart, make a new group. Please specify the group name. 
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15.9 Insert colour cliparts（printed label） 
 

"The file you have selected BEPOP-colour clipart file could not be read. The file is invalid or not 
supported." 

Support：Please reinstall BepopPC EX, or download new colour cliparts from the MAX Bepop dedicated website. 

 

"Cannot open this file" 

Support：The chosen colour clipart does not exist or you do not have access rights. If the clipart data does not 

exist, reinstall BepopPC EX. If you do not have access rights, then please consult with your system 

administrator. 

 
 

15.10 Text box 
 

"Cannot find font" 

Support：The font that was used when this file was saved is not in your computer. Please choose another font.  

 
 

15.11  Bordering function（Cutting/Printing) 
 

"Object size is out of the range to execute Bordering. The range of Bordering: 
Sheet length direction: 1.0 to 3000.0 mm (0.04 to 118.11 in) , Sheet width direction: 1.0 to 275.0 mm 
(0.04 to 10.82 in) ." 

Support：Adjust the object size to fit within the limits. If multiple objects are chosen, please choose one object 

at a time. 
 
 

"There is no Bordering data. Bordering is not executed." 

Support：This is displayed when there is no data that can be traced, for example a text box with only a space. 

 

"Error was occurred when creating Bordering data. Bordering is not executed." 

Support：When there is not enough RAM on the PC this message is displayed. Close background applications 

or restart your computer. 

 

"Bordering is not executed because of Memory shortage. (%1)" 

Support：There is not enough RAM to support bordering. Increase RAM, or move to a more powerful PC. 
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16  Visit MAX Bepop dedicated website ! 
 

(1) In the Bepop PC EX design window, please click the     Max Bepop dedicated website icon. 
 
(2) This will start up your browser and automatically direct you to the Max Bepop dedicated website. 

 

(3) Follow the directions to continue browsing, as well as downloading the following contents. 

 
   MAX Bepop dedicated website provides the following services: 
     ●Free software and driver updates     ●Clipart and template downloads 

  ●Case studies            ●And much more!    
 

 


